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Warnings and Notices

WARNING

The Optical Test Head is heavy and requires two people to lift or carry it.
Do not attempt to lift or carry it on your own.
Make sure you use the help of a colleague to unpack or move the Optical 
Test Head.

WARNING

To avoid the possibility of injury or death, you must observe the following 
precautions before switching on the instrument.
Insert the power cable plug only into a socket outlet provided with a pro-
tective earth contact. Do not negate this protective action by the using 
an extension cord without a protective conductor.

WARNING

Never look directly into the end of a fiber or a connector, unless you are 
absolutely certain that there is no signal in the fiber.
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In This Guide…
This User’s Guide contains information about installing and using the 
Photonic All-Parameter Analyzer and Photonic Analysis Toolbox (PAT).

Chapter 1 Installing the Photonic All-Parameter Analyzer

This chapter describes how to install your hardware and software. 

Chapter 2 Getting Started

This chapter describes how to use the optical bench accessories, and 
make your first measurement.

Chapter 3 The Photonic Analysis Toolbox Reference

This chapter provides reference information on the menus, toolbars and 
other functions of the Photonic Analysis Toolbox application.

Chapter 4 Making Measurements

This chapter describes the procedures necessary to make measurements 
with the Photonic All-Parameter Analyzer and the Photonic Analysis 
Toolbox application.

Chapter 5 Analyzing Results

This chapter describes how to analyze recently measured and previously 
stored results.

Appendix 6 System Specifications

This appendix lists the specifications of the Photonic All-Parameter 
Analyzer.

Appendix 7 Performance Verification

This appendix describes how to check and keep your Photonic All-
Parameter Analyzer up to specifications.

Appendix 8 Maintenance and Troubleshooting

This appendix describes how to keep your Photonic All-Parameter 
Analyzer functioning properly, and how to deal with problems.

Appendix 9 Theory of Measurement and Operation

This appendix provides conceptual information on the test method and 
measurement approach used by the Photonic All-Parameter Analyzer

Appendix 10 Definition of Terms

This appendix defines the terms used in this manual, and in connection 
with your Photonic All-Parameter Analyzer.
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Installing the Photonic All-Parameter Analyzer
1

Installing the Photonic All-Parameter 
Analyzer

This chapter describes how to install your hardware and software.

The chapter starts with a brief description of the Photonic All-Parameter 
Analyzer system.
Then there is a list of the components that you receive, or supply yourself 
to make up the system.
This is followed by instructions on how to prepare the site for the test 
system, and how to connect the hardware and install the software.

Safety Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Safety Summary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Before applying power . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
AC Line Power Supply Requirements  . . . . . . . . . . . . . . . . . . . . . 17
AC Line Power Cable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Additional Safety Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Safety Symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Operating and Storage Environment . . . . . . . . . . . . . . . . . . . . . . 19
Declaration of Conformity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Regulatory Compliance Notes  . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

An Overview of your Photonic All-Parameter Analyzer . . 22

Alternative Hardware Configurations  . . . . . . . . . . . . . . . . . . . . . 22
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Connecting the Hardware Together . . . . . . . . . . . . . . . . . . . . . . . 36
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Installing the Photonic All-Parameter Analyzer Safety Information
Safety Information

The following general safety precautions must be observed during all 
phases of operation of this instrument. Failure to comply with these 
precautions or with specific warnings elsewhere in this manual violates 
safety standards of design, manufacture, and intended use of the 
instrument.

Agilent Technologies assumes no liability for the customer's failure to 
comply with these requirements. 

Before operation, review the instrument and manual for safety markings 
and instructions. You must follow these to ensure safe operation and to 
maintain the instrument in safe condition.

Safety Summary
The Agilent 81910A Photonic All-Parameter Analyzer is a Safety Class 1 
instrument.

This product is intended for indoor use only. To prevent potential fire or 
electric shock hazard, do not expose to rain or other excessive moisture.

The protective features of this product may be impaired if it is used in a 
manner not specified in the operation instructions.

Before applying power
… comply with the chapter “Installing the Photonic All-Parameter 
Analyzer” . 

… verify that the product is set to match the available line voltage, and all 
safety precautions are taken. 
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Safety Information Installing the Photonic All-Parameter Analyzer
AC Line Power Supply Requirements
The Agilent 81910A Photonic All-Parameter Analyzer operates from a 
single phase AC power source that supplies between 100 V and 240 V at a 
frequency in the range of 50 to 60 Hz to the System Controller.

The maximum power consumption is 200VA with all options installed.

AC Line Power Cable
According to international safety standards, the System Controller has a 
three-wire power cable.

The type of power cable shipped with each instrument depends on the 
country of destination. Refer to the diagram below for the part numbers of 
the power cables available.

Figure 1 Line power cables – plug identification

To avoid the possibility of injury or death, you must observe the 
following precautions before switching on the instrument.
Insert the power cable plug only into a socket outlet provided with 
a protective earth contact. Do not negate this protective action by 
the using an extension cord without a protective conductor.

CAUTIONWARNING
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Installing the Photonic All-Parameter Analyzer Safety Information
Additional Safety Requirements
• In case of hazard the power cable inlet of the controller serves as device 

to disconnect from the mains. 
The controller must be positioned that the operator can easily access the 
power cable inlet.
In case of rack-mounted controller the rack must be provided with an 
easily accessible mains switch.

• Do not interrupt the protective earth connection intentionally.

• Do not operate the instrument in the presence of flammable gases or 
fumes 

• Operating personnel must not remove instrument covers.

• There is no user-replaceable fuse in the instrument.

• Component replacement and internal adjustments must be
made only by qualified service personnel.

• Instruments that appear damaged or defective must be made inoperative 
and secured against unintended operation until they can be repaired by 
qualified service personnel.

Safety Symbols
This symbol denotes a general hazard and indicates that you 
need to read and understand the User’s Guide before 
proceeding.

This symbol denotes a magnet. Caution for persons with 
pacemakers.
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Safety Information Installing the Photonic All-Parameter Analyzer
Operating and Storage Environment
The following summarizes the Photonic All-Parameter Analyzer operating 
environment ranges.

Temperature and humidity

The Agilent 81910A Photonic All-Parameter Analyzer can be operated 
between 5°C and 45°C (within specifications at a temperature of 
23°C ± 5K) and a humidity between 15% and 80%.

The Agilent 81910A Photonic All-Parameter Analyzer can be stored or 
shipped at temperatures between -40°C and +50°C. It shall be protected 
from temperature extremes and changes in temperature that may cause 
condensation within it.

Altitude

The Agilent 81910A Photonic All-Parameter Analyzer can be used up to 
2000m (6500ft.)

Measurement (Overvoltage) category and Pollution

The Agilent 81910A Photonic All-Parameter Analyzer Analyzer complies 
with measurement category II and is designed for pollution degree 2 (IEC 
60664-1).
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Installing the Photonic All-Parameter Analyzer Safety Information
Declaration of Conformity
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Safety Information Installing the Photonic All-Parameter Analyzer
Regulatory Compliance Notes

EMC Australia/New Zealand

EMC/CEM Canada

These ISM devices comply with Canadian ICES-001.

Ces appareils ISM sont conformes ŕ la norme NMB-001 du Canada.
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 21



Installing the Photonic All-Parameter Analyzer An Overview of your Photonic All-Parameter Analyzer
An Overview of your 
Photonic All-Parameter Analyzer

The Photonic All-Parameter Analyzer consists of a number of major 
components that are connected optically and electronically. 

Alternative Hardware Configurations
There are three alternative hardware configurations.
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An Overview of your Photonic All-Parameter Analyzer Installing the Photonic All-Parameter Analyzer
Single PC Configuration

Figure 2 Overview of the Single PC Configuration

In this case all of the software and connections are on the PC supplied 
with the All-Parameter Analyzer, including

• the Photonic Analysis Toolbox and Photonic Foundation Library (API) 
software

• the GP-IB card

• the Plug and Play drivers

• the Agilent VISA drivers, and 

• the System Controller software (data acquisition from and control of the 
Optical Test Head)

The PC is connected to the Polarization Controller and Lightwave 
Measurement System over GP-IB, and to the Optical Test Head over the 
Data Acquisition lines.

This is the configuration described in detail this this manual.

Optical Test Head

PC with System 
Controller and 
Photonic Analysis 
Toolbox software

Lightwave Measurement 
System

Polarization Controller

Data Acquisition Lines

GP-IB
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Installing the Photonic All-Parameter Analyzer An Overview of your Photonic All-Parameter Analyzer
Two PC setup with GP-IB Connection to the User’s PC

Figure 3 Overview of the Two PC setup with GP-IB Connection to the User’s PC

In this case the user’s PC contains:

• the Photonic Analysis Toolbox and Photonic Foundation Library (API) 
software

• the GP-IB card

• the Plug and Play drivers

• the Agilent VISA drivers, and 

The user’s PC is connected to the Polarization Controller and Lightwave 
Measurement System over GP-IB.

The System Controller PC contains:

• the System Controller software (data acquisition from and control of the 
Optical Test Head).

The System Controller PC is connected to the Optical Test Head over the 
Data Acquisition lines.

The user’s PC is connected to the System Controller PC via LAN.

This was the hardware configuration used for the first release of the All-
Parameter Analyzer.

How to set up this configuration is not described explicitly, in this manual.

NOTE

Optical Test Head

User’s PC with 
Photonic Analysis 
Toolbox software

Lightwave Measurement 
System

System Controller (rack 

mounted PC

or standard PC)

Polarization Controller

Data Acquisition Lines

LAN

GP-IB
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An Overview of your Photonic All-Parameter Analyzer Installing the Photonic All-Parameter Analyzer
Two PC setup with using the System Controller PC’s GP-
IB Connection via LAN server.

Figure 4 Overview of the Two PC setup with GP-IB Connection to the System Controller PC

In this case the user’s PC contains:

• the Photonic Analysis Toolbox and Photonic Foundation Library (API) 
software

• the Agilent VISA LAN Client software, and 

The System Controller PC contains:

• the GP-IB card

• the Plug and Play drivers

• the Agilent VISA drivers

• the Agilent VISA LAN Server software, and 

• the System Controller software (data acquisition from and control of the 
Optical Test Head).

How to set up this configuration is not described explicitly, in this manual.
NOTE

Optical Test Head

User’s PC with 
Photonic Analysis 
Toolbox software

Lightwave Measurement 
System

System Controller PC

Polarization Controller

Data Acquisition Lines

LAN

GP-IB
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Installing the Photonic All-Parameter Analyzer An Overview of your Photonic All-Parameter Analyzer
The System Controller PC is connected to the Polarization Controller and 
Lightwave Measurement System over GP-IB, and to the Optical Test Head 
over the Data Acquisition lines.

The user’s PC is connected to the System Controller PC via LAN. The 
connection from the Photonic Analysis Toolbox to the Polarization 
Controller and Lightwave Measurement System is accomplished 
usingAgilent VISA LAN Client/Server.

Hardware Description
The test signal originates from the Tunable Laser Source Module in the 
Lightwave Measurement System. This is routed, via the Polarization 
Controller, to the Optical Test Head, and to the device under test.

The light transmitted and reflected by the device under test (DUT) is 
measured at various points within the Optical Test Head by the Power 
Sensor Modules in the Lightwave Measurement System, and by internal 
power sensors within the Optical Test Head. The readings from the internal 
power sensors are polled by the System Controller software.

The Lightwave Measurement System, the Polarization Controller and the 
System Controller software are controlled by the Photonic Analysis 
Toolbox software. The Photonic Analysis Toolbox software also collects 
the measurement data from the Power Sensor Modules and the System 
Controller software. This measurement data is then processed to produce 
tabular and graphical results.
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Checking for Updates

Before you begin installing your All-Parameter Analyzer, we recommend 
that you check the support website for details of any changes or updates. 
The All-Parameter Analyzer support website is at
http://www.agilent.com/comms/allparameter
=> Choose “Technical Support”.
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Unpacking the Photonic All-
Parameter Analyzer

Each Photonic All-Parameter Analyzer contains.

• 1 Agilent 8164B Lightwave Measurement System (Mainframe) 
The Lightwave Measurement System is not supplied if you ordered op-
tion 002 or option 004.

• User’s guide for the 8164B Lightwave Measurement System (not sup-
plied if you ordered option 002 or option 004)

• Programmer’s guide for the 8164B Lightwave Measurement System (not 
supplied if you ordered option 002 or option 004)

• 1 Agilent 81640B or 81600B option 200 or 160 
Tunable Laser Source Module
If you ordered option 002 or option 004, this is the refurbished, fully cali-
brated Tunable Laser Source Module in exchange for the module that 
you previously sent to Agilent.

• User’s guide for the Agilent 81640B or 81600B Tunable Laser Source 
Module

• 3 Agilent 81634B Power Sensor Modules

• User’s guide for the Agilent 81634B Power Sensor Module

• Serial cable assembly (not supplied if you ordered option 002 or option 
004)

• 1 Agilent 8169A Polarization Controller

• User’s guide for the Agilent 8169A Polarization Controller

• 1 System Controller PC
used to run/control the system.

• 1 Keyboard Kit

• 2 Data Acquisition cards
used to control/acquire data from the Optical Test Head.

• 1 Ribbon Cable
used to connect the two data acquisition cards.

• 1 Agilent 81910TH Optical Test Head
used as an optical bench and for connecting to the device under test.
28 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Unpacking the Photonic All-Parameter Analyzer Installing the Photonic All-Parameter Analyzer
• 1 Optical Test Head Hood
used to optimize measurement performance by protecting the DUT and 
the fibers from air currents.

• 1 DUT Holder
optionally used to hold the DUT on the optical bench.

• 1 Mounting Kit
contains
20 optical bench mounting plugs so you can configure your own optical 
setup.
1 Allen key for the screws used to attach the Optical Test Head Hood to 
the Optical Test Head.
1 Allen key for removing the cover of the adapter patchcords in the opti-
cal workbench.
1 Termination Rod for use in making terminations.

• 1 Accessories Kit
contains
4 fiber rails to keep fibers in defined and fixed positions.
2 fiber holders, to keep the fibers in a defined position for best possible 
measurements.

• 2 rail kits and 2 rack mount kits for mounting the Polarization Controller 
and the Lightwave Measurement System in a rack.

• 2 GPIB cables

• 2 data acquisition cables, 3m
used to transfer data between the System Controller PC and the Optical 
Test Head.

• 1 BNC cable, 3m
used as a trigger cable between the Tunable Laser Source Module and 
the Optical Test Head.

• 1 LAN cable

• 1 Semi-Rigid Patchcord, 0.3m, with two HMS-10 connectors.
used to connect the output of the Tunable Laser Source Module to the 
input of the Polarization Controller.

• 1 Protected Patchcord, 3m, with two HMS-10 connectors.
used to connect the output of the Polarization Controller to the input of 
the Optical Test Head.
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• 2 adapter patchcords, E2000 to bare fiber
to adapt the Optical Test Head for operation with DUTs using bare fiber 
connections.

• 2 adapter patchcords, E2000 to straight
to adapt the Optical Test Head for operation with DUTs using straight 
connectors.

• 3 HMS-10 interface adapters for connecting to the power sensor mod-
ules.

• 2 81000FI interface adapter

• 2 81000NI interface adapter

• 1 box containing 2 reference patchcords with straight connectors used 
for reference measurements for systems using straight connectors.

• 1 box containing 2 reference patchcords and 2 performance verification 
patchcords with angled connectors used for reference measurements 
for systems using angled connectors.

• 1 box containing 2 reference patchcords with bare fiber ends used for 
reference measurements for systems using bare fiber connections.

• UK6 Verification Report

• Support CD-ROM

• 2 or 3 power cords, according to the option ordered, used for the Light-
wave Measurement System, Polarization Controller, and System Con-
troller PC.

• 1 CD containing the Photonic Analysis Toolbox software
for installation on your PC.

• This User’s Guide
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Specification of the User’s PC

If the Photonic Analysis Toolbox software is to run on a separate PC (see 
“Alternative Hardware Configurations” on page 22 for information on 
possible configurations), this should satisfy the following minimum 
specification:

Processor: 500 MHz
Note: Do not use dual processors unless they are 
supported by your VISA library.

Main Memory: 192 Mbyte

Display Resolution: SVGA (1024 x 768)

Colors: 16 or 24 bit

Operating System: Windows NT 4 SP 6 or SP 6a or Windows 2000 SP2 or 
Windows XP

OS Language 
option:

English (US) or Japanese

Internet Explorer: Version 4 or higher

VISA Library: National Instruments Version 2.0 or higher (not 2.6! but 
2.6.1) or Agilent J 2.0 or higher

GPIB-Card:a

a   Only required for the Two PC Setup with GP-IB Connection to the User’s PC

Any type compatible with your VISA Library
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Setting Up the Photonic All-
Parameter Analyzer

Setting up your Photonic All-Parameter Analyzer consists of three major 
steps:

• Preparing the site

• Setting up the hardware, which includes preparing the equipment and al-
lowing it to acclimatize, setting up the Lightwave Measurement System, 
making the optical connections, making the signal connections, con-
necting the power, and connecting the system to your PC.

• Installing the software.

Preparing the Installation

Requirements and Constraints

Before you begin installing your Photonic All-Parameter Analyzer, make 
sure

• the site you have chosen meets the environmental conditions listed in 
“Performance Specifications” on page 216, and “Operating and Storage 
Environment” on page 19. 
Please also check the environmental conditions and site preparation in-
formation in the documentation supplied with the Lightwave Measure-
ment System, the Polarization Controller and the System Controller PC.

• a robust bench or table is available for the Optical Test Head. This should 
be away from strong airflows or any kind of vibrations.

• there are enough AC-power outlets (you will need 1 each for the Light-
wave Measurement System, the Polarization Controller, and the System 
Controller PC).

The Lightwave Measurement System, the Polarization Controller need to 
be positioned together, but not more than 2 m from the Optical Test Head.
The System Controller PC must also be positioned within 
2 m of the Optical Test Head.

DO NOT place the Optical Test Head on top of the Lightwave Measurement 
System, the Polarization Controller or the System Controller PCNOTE
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Updating Your Lightwave Measurement System 
(option 002 or 004)

If you ordered your Photonic All-Parameter Analyzer as an upgrade (option 
002), you must ensure that the Lightwave Measurement System has the 
most recent software.

The Support CD-ROM contains the most recent software, and is contained 
in your shipment.

In addition to your PC, you require a null-modem serial cable, such as is 
supplied with your 8164B Lightwave Measurement System mainframe.

To upgrade the Lightwave Measurement System firmware:

1 Insert the Support CD-ROM into your PC.

2 Copy the Firmware\8164B folder from the Support CD-ROM to a folder 
on your PC.
This folder contains the update tool ATTools_v1_23.exe and a firmware 
image file named 64B_Vxxx.Z
where xxx refers to the firmware version. For example, 64B_V402.Z is 
firmware version 4.02 for the 8164BLightwave Measurement System.

3 Connect your Lightwave Measurement System to your PC with the 
serial cable.

4 Read all of this step before you begin. You will need to prepare to 
perform this step easily.
Turn on the Lightwave Measurement System and wait until the Agilent 
screen appears.
Quickly:

a Press, but do not hold the Aux hardkey

b Press the Appl hardkey.

This section is only necessary if you need to upgrade your existing 
Lightwave Measurement System. If you received a Lightwave 
Measurement System as part of your delivery, you do not need to perform 
this upgrade.

NOTE

This section describes the upgrade procedure for the 8164B. If you are 
using an 8164A, the procedure is different. Please follow the instructions 
of your 8164A/B User’s Guide. Instructions and downloads are also 
available at www.agilent.com\comms\octfirmware.

NOTE
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If you were successful, the instrument displays: “Instrument 
Maintenance Mode”.
Otherwise, turn off the power and try again.

1 At your PC, click on ATTools_v1_23.exe to start the update tool.
Click OK to confirm that you have completed steps the preceding steps.

When the serial connection has been established, which can take up to 
30 seconds, the ATTools user interface is displayed.

2 Select the firmware image (file type .Z) in the file selection box, then 
click the Update Firmware button.
Click OK to confirm your choice of firmware upgrade.

3 The firmware upgrade is tracked by a progress bar in the ATTools user 
interface.
When the update is complete, a confirmation message is displayed.
Click OK.

4 Click Exit to terminate ATTools.
Your Lightwave Measurement System reboots automatically.

Installing the Data Acquisition Cards into the System 
Controller PC

The data acquisition cards are removed from the System Controller PC 
after the system has completed the final factory test, and are shipped 
separately to avoid any damage in transport. These cards must be 
reinstalled before you continue with the installation.

• You do not require any special tools for the installation.

• Please read the 'Setup and Quick Reference Guide' supplied with the PC, 
especially the sections 'CAUTION: Safety Instructions' and 'When Using 
Your Computer'.

All of the drivers and applications required by the All-Parameter Analyzer 
are pre-installed on the System Controller PC. The only modification 
necessary is the installation of the two cards.

NOTE

Disconnect any cables to avoid any potential hazard of electrical 
shock.

CAUTIONWARNING
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1 Open the PC case, according to the instructions supplied with the PC.

2 Open the board locking device.

3 Remove the two screws.

4 Insert the data acquisition card marked “Port 1” into the slot 
corresponding to Port 1 on the rear of the System Controller PC casing.

5 Insert the data acquisition card marked “Port 2” into the slot 
corresponding to Port 2 on the rear of the System Controller PC casing.

6 Connect the two cards 
together with the ribbon cable.

7 Fix the two cards with the 
screws removed in step 3.

8 Close the board locking device.

9 Close the case of the System 
Controller PC.

• Check the intrusion switch assembly (please refer to the documenta-
tion for the PC for further information).

• If necessary, lift the data acquisition card slightly to accommodate the 
intrusion switch assembly.

Observe all precautions for handling electrostatic discharge 
sensitive devices.

Handle the boards with care, don't touch the circuits, use the edge 
of the board for handling.

Make sure that the manual voltage selection switch is set for the 
voltage that most closely matches the AC power available in your 
location (e.g. 115-V position for Japans 100-V AC power).

CAUTION
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Connecting the Hardware Together

Before you begin

1 Remove the Optical Test Head, the test equipment, and all of the 
patchcords and electrical cables from the packaging.

2 Make sure you have received everything before you proceed. If anything 
is missing, contact your local Agilent representative.

3 Place the equipment in its final position.

• You will need regular access to the PC with the Photonic Analysis 
Toolbox software, to control the system, and the Optical Test Head to 
attach and remove the components for test.

• Make sure the System Controller PC has adequate clearance for ven-
tilation.

4 Remove the 4 fixing bolts from the Optical Test Head.
These bolts prevent the suspension of the Optical Test Head from being 
damaged in shipment.

• There is one fixing bolt on each side of the Opti-
cal Test Head.

• There are two fixing bolts at the back of the Op-
tical Test Head, to the left and right of the con-
nector area.

• Store the fixing bolts in the holes provided at the 
back of the Optical Test Head, on the left and 
right of the connector area.

The Optical Test Head is heavy and requires two people to lift or 
carry.
Do not attempt to lift or carry it on your own.
Make sure you use the help of a colleague to unpack or move the 
Optical Test Head.

CAUTIONWARNING
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.

5 If the Optical Test Head is placed in a 
location where air currents could cause 
movement of patchcords or optical 
components, we recommend that you 
attach the Optical Test Head Hood.

a Place the Optical Test Head Hood on 
the Optical Test Head.

b Use the 4 screws to attach the hinges 
into the back of the Optical Test Head.

6 If the equipment, cords and cables have not been stored at the 
temperature of the room where they are being installed, leave them for 
an hour or so to make sure they reach room temperature. This will 
prevent unwanted condensation.

Setting up the Lightwave Measurement System

Please refer to the User Guide for your Lightwave Measurement System 
for detailed instructions on inserting modules.

1 Insert the Tunable Laser Source Module into the Lightwave 
Measurement System.

2 Insert the three Power Sensor Modules into slots 1, 2 and 3 of the 
Lightwave Measurement System.

3 Use a blanking plate to cover slot 4 of the Lightwave Measurement 
System.

Reinsert the fixing bolts if you are moving or shipping the Optical 
Test Head.

To reinsert the bolts, you will need to press the optical bench down 
by a few millimeters (a few 100ths of an inch).

CAUTION

Four fiber rails are provided to prevent fibers getting caught under the 
hood when closing it. See “Fixing the Fiber Rails” on page 48 for 
information on how to fix the fiber rails to the optical bench.

NOTE
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Making the Optical Connections

1 Screw the Interface Adapters onto

• the inputs of the Power Sensor Modules

• the output 1 (Low SSE) of the Tunable Laser Source Module

• the input and output of the Polarization Controller

• the input on the rear of the Optical Test Head

The tests indicated for these connections can be performed either for a 
new optical connection, or if the diagnostic tool indicates failure. We 
recommend you use an optical power measurement head to make the 
measurements indicated, but it is possible to use one of the Power Sensor 
Modules of the Photonic All-Parameter Analyzer.

2 Use the Semi-Rigid Patchcord, to connect the Tunable Laser Source 
Module to the Polarization Controller

a Unscrew the protective cover and connect one side of the Semi-
Rigid Patchcord to the Tunable Laser Source Module output. While 

These instructions assume that you are installing the Photonic All-
Parameter Analyzer for the first time, using hardware delivered from 
Agilent Technologies.

If you are re-installing the hardware, or reusing existing hardware, please 
make sure that all of your optical connectors are clean before proceeding.

NOTE

Take care when inserting the connectors of the Semi-Rigid 
Patchcord.
The stiffness of the Semi-Rigid Patchcord requires caution to insert 
it into the connector adapter.

Before each connection, it is strongly recommended to clean each 
optical connector and bushing. Refer to“Cleaning” on page 270 for 
information on cleaning connectors. Also, refer to “Do not touch the 
ferrule of the three patchcords in the tubing from the back of the Optical 
Test Head.” on page 40 before handling the patchcords from the Optical 
Test Head.

The quality of the optical connection between the Tunable Laser 
Source Module, the Polarization Controller and the Optical Test 
Head is vital to the overall performance of the Photonic All-
Parameter Analyzer. A connection with high loss can easily occur if 
mechanical stress is applied on the connector, or more commonly if 
the connectors are either dirty or damaged.

CAUTION
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the connector is being screwed onto the bushing, try to avoid any 
transverse resistance by holding the metal casing of the patchcord 
perpendicular to the TLS front panel.

b Unscrew the protective cover and connect the other side of the 
Semi-Rigid Patchcord to the power meter.

c Set the Tunable Laser Source Module to a wavelength of 1570 nm 
and laser power to -10 dBm.
Set the power meter to a wavelength of 1570 nm.

d The power measured by the power meter must be between -10.8 
dBm and -9 dBm.

If the power is not within these limits, then clean the power meter 
connector, and the connector of the Semi-Rigid Patchcord that is 
connecting to the power meter and repeat the measurement.
If, after cleaning, the power is still not within the limits, disconnect, 
clean and reconnect the Semi-Rigid Patchcord to the Tunable Laser 
Source Module, avoiding transverse stress on the connector as 
much as possible, as described above.
If the power is still not within the limits, please contact your local 
Agilent representative.

e Disconnect the Semi-Rigid 
Patchcord from the power 
meter. Without disconnecting 
the Semi-Rigid Patchcord from 
the Tunable Laser Source 
Module and taking care not to 
strain the front connectors, 
connect the other side of the 
Semi-Rigid Patchcord to the 
input of the Polarization 
Controller. 

3 Using the Protected Patchcord, 
unscrew the protective covers and connect the output of the 
Polarization Controller to the power meter.

a The polarizer plate in the Polarization Controller is not aligned with 
the state of polarization of the incident light, so set the polarizer 
angle manually from the front panel of the Polarization Controller to 
get the maximum power on the power meter.
Use 10 degree steps first, then 1 degree steps to locate the 
maximum.
When the maximum is obtained, lock the polarizer angle by pressing 
“enter”.

b The power measured by the power meter at the maximum must be 
between -14.5 dBm and -10.5 dBm.

Output 1

input
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If the power is not within these limits, then clean the power meter 
connector, and the connector of the Protected Patchcord that is 
connecting to the power meter and repeat the measurement.
If the power is still not within the limits, then clean the Polarization 
Controller output connector, and the connector of the Protected 
Patchcord that is connecting to the Polarization Controller and 
repeat the measurement.
If, after cleaning, the power is still not within the limits, and taking 
care not to strain the front connectors, disconnect, clean and 
reconnect the Semi-Rigid Patchcord to the Polarization Controller.
If the power is still not within the limits, please contact your local 
Agilent representative.

c Disconnect the Protected Patchcord from the power meter, and 
connect it to the Optical Test Head.

output

Optical
Input

Do not touch the ferrule of the three patchcords in the 
tubing from the back of the Optical Test Head.

Take care when connecting these patchcords. The fronts of the 
connectors are specially treated, and scratches or dirt will affect the 
accuracy of your measurements.

These connectors should only be cleaned with clean, compressed 
air.
The specially treated surfaces can be damaged by normal contact 
cleaning methods or by the use of alcohol or other liquids, affecting 
the accuracy of measurements.

CAUTION
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4 Connect the three 
patchcords in the tubing 
from the back of the 
Optical Test Head to the 
Power Sensor Modules.
The patchcords are 
labelled according to the 
slot of the Power Sensor 
Module to which they 
should be connected. 
That is, the patchcord labelled PM Slot 1 should be connected to the 
Power Sensor Module in slot 1, and so on. 

Input

The Photonic All-Parameter Analyzer is supplied ready to use with devices 
that have angled connections.

Adapter patchcords are also provided for use with straight or bare fiber 
connections.

If you are testing devices with straight or bare fiber connections, see 
“Replacing the Optical Test Head Adapter Patchcord” on page 285 for 
information on how to change the adapter patchcords in the Optical Test 
Head.

NOTE
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Making the Signal Connection
1 Using the Coax cable, connect the Trigger Output from the rear of the 

Lightwave Measurement System to the Trig In input on the rear of the 
Optical Test Head. 

2 Using the two data acquisition 
cables, connect from the port 1 on 
the rear of the System Controller to 
port 1 on the rear of the Optical Test 
Head, and from the port 2 on the 
rear of the System Controller PC to 
port 2 on the rear of the Optical Test 
Head.

3 Using the GPIB cables, connect the 
PC to the Lightwave Measurement 
System, and then to the 
Polarization Controller.

Trigger Out

Trig In

Port 2 Port 1

to System Controller PC

GP- IB

GP- IB

to PC controlling the Lightwave 
Measurement System and 
Polarization Controller
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Connecting the Power
1 Connect the Lightwave Measurement System, Polarization Controller 

and System Controller PC to the ac power source.
The circuitry in the Optical Test Head is powered via the data acquisition 
cables.

Installing the Software

1 Insert the Photonic Analysis Toolbox software CD into the CD-ROM 
drive on your PC.

2 Open the file explorer.

3 Change to the root directory (\) on the CD-ROM. 

4 Double-click on the program PAT.exe.

5 Click on the Next > button to start the 
installation process. 
The Installation files are extracted.

o not need to install the software if you are using the Photonic Analysis 
Toolbox on the PC supplied with the system.

The following instructions only apply if you are using the Photonic 
Analysis Toolbox softw

Before you install the Photonic Analysis Toolbox software, make sure that 
you have already installed the Agilent I/O Libraries.
These libraries are delivered with your instruments, and are also available 
from the Agilent website (http://www.agilent.com), under the heading 
Test & Measurement, sub-heading Technical Support.

NOTE

NOTE
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6 Click on the Next > button to start the 
installation of the software.

7 Click on the Yes button to accept the 
terms of the license agreement.

8 If you want to install the program to a 
different directory, click on the 
Browse... button and select the 
directory you want to use.
When you agree with the directory 
indicated, click on the Next > button

9 If you want the program icons to the 
installed in a particular program 
folder, select this folder, or enter the 
folder name.
When you are satisfied with the 
program folder, click on the Next > 
button.
The files are installed.

10 You are now asked to enter the IP 
address of the System Controller PC.
The default address of the System 
Controller PC is given. Please check 
with your IT Department if you should 
use a different fixed IP address for the 
System Controller. If your System 
Controller is using a different 
address, enter this address.
When you have made sure that the correct IP address has been entered, 
click on the Next > button.
44 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Setting Up the Photonic All-Parameter Analyzer Installing the Photonic All-Parameter Analyzer
The Photonic Analysis Toolbox uses the plug-and-play (PNP) drivers for 
the Agilent 8169. These are added to your system as part of the 
installation. These will replace any existing Agilent or HP 8169 PNP drivers 
on your system.

11 Click on the OK button to continue with the 
installation of the Agilent 8169 plug-and-play 
drivers.

Follow the instructions of the installer. 

Select to install the VISA files, if necessary. 

Select the Typical configuration, unless you have specific requirements 
for other instruments being used from this PC.

When the driver has been installed, 
click on the Finish button.

The Photonic Analysis Toolbox uses the 
plug-and-play (PNP) drivers for the 
Agilent 816x. These are added to your 
system as part of the installation. These 
will replace any existing Agilent or HP 
816x PNP drivers on your system.

12 Click on the OK button to continue with the 
installation of the Agilent 816x plug-and-play 
drivers.
Follow the instructions of the installer. 

Select to install the VISA files, if necessary.

Select the Complete configuration, unless you have specific 
requirements for other instruments being used from this PC.

When the driver has been installed, 
click on the Finish button.

13 The installation of the software has 
now completed. Click on the Finish 
button.

The software is now ready to run.
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Making Sure Everything Works
When you first start the System Controller PC, check in the Measurement 
and Automation Explorer (under Devices and Interfaces) of the System 
Controller software, that the two data acquisition (DAQ) cards are listed.

Use the test described in “Operational Verification Test” on page 222, to 
ensure the system is running correctly.
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Getting Started

Getting started covers how you fix components to the optical bench on the 
Optical Test Head, how you attach a test device, starting the system, 
setting up measurement parameters, and running a measurement.

Fixing Components to the Optical Bench . . . . . . . . . . . . . . 48

Fixing the Fiber Rails  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Using the Fiber Clamps  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Using the Termination Rod  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Using the DUT Holder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Fixing Other Objects to the Optical Bench . . . . . . . . . . . . . . . . . 54

Starting the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Making a First Measurement . . . . . . . . . . . . . . . . . . . . . . . . 56

To Set Up a New Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . 56

To Set the Parameters for a Measurement in Expert Mode . . . 59

Making an Expert Mode Measurement. . . . . . . . . . . . . . . . . . . . 72
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 47



Getting Started Fixing Components to the Optical Bench
Fixing Components to the Optical 
Bench 

 

Fiber rails, clamps and a DUT (device under test) holder are provided to 
help you set up efficient tests.

Fixing the Fiber Rails
Four fiber rails are provided to prevent fibers getting caught under the hood 
as you close it. These are pressed into the holes in the optical bench close 
to the edge.

Figure 5 Inserting a fiber rail into the optical bench

To remove the fiber rails, pull them out of the optical bench.

The optical bench can take a maximum weight of 10 kg (22 lbs.).
CAUTION

When fixing components to the optical bench, distribute the weight evenly 
to ensure the optimal operation of the suspension.NOTE
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Using the Fiber Clamps
1 At both sides of the body of the fiber clamp, pull the dust covers up off 

the two studs onto which they are wedged.

Figure 6 Removing the dust cover from a fiber clamp

2 Put the fixing bolts of the DUT holder into the mounting plugs.

3 Tighten the mounting plugs slightly so they start to bulge.

4 Insert the mounting plugs attached to the fiber clamp into the optical 
bench.

Figure 7 Inserting the fiber clamp into the optical bench

5 Use the hexagonal key to tighten the fixing bolts.

Figure 8 Tightening the fiber clamp into the optical bench

If the bolts and mounting plugs rotate in the holes of the optical bench, 
remove the fiber clamp from the optical bench, tighten the mounting 
plugs so they bulge a little more and try again.

6 Replace the dust caps on both sides, pressing them down on the studs.

To remove the fiber clamp from the optical bench, perform the procedure 
above in reverse.

To clamp a fiber:
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7 Raise the arm of the fiber clamp. 

Figure 9 Raising and lowering the fiber clamp

8 Arrange the fibers on the optical bench.

9 Lower the arm of the fiber clamp.
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Using the Termination Rod
1 Screw the termination rod into the mounting plug.

2 Tighten the mounting plug slightly so it starts to bulge.

3 Insert the mounting plug attached to the termination rod into the optical 
bench.

Figure 10 Inserting the termination rod into the optical bench

4 Rotate the termination rod to tighten it.

If the rod and mounting plug rotate in the hole of the optical bench, 
remove the termination rod from the optical bench, tighten the mounting 
plug so it bulges a little more and try again.

To remove the termination rod from the optical bench, perform the 
procedure above in reverse.

Making a Termination

To make a termination, wrap a length of the fiber around the rod 5 times. 
Fix the wrapped fiber (using adhesive tape, or an elastic band).

Figure 11 Creating a termination using the termination rod
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Using the DUT Holder

1 Screw the fixing bolts of the DUT holder into the mounting plugs.

2 Tighten the mounting plugs slightly so they start to bulge.

3 Insert the mounting plugs attached to the DUT Holder into the optical 
bench.

Figure 12 Inserting the DUT holder into the optical bench

4 Use the hexagonal key to tighten the fixing bolts.

Figure 13 Tightening the DUT holder into the optical bench

If the bolts and mounting plugs rotate in the holes of the optical bench, 
remove the DUT holder from the optical bench, tighten the mounting 
plugs so they bulge a little more and try again.

To remove the DUT holder from the optical bench, perform the procedure 
above in reverse.

To put a DUT into the holder:

Caution for persons with pacemakers.

Do not use the DUT holder with devices that are sensitive 
to magnetic fields.

The DUT Holder uses a magnetic clamp to hold the DUT.

CAUTION
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5 Raise the flap at the top. 

Figure 14 Opening and closing the DUT holder

6 Put the DUT into the opening.

7 Lower the flap to clamp the DUT in place.
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Fixing Other Objects to the Optical Bench
A number of standard optical bench mounting plugs and fixing bolts are 
supplied with your Photonic All-Parameter Analyzer. These plugs are 
threaded on the inside. 

To fix an object to the optical bench:

1 Insert fixing bolts through the fixing holes of the object, and screw them 
into the mounting plugs.

Figure 15 Inserting a fixing bolt into a mounting plug

2 Tighten the mounting plugs slightly so they start to bulge.

3 Insert the mounting plugs attached to the object into the optical bench.

Figure 16 Tightening the fixing bold into the optical bench

4 Use the hexagonal key to tighten the fixing bolts.

If the bolts and mounting plugs rotate in the holes of the optical bench, 
remove the object from the optical bench, tighten the mounting plugs so 
they bulge a little more and try again.

To remove the object from the optical bench, perform the procedure above 
in reverse.
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Starting the System

To make sure the Tunable Laser Source Module can perform as specified, it 
needs to warm up for an hour. Therefore you should power up the 
Lightwave Measurement System at least an hour before you intend to start 
measuring.

When you power up the Lightwave Measurement System, you will need to 
manually unlock it by entering the number “1234” on the keypad.

When you are ready to make your measurements, and if you have not 
already done so, power up the Polarization Controller and System 
Controller PC with the Photonic Analysis Toolbox software.
The Optical Test Head is powered by the System Controller PC, and does 
not need to be powered up separately. The Controller Engine software 
should start automatically.

After the hardware is powered up, run the Photonic Analysis Toolbox 
software by 

• double-clicking on the icon that was added to your desktop during the in-
stallation or

• clicking on the Windows Start button, selecting Programs, then the 
Photonic Tools folder, and clicking on Photonic Analysis Toolbox.

The software runs, and the Photonic Analysis Toolbox software 
automatically detects the hardware connected over the GP-IB.
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 55



Getting Started Making a First Measurement
Making a First Measurement

Before you begin to make your first measurement, attach your Interface 
Adapters to the input and output of the Optical Test Head.

To Set Up a New Measurement

1 Click on

2 Select the measurement mode you want to use.
The software can be used in two modes: the "All Parameter mode" and 
the "Expert mode". 

• All Parameter mode is recommend for general use.
All Parameter mode includes the realtime and full-performance meas-
urements. This allows you to check and adjust the setup with a real-
time measurement (updated every 1 to 2 seconds) and then do a full 
performance specified measurement — or continue with realtime 
measurements for continued adjustments of the Device under Test.

Only selected combinations of measurements are possible in standard 
All Parameter Test mode. The permitted combinations are Fast GD, 
Fast IL, Fast GD and Fast IL, DGD/GD, PDL/IL, DGD/GD and PDL/IL.
The start, stop and wavelength parameters for both loss and disper-
sion measurements must be the same.
If both transmission and reflection measurements are being made, the 
same combination of measurements must be made in both directions.

Never look directly into the end of a fiber or a connector, unless 
you are absolutely certain that there is no signal in the fiber.

CAUTIONWARNING

Realtime measurements are made using interferometry:
Fast IL results are derived from the interferogram and PDL/IL results are 
calculated using a Jones Matrix. 

NOTE
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• Expert mode allows full freedom in the selection of parameters, any 
combination of loss and dispersion measurements, and seperate con-
gifuration of measurement parameters for loss measurements and 
dispersion measurements. It also supports measurements over 50 nm 
with the highest resolution.
Expert mode does not support real-time measurements.

3 Enter the information about your device under test (DUT), if desired.

This includes

4 If you have more than one setup hardware, select the hardware to be 

ID The identification of the DUT

DUT Temperature The temperature of the DUT during the measurement. 
This is used for documentation purposes only. It is not 
used in any calculations.The temperature range at which 
the Photonic All-Parameter Analyzer meets its 
specifications is given in “Performance Specifications” 
on page 216

Comment Space to add comments on the DUT and the 
measurement.
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used for the measurement from the pull-down menus.

Click on the Next > button.
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To Set the Parameters for a Measurement in 
Expert Mode

1 Set the measurement parameters for the phase measurements.

a Select the measurement

Parameters for Expert-Mode measurements cannot be used to make 
realtime measurements.

You can select DGD measurements even if DGD and PMD measurements 
are not possible on your All-Parameter Analyzer (option #005). However 
the DGD measurement will not be carried out, and the PMD analysis is not 
possible.

NOTE

NOTE

Fast GD To make just a group delay measurement, using 
a single polarization state.
Reference measurements are optional for the 
Fast GD measurement.

GD/DGD To make both group delay and differential group 
delay measurements, using two polarization 
states.
Reference measurements are required.

No Phase Measurement To skip the measurement of group delay and 
differential group delay 
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b Select the light path

c If you are running a GD/DGD measurement, you can also select to 
generate a Jones Matrix for export as an ASCII file.
The Jones matrix can only be generated during a measurement. It 
cannot be generated from existing measurement data. Once 
generated, the Jones Matrix is saved with your measurement data, 
increasing the size of a measurement file by approximately 50%.

d Set the start and stop wavelengths, and the step size for the sweep. 
The step size of the wavelength sweep limits the possible 
resolution bandwidth of the results for the group delay and 
differential group delay, as well as the resolution bandwidth of the 
chromatic dispersion analysis.
For phase measurements, the maximum step size is 100pm.
The maximum wavelength span depends on the sweep speed of the 
tunable laser source. The dependency between span and sweep 
speed is given in “Dispersion Measurement Specifications” on 
page 218.

e Select the number of scans. The result is averaged across the 
selected number of scans.
Increasing the number of scans reduces the noise floor, but 
increases the measurement time. 
Graphs of uncertainty as a function of the spectral averaging time 
and the number of averages are given in “Supplementary dispersion 
measurement characteristicsa” on page 219.

f Set the Resolution Bandwidth of the group delay and differential 
group delay results, by entering the size factor of the sliding window 
for the calculation of the group delay and differential group delay. 
The sliding window is of Gaussian shape, centered on the current 
wavelength.
The resolution bandwidth is the 2σ value of the sliding window and 
is the product of the size factor and the step size for the sweep.
The resolution bandwidth of the chromatic dispersion analysis is 

Transmission To measure in the transmission path only.

Reflection To measure in the reflection path only.

Transmission + Reflection To measure in both transmission and reflection 
paths.
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described in “Setting up the Auto-Analysis of Results” on page 152 
and “Analyzing Chromatic Dispersion” on page 178.

g Set the sweep speed of the tunable laser by opening "Options..." 
and selecting the proper speed in "Phase Options":

The higher the sweep speed the lower is the impact of 
environmental disturbances. Increasing sweep speed improves 
phase measurement accuracy. The maximum usable sweep speed 
depends on the device length to be tested. The dependency 
between sweep speed and device length is given in “Dispersion 
Measurement Specifications” on page 218.

2 Set the measurement parameters for the loss and polarization 
dependent loss measurements

a Select the measurement

Fast Loss To make just a loss measurement, using a single 
polarization state
Reference measurements are optional for the 
Fast Loss measurement.

Loss/PDL To make both loss and polarization dependent 
loss measurements, using four polarization 
states.
Reference measurements are required.

No Loss Measurement To skip the measurement of loss and polarization 
dependent loss.
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b Select the light path

c Set the start and stop wavelengths, and the step size for the sweep.
If you want to use the same values as you entered for the phase 
measurement, click in the box beside Use Phase sweep 
wavelength to make sure it has a check mark.
For loss measurements, the maximum step size is 
200 pm.

d Select the Number of Sweeps to use for the measurement.
Each sweep is performed at a different power sensor range, and the 
results are combined to provide an increased dynamic range.
A single sweep provides a dynamic range of 35 dB (typical), two 
sweeps provides a dynamic range of 50 dB (typical), three sweeps 
provides the specified dynamic range of over 55 dB in the 
transmission path and over 45 dB in the reflection path.
Increasing the number of sweeps increases the measurement time.

e To set the start of the power sensor range for your measurement, 
please refer to “Setting the Start Range for the Power Sensor” on 
page 149.

f To set the start of the coherence control for the Tunable Laser 
Source Module, please refer to “Controlling the Quality of the Laser 
Signal” on page 149.

Transmission To measure in the transmission path only.

Reflection To measure in the reflection path only.

Transmission + Reflection To measure in both transmission and reflection 
paths.
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To Set the Parameters for a Measurement in All 
Parameter Mode
1 Set the measurement parameters

.

You can select DGD measurements even if DGD and PMD measurements 
are not possible on your All-Parameter Analyzer (option #005). However 
the DGD measurement will not be carried out, and the PMD analysis is not 
possible.

NOTE
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a Select the measurement

b Select the light path

Fast GD To make just a group delay measurement, using a 
single polarization state.
Reference measurements are optional for the 
Fast GD measurement.

Fast Loss To make just a loss measurement, using a single 
polarization state
Reference measurements are optional for the 
Fast Loss measurement.

Fast GD and Fast Loss To make just a group delay and a loss 
measurement, using a single polarization state 
for the Fast GD, and a second single polarization 
state for the Fast Loss measurement.
Reference measurements are optional for the 
Fast GD and Fast Loss measurements.

GD/DGD To make both group delay and differential group 
delay measurements, using two polarization 
states.
Reference measurements are required.

Loss/PDL To make both loss and polarization dependent 
loss measurements, using four polarization 
states.
Reference measurements are required.

GD/DGD and Loss/PDL To make group delay, differential group delay, 
loss and polarization dependent loss 
measurements, using two polarization states for 
the GD/DGD measurement and four polarization 
states for the Loss/PDL measurement.
Reference measurements are required.

Transmission To measure in the transmission path only.

Reflection To measure in the reflection path only.

Transmission + Reflection To measure in both transmission and reflection 
paths.
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c If you are running a GD/DGD measurement, you can also select to 
generate a Jones Matrix for Export as an ASCII file.
The Jones matrix can only be generated during a measurement. It 
cannot be generated from existing measurement data. Once 
generated, the Jones Matrix is saved with your measurement data, 
increasing the size of a measurement file by approximately 50%.

d Set the start and stop wavelengths, and the step size for the sweep.
The step size of the wavelength sweep limits the possible 
resolution bandwidth of the results for the group delay and 
differential group delay, as well as the resolution bandwidth of the 
chromatic dispersion analysis.
For measurements in All Parameter mode, the maximum step size is 
100 pm.

2 Set the measurement parameters for the phase measurements
Click on the Phase Options tab to select this configuration if it is not 
already shown.

a Select the number of scans. The result is averaged across the 
selected number of scans.
Increasing the number of scans reduces the noise floor, but 
increases the measurement time. 
Graphs of uncertainty as a function of the spectral averaging time 
and the number of averages are given in “Supplementary dispersion 
measurement characteristicsa” on page 219.

b Set the Resolution Bandwidth of the group delay and differential 
group delay results, by entering the size factor of the sliding window 
for the calculation of the group delay and differential group delay. 
The sliding window is of Gaussian shape, centered on the current 
wavelength.
The resolution bandwidth is the 2σ value of the sliding window and 
is the product of the size factor and the step size for the sweep.
The resolution bandwidth of the chromatic dispersion analysis is 
described in “Setting up the Auto-Analysis of Results” on page 152 
and “Analyzing Chromatic Dispersion” on page 178.

c Set the sweep speed of the tunable laser by opening "Options..." 
and selecting the proper speed in "Phase Options":

The higher the sweep speed the lower is the impact of 
environmental disturbances. Increasing sweep speed improves 
phase measurement accuracy. The maximum usable sweep speed 
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depends on the device length to be tested. The dependency 
between sweep speed and device length is given in “Dispersion 
Measurement Specifications” on page 218

3 Set the measurement parameters for the loss and polarization 
dependent loss measurements

Click on the Loss Options tab to select this configuration if it is not 
already shown.

a Select the Number of Sweeps to use for the measurement.
Each sweep is performed at a different power sensor range, and the 
results are combined to provide an increased dynamic range.
A single sweep provides a dynamic range of 35 dB (typical), two 
sweeps provides a dynamic range of 
50 dB (typical), three sweeps provides the specified dynamic range 
of over 55 dB in the transmission path and over 45 dB in the 
reflection path.
Increasing the number of sweeps increases the measurement time.
To set the start of the power sensor range for your measurement, 
please refer to “Setting the Start Range for the Power Sensor” on 
page 149.
To set the start of the coherence control for the Tunable Laser 
Source Module, please refer to “Controlling the Quality of the Laser 
Signal” on page 149.
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To Perform the Reference Measurements

When you have set all the parameters for the measurement, you must 
perform a reference measurement.

4 You are prompted to start the Initialization Reference. 

• If the system has been initialized recently and the hardware and meas-
urement setup has not been changed, click on the Next > button to 
skip the Initialization Reference.

a It is recommended that you zero the power sensors before 
beginning the reference measurement.

If the power sensors have been zeroed recently and the setup has 
not be changed, click on the box to remove the check mark.

b If you have changed the setup, or if you want to ensure meeting the 
specifications, click on the Start... button.

• If you are zeroing the power meters, you are prompted to set up the 
Optical Test Head for the Initialization Measurement by disconnecting 

Do not look directly into the Optical Test Headconnector, unless 
you are absolutely certain that there is no signal.

CAUTIONWARNING
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any fibers and putting protective caps on the input and output of the 
Optical Test Head.
Click on the OK button.
The power sensors are zeroed and the initialization reference is made.

c If you are not zeroing the power meters, you are prompted to set up 
the Optical Test Head for the Initialization Measurement by 

disconnecting any fibers from the input and the output of the 
Optical Test Head.
Click on the OK button.
The Initialization Reference runs.

5 When the Initialization Reference finishes, you are prompted to set up 
the Optical Test Head for the Reference Measurement.
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a Select the type of reference measurement you want to perform.

b Click on the Start... button.

6 If you have selected a transmission reference measurement, you are 

Transmission To measure a reference in the transmission path 
only.
This option is only available if your measurement 
parameters specify only a measurement in the 
transmission path.

Reflection To measure a reference in the reflection path only 
using a reflective reference device.
This option is only available if your measurement 
parameters specify only a measurement in the 
reflection path.

Terminated Reflection To measure a reference in the reflection path 
using a reflective reference device and include a 
reference with a termination device.
This option is only available if your measurement 
parameters specify only a measurement in the 
reflection path.
The measurement of the terminated reflection 
reference extends the time for the reference 
measurement, but adds to the overall accuracy of 
the results.

Transmission and 
Reflection

To measure a reference in both transmission and 
reflection paths.

Transmission and 
Terminated Reflection

To measure a reference in both transmission and 
reflection paths, including a termination 
reference.
The measurement of the terminated reflection 
reference extends the time for the reference 
measurement, but adds to the overall accuracy of 
the results.
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prompted to set up the Optical Test Head for this measurement.

a Connect or splice the Transmission Reference Fiber from the input 
to the output of the Optical Test Head.
Place the Transmission Reference Fiber on the optical bench of the 
Optical Test Head. 

b Click on the OK button.
The reference transmission measurement runs in one or two cycles, 
depending on the measurements selected, to calibrate the 
transmission path for the Loss/PDL measurements and then for the 
GD/DGD measurements.

c Disconnect the Transmission Reference Fiber from the Optical Test 
Head.

d If there are other reference measurement tasks to be done, click on 
the Start... button.

7 If you have selected a reflection reference measurement, you are 
prompted to set up the Optical Test Head for this measurement..

Please make sure that any optical connectors that you are using are clean 
before making a connection.NOTE

Please make sure that any optical connectors that you are using are clean 
before making a connection.NOTE
70 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Making a First Measurement Getting Started
a Connect or splice the Reflectance Reference Device to the output of 
the Optical Test Head.

b Place the Reflectance Reference Fiber on the optical bench of the 
Optical Test Head. 

c Click on the OK button.
The reference reflection measurement runs in one or two cycles, 
depending on the measurements selected, to calibrate the 
reflection path for the Loss/PDL measurements and for the 
GD/DGD measurements.

d If there are other reference measurement tasks to be done, click on 
the Start... button.

8 If you have selected a terminated reflection reference measurement, 
you are prompted to set up the Optical Test Head for this measurement.

a Connect or splice a fiber to the output of the Optical Test Head.

b Place the termination rod in the optical bench of the Optical Test 
Head, and wrap a length of the fiber around the rod 5 times. Fix the 
wrapped fiber (using adhesive tape, or an elastic band). Fix the fiber 
using the fiber clamps. See “Using the Termination Rod” on page 51 
and “Using the Fiber Clamps” on page 49 for more information on 
making a termination and fixing the fiber.

c Click on the OK button.
The reference termination measurement runs.

d If there are other reference measurement tasks to be done, click on 
the Start... button.

9 Disconnect the fiber from the Optical Test Head.

10 Click on the Finish button.

Please make sure that any optical connectors that you are using are clean 
before making a connection.NOTE
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Making an Expert Mode Measurement
After you have completed the reference measurement, you can 
parameterize your devices.

11 Click on 
OR
From the Measurement menu, select Start DUT Measurement.

12 Click on 

in the port-selection menu bar..

13 Connect or splice the DUT from the input to the output of the Optical 
Test Head.
Fix the DUT on the optical bench of the Optical Test Head, and fix the 
input and output fibers, using the fiber clamps. See “Using the DUT 
Holder” on page 52 and “Using the Fiber Clamps” on page 49 for more 
information on fixing the DUT and the fibers.

The measurement runs, showing the measurement status as it 
progresses.
When the measurement finishes, the results are shown.

14 If you want to measure the transmission characteristic of another 
output of a multiport device, click on , and repeat step 12 to 
step 13.

Never look directly into the end of a fiber or a connector, unless 
you are absolutely certain that there is no signal in the fiber.

Please make sure that any optical connectors that you are using are clean 
before making a connection.

WARNING

NOTE
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If you want to abort the measurement of a port, click on .
This will affect only the port that is currently being measured.

15 When you have finished measuring all the ports of your device, click on 
.

To measure further devices, click on , and repeat step 12 to step 15.
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Making a Real-time Measurement in All Parameter 
Mode

After you have completed the reference measurement, you can 
parameterize your devices.

16 Connect or splice the DUT from the input to the output of the Optical 
Test Head.
Fix the DUT on the optical bench of the Optical Test Head, and fix the 
input and output fibers, using the fiber clamps. See “Using the DUT 
Holder” on page 52 and “Using the Fiber Clamps” on page 49 for more 
information on fixing the DUT and the fibers.

17 Click on 
OR
From the Measurement menu, select Start Realtime Measurement.

The measurement runs.
As each measurement finishes, the results are shown. The results are 
updated once a second.

18 If you want to pause the measurement, click on 
OR
From the Measurement menu, select Pause Realtime Measurement.

To restart the measurement, click on 
OR
From the Measurement menu, select Start Realtime Measurement.

19 When you have finished measuring, click on 
OR
From the Measurement menu, select Stop Realtime Measurement.

Never look directly into the end of a fiber or a connector, unless 
you are absolutely certain that there is no signal in the fiber.

Please make sure that any optical connectors that you are using are clean 
before making a connection.

You can only make measurements with realtime support if all-parameter 
mode has been selected as part of the setup of the new measurement.

WARNING

NOTE

NOTE
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The Photonic Analysis Toolbox Reference

This chapter provides reference information on the menus, toolbars and 
other functions of the Photonic Analysis Toolbox application.

The chapter starts with a description of each menu and all its items. This is 
followed by a description of the context menus that are available.
The chapter finishes with a description of the icons used by the software.

The File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

The Instruments Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
The Measurement Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

The Measurement Setup Submenu . . . . . . . . . . . . . . . . . . . . . . . 83

Other Items in the Measurement Menu . . . . . . . . . . . . . . . . . . . 85

The Analysis Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
The Graph Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

The Transmission Graph Submenu  . . . . . . . . . . . . . . . . . . . . . . . 92

The Reflection Graph Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Other Items in the Graph Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . 94

The View Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
The Options Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

The Layout Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

The Log Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

X-Axes Dimension Submenu. . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

The Window Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
The Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
The Graph Context Menu . . . . . . . . . . . . . . . . . . . . . . . . . . 107

The Zoom Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

The Marker Submenu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Other Items in the Graph Context Menu . . . . . . . . . . . . . . . . . . 110

The Marker Context Menu . . . . . . . . . . . . . . . . . . . . . . . . . 111
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 75



The Photonic Analysis Toolbox Reference
The Setup View Root Context Menu. . . . . . . . . . . . . . . . . 112

The Measurement View Root Context Menu  . . . . . . . . . 113
The Measurement View Context Menu . . . . . . . . . . . . . . 114
The Curve View Root Context Menu. . . . . . . . . . . . . . . . . 119
The Curve View Context Menu  . . . . . . . . . . . . . . . . . . . . . 120
The Curve View Result Context Menu . . . . . . . . . . . . . . . 121
The Standard Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

The Instrument Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
The Measurement Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . 125
The Realtime Measurement Toolbar . . . . . . . . . . . . . . . . . 129
The Graph Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
The X-Axes Dimension Toolbar  . . . . . . . . . . . . . . . . . . . . . 132
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The File Menu

Open Opens a file browser window to select and load a measurement result and 
any analysis data that is available from a file (*.omr).

The same function is available 

• on “The Standard Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “O” 
key (CTRL+O).

Save All Saves all the opened measurements to files (*.omr).
The measurements are saved with their current name, as shown in the 
Measurement View tab of the Workspace window. See “The View Menu” 
on page 95 for information on how to view the Workspace window.

The same function is available 

• on “The Standard Toolbar”  using .

Close All

All the opened measurements are removed from memory.

Save Active
Measurement

Saves the active measurement to a file (*.omr).
The measurements is saved with its current name, as shown in the 
Measurement View tab of the Workspace window. 

The same function is available 

• on “The Standard Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “S” 
key (CTRL+S).

To save the active measurement or any of the non-active measurements 
that are open, use Save in “The Measurement View Context Menu” .

Make sure you have saved any new measurements, or measurements for 
which you have changed the analysis parameters before you close all the 
measurements.

NOTE
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Save Active
Measurement

As...

Saves the active measurement to a file (*.omr) with a name you specify.

1 Enter the name for the file and click on the Save button.

The measurement is saved.

To save the active measurement or any of the non-active measurements 
that are open to a different file, in the Measurement View tab of the 
Workspace use Save As in “The Measurement View Context Menu” .

Close Active
Measurement

The active measurement is removed from memory.

To close the active measurement or any of the non-active measurements 
that are open, use Close in “The Measurement View Context Menu” .

Open
Measurement

Setup

Opens a file browser window to select and load a measurement setup from 
file (*.omr).

If you want to protect the measurement setup from alteration, check the 
“Open as read-only” box at the bottom of the file browser window.

You will be able to alter the measurement setup, but you will not be able to 
overwrite the original file.
You can save the altered measurement setup to a different file using “Save 
Measurement Setup As...”  in the File menu.

Save
Measurement

Setup

Saves the current measurement setup to a file (*.omr).
The measurements is saved with its current name, as shown in the Setup 
View tab of the Workspace window. See “The View Menu” on page 95 for 
information on how to view the Workspace window.

Save
Measurement

Setup As...

Opens a file browser window to name the file (*.omr) to which the current 
measurement setup is to be saved.

Enter the name for the file and click on the Save button.

The current measurement setup is saved.
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ASCII Export... Opens a measurement selection window to select the measurement 
for which the results are to be exported.

1 Click on the measurement for which you want to export results.

2 Click on the Next button.

3 Make sure the only boxes checked are beside the parts of the 
measurement you want to export.

4 Select the number of samples you want to export for each curve.
If you select “All”, all of the samples used to draw the measurement 
curve will be exported.
If you select a number, that number of equally spaced samples will be 
exported. This makes it easier for you to compare curves, to generate 
consistent curves in an external application, or to reduce the quantity 
of data for post-processing by other applications.

5 Click on the Next button.

6 Enter the name for the file and click on the Finish button.

The selected results are exported to an ASCII text file using comma (,) 
separated values (.csv).

The format of the .csv file is described in “Exporting Trace Data” on 
page 207.
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ASCII Export
Mueller Matrix...

Opens a file browser window to name the file (*.txt) to which the Mueller 
matrix from the current measurement setup is to be saved.

Enter the name for the file and click on the Save button.

The format of the .csv file is described in “Exporting the Mueller Matrix” on 
page 211.

ASCII Export
Jones Matrix...

Opens a file browser window to name the file (*.txt) to which the Jones 
matrix from the current measurement setup is to be saved.

Enter the name for the file and click on the Save button.

The format of the .csv file is described in “Exporting the Jones Matrix” on 
page 210.

Print Prints the measurement and analysis setup, any graphs which contain one 
or more curves (including such graphs that are currently minimized on the 
screen) and the tables for the active measurement result or analysis.

In the Print window, select the printer you want to use, and press the OK 
button.

The same function is available 

• on “The Standard Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “P” 
key (CTRL+P).

Print Setup Configures the printer to be used for printing measurement results and 
analyses, and graphs.

Print Preview Shows a preview of the printout of the active measurement results or 
analysis.

The same function is available 

• on “The Standard Toolbar”  using .

Exit Ends the Photonic Analysis Toolbox application.
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The Instruments Menu

Scan for
Instruments

Scans the GPIB and the network bus for available measurement 
instruments.

The Photonic Analysis Toolbox scans the GPIB and the network on startup. 
If you add or remove an instrument, use Scan for Instruments to update 
the list of instruments.

If the list of instruments is not shown automatically after the scan has 
completed, use Show Instruments... in the Instruments menu.

To show the list of instruments automatically after each scan,

1 In the Instruments menu, select Show Instruments....

2 Click on the box beside “Show this dialog after each instrument scan 
automatically” until it is checked.

The same function is available 

• in “The Instrument Toolbar” , select .

Show
Instruments...

Lists the measurement instruments recognized by the Photonic Analysis 
Toolbox.

If you scan the GPIB, or change the hardware selection, the current 
measurement setup is discarded. You will need to create a new 
measurement, including the setting of the measurement parameters, and 
the making of a reference measurement, before you can make further 
measurements.

NOTE
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• Click on an instrument to see its details.

• Click on  beside an instrument or module to see its modules or 
connections.

Use Scan for Instruments in the Instruments menu option to scan the bus 
again and update the list.

The same function is available 

• in “The Instrument Toolbar” , select .

Zero All Power
Sensors

Zeros the three power sensors in the Lightwave Measurement System.

You may want to zero the power meters manually before making a 
reference measurement, if you load existing reference data from a file, or 
to ensure the best possible performance.

The same function is available 

• in “The Instrument Toolbar” , select .

Make sure the three patchcords in the tubing from the back of the Optical 
Test Head are connected to the inputs of the power sensors before you 
zero them.

NOTE
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The Measurement Menu

The measurement menu provides access to the control for setting up and 
performing measurements.

The Measurement Setup Submenu
New This starts a new measurement, including setting up the hardware, 

measurement parameters, making a reference, and measuring a device, as 
described in “Making a First Measurement” on page 56.

The same function is available 

• on “The Measurement Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “N” 
key (CTRL+N).

Edit Parameters...

Allows examination and individual adjustment of the measurement 
parameters that will be used for the next measurement.

The same function is available 

• on “The Measurement Toolbar”  using , or 

• by double clicking on the Measurement Parameters element of the 
current measurement in the Setup View tab of the Workspace window. 
See “The View Menu” on page 95 for information on how to view the 
Workspace window.

Reconfigure
Instrument

Setup...

Select the hardware to be used for the measurement from the pull-down 
menus.

If you change the measurement parameters, you may have to make a 
reference measurement before you can make further measurements.NOTE
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The same function is available 

• on “The Measurement Toolbar”  using .

After you have selected the hardware, you will automatically be required to 
check or change the measurement parameters.
Click on the Next > button.

DUT Information Provides a boilerplate for you to add information about the device under 
test (DUT).
Click on the Edit button to change the information.

This includes

The same function is available 

• on “The Measurement Toolbar”  using 

Properties... Shows the measurement information.

If you want to change the operator ID, click on the Edit button.

ID The identification of the DUT

Serial Number The serial number of the DUT

DUT 
Temperature

The temperature of the DUT during the measurement. This is 
used for documentation purposes only. It is not used in any 
calculations.
The temperature range at which the Photonic All-Parameter 
Analyzer meets its specifications is given in “Performance 
Specifications” on page 216

Comment Space to add comments on the DUT and the measurement.
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Other Items in the Measurement Menu
Set as Active

Measurement
Click on the measurement from the submenu that you want to set as the 
active measurement.

The same function is available

• using Set as Active Measurement in “The Measurement View Context 
Menu” .

• using Set as Active Measurement in “The Curve View Context Menu” .

Create Setup from
Active

Measurement

Use the measurement setup from the current active measurement for 
following measurements.

The same function is available 

• using Create Setup from Measurement in Ò The Measurement View 
Context Menu Ó .

Start Reference Starts the reference measurement.

The same function is available 

• on “The Measurement Toolbar”  using , or 

• from the keyboard by holding down the SHIFT key and pressing the “F5” 
key (SHIFT+F5).

Start DUT
Measurement

Starts the measurement.

The same function is available 

• on “The Measurement Toolbar”  using , or 

• from the keyboard by pressing the “F5” key.

On completion, the results are displayed in the Graph window, in the 
Analysis Table window and the measurement is added to the 
Measurement View in the Workspace window.

The completed measurement becomes the current active measurement.

Until saved, results have the default filename Noname001, Noname002, 
and so on.

If you change the measurement parameters, you may have to make a 
reference measurement before you can make further measurements.NOTE
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Start Realtime
Measurement

Starts a measurement with fast update ratea for checking device 
connections and measurement parameters, or as a prelude to measuring 
dispersion properties for devices such as Dispersion Compensating 
Gratings.

The same function is available 

• on “The Measurement Toolbar”  using , or 

• from the keyboard by pressing the “F7” key.

The results are displayed in the Graph window and the measurement is 
added as the Current Measurement to the Measurement View in the 
Workspace window. 

Pause Realtime
Measurement

Pauses a realtime measurement.

The same function is available 

• on “The Measurement Toolbar”  using , or 

• from the keyboard by pressing the “PAUSE” key.

Restart the measurement by selecting Start Realtime Measurement. 

Stop Realtime
Measurement

Stops a realtime measurement, and clears the realtime traces.

The same function is available 

• on “The Measurement Toolbar”  using , or

• from the keyboard by pressing the “Ctrl-F7” key.

a The update rate of the realitme measurement depends on the sweep range, but 
is typically 1Hz for a filter-type device.

The results of the realtime measurement are only intended for verification 
or making adjustments.
The results are derived from a single sweep and do not provide as high an 
accuracy as the normal DUT measurement (as specified in “System 
Specifications” on page 215).

NOTE
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The Analysis Menu

Auto-Analysis
Setup...

Sets the automatic analysis of results after they have been measured. 

The results of the peak and notch analyses are shown in the Analysis Table 
window. The Chromatic Dispersion is shown in its own graph window.

The same function is available 

• on “The Measurement Toolbar”  using .

1 Click on the boxes to set a check mark beside Loss Analysis or Phase 
Analysis, depending on which auto-analysis you want to perform.
Click on the Next > button.

The parameters for chromatic dispersion must be configured here if you 
want to view chromatic dispersion using a real-time measurement.NOTE
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2 If you selected loss analysis.

a Click on the boxes to set a check mark in the row and column 
corresponding to the loss analyses you want to perform (generic, 
peak and notch analyses, in the transmission and reflection paths).
Click on the Next > button.

b If you selected peak analysis, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing. 
For more information on these parameters and what effect they 
have, see “Reanalyzing the Generic, Peak and Notch Loss” on 
page 196.

c If you selected notch analysis, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing.
For more information on these parameters and what effect they 
have, see “Reanalyzing the Generic, Peak and Notch Loss” on 
page 196.

3 If you selected phase analysis, set the Resolution Bandwidth of the 
Chromatic Dispersion analysis by entering the number of adjacent 
samples used in the sliding window for the calculation.
The sliding window is centered on the current wavelength.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.

4 Click on the Finish button.
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Reanalyze
Phase...

Replaces the existing or nonexisting Chromatic Dispersion analysis for the 
selected measurements with an analysis based on the new value for the 
resolution bandwidth.

The chromatic dispersion is shown as a graph for the available light paths 
for the measurement. See “The Transmission Graph Submenu” on page 92 
and “The Reflection Graph Submenu” on page 93 for details on how to 
display the chromatic dispersion graph. 

To reanalyze the chromatic dispersion for the active measurement, use 
Reanalyze Phase in “The Measurement View Context Menu” .

1 Click on the boxes to set a check mark beside the measurements you 
want to reanalyze.

2 Set the Resolution Bandwidth of the Chromatic Dispersion analysis by 
entering the number of adjacent samples used in the sliding window 
for the calculation.
The sliding window is centered on the current wavelength.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.

3 Click on the OK button.

Reanalyze Loss... Replaces existing or nonexisting peak or notch loss analyses for the 
selected measurements with analyses based on the new values for the 
analysis parameters.

The loss analyses are shown in the Analysis Table window. See “The View 
Menu” on page 95 for details on how to display the Analysis Table window.
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To reanalyze the peak or notch, use Reanalyze Loss in “The Measurement 
View Context Menu” .

1 Click on the boxes to set a check mark beside the measurements you 
want to reanalyze.

2 Click on the boxes to set a check mark beside the measurements you 
want to reanalyze.

Click on the Next > button.

3 If you selected peak analyses, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing. 
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For more information on these parameters and what effect they have, 
see “Reanalyzing the Generic, Peak and Notch Loss” on page 196.

4 If you selected notch analyses, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing.
For more information on these parameters and what effect they have, 
see “Reanalyzing the Generic, Peak and Notch Loss” on page 196.

5 Click on the Finish button.

Compare Loss
Analysis with

Active
Measurement...

Temporarily reanalyzes the generic, peak and notch loss analyses for the 
selected measurements with analyses based on the analysis parameters 
of the active measurement, and adds the resulting analyses to the analysis 
tables.

The analyses and analysis parameters for the selected measurements are 
not altered in the file or the measurement. If you change the active 
measurement, the analyses for the comparison are deleted.
To change the analyses for a measurement, “Reanalyze Loss...” on 
page 89.

The loss analyses of the active measurement and the measurements 
selected for comparison are shown in the Analysis Table window.
See “The View Menu” on page 95 for details on how to display the 
Analysis Table window.

To compare the loss analyses for any individual non-active measurement 
that is open with the active measurement, use Compare Loss Analysis 
with Active Measurement in the “The Measurement View Context Menu” 
.

1 Click on the boxes to set a check mark beside in the row and column 
corresponding to the loss analyses you want to compare with the 
active measurement (generic, peak and notch analyses, in the 
transmission and reflection paths).

2 Click on the Finish button.
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The Graph Menu

The graph menu lets you select which graphs are displayed, and control of 
the universal display possibilities

The Transmission Graph Submenu
There are five transmission graph windows:

• Loss (Loss)

• Polarization Dependent Loss (PDL)

• Group Delay (GD)

• Differential Group Delay (DGD)

• Chromatic Dispersion (CD)

In each case the graph window displays the selected curves of the 
measurement results over wavelength (nm).

Select Loss, PDL, GD, DGD, or CD in the Transmission Graph submenu to 
activate any individual graph window or combination of these graph 
windows.

You can select which curves are selected in the Curve View tab of the 
Workspace window. See “The View Menu” on page 95 for information on 
how to view the Workspace window.

Bring to Front Bring any transmission graphs that are active to the front. Any active 
reflection graphs will be minimized.

The same function is available 

• on “The Graph Toolbar”  using .
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The Reflection Graph Submenu
There are five reflection graphs:

• Loss (Loss)

• Polarization Dependent Loss (PDL)

• Group Delay (GD)

• Differential Group Delay (DGD)

• Chromatic Dispersion (CD)

In each case the graph window displays the selected curves of the 
measurement results over wavelength (nm).

Select Loss, PDL, GD, DGD or CD in the Reflection Graph submenu to 
activate any individual graph window or combination of these graph 
windows.

You can select which curves are selected in the Curve View tab of the 
Workspace window. See “The View Menu” on page 95 for information on 
how to view the Workspace window.

Bring to Front Bring any reflection graphs that are active to the front. Any active 
transmission graphs will be minimized.

The same function is available 

• on “The Graph Toolbar”  using .
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Other Items in the Graph Menu
Noise

Suppression...
Specifies the Noise Suppression Threshold. Enter the value for the 
threshold and click on the OK button.

The Loss Measurement curve, in the measurement path of the currently 
active graph, is examined for sections with signal strength less than the 
threshold.
Any areas below the threshold are removed from the display of the other 
curves in the measurement path.
The display of the loss curve is not affected.
Graphs which did not use the same measurement parameters as the loss 
measurement are not affected.

Zoom Out All Zoom out to view the full curves in all the graph windows.

The same function is available

• on “The Graph Toolbar”  using .

Double-click in a graph window to zoom out to view the full curves in that 
window.

Show Markers Select this to show or hide all markers in the graph windows.

The same function is available 

• on “The Graph Toolbar”  using .

Use the graph context menu in a particular graph window to show or hide 
the markers in that window. See “The Graph Context Menu” on page 107 
for more information.

Show Orientation
Curves

Select this to show or hide all the orientation curves in the graph windows.
If orientation curves are selected, the loss average curve is shown in the 
background of each curve. This provides a visual reference to help you 
correlate between different curves of the same measurement.

The same function is available 

• on “The Graph Toolbar”  using .

Use the graph context menu in a particular graph window to show or hide 
the orientation curves for that window. See “The Graph Context Menu” on 
page 107 for more information.
94 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



The View Menu The Photonic Analysis Toolbox Reference
The View Menu

The Photonic Analysis Toolkbox's View menu allows you to enable and 
disable the different on-screen areas of the Photonic Analysis Toolbox.

The layout of the graphs in the Graph window is controlled from the 
Window menu, see “The Window Menu” on page 104.

The workspace, analysis table and log windows and the toolbars can be 
“detached” from the Photonic Analysis Toolbox window and placed 
anywhere on your PCs screen:

1 Double-click on the header or sidebar ( ).

2 Click in the window title bar and drag it to the new position.

To re-attach the Workspace, Log or Analysis Table window, double click in 
the window title bar.

Resizing and closing any window is done according to the normal 
Windows conventions.

Workspace

Analysis Table

Log

Toolbars

Status Bar

Graph
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Workspace If Workspace is selected, you can view the setup and history of the 
measurements made in the current session.

• The Setup View shows the current preparations for measurements: 
Click on the Setup View tab at the bottom of the Workspace window to 
see it.

• Click with the right mouse button on Current Measurement Setup to 
access “The Setup View Root Context Menu”  (see page 112).

• Double-click on DUT Information to view or edit the ID, serial number, 
temperature information or comments for the next DUT to be meas-
ured. See “DUT Information” on page 84.

• Double-click on Measurement Parameters to view or edit the param-
eters for the next measurement. See “Checking or Setting the Meas-
urement Parameters” on page 139.

• Double-click on Instrument Setup to view or reconfigure the instru-
ments in use for the next measurement. See “Show Instruments...” on 
page 81.
Click on the Reconfigure button at the bottom left of this box to recon-
figure the instruments. See “Reconfigure Instrument Setup...” on 
page 83.

• Double-click on Analysis Settings to edit the automatic analysis set-
tings applied after the measurement. See “Auto-Analysis Setup...” on 
page 87.

• A red X ( ) beside the text No reference data available, indicates 
that the reference data is no longer valid.
A green check mark ( ) beside the text All reference data available, 
indicates that the current reference data is valid.
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• The Measurement View shows all of the measurements currently in 
memory - Click on the Measurement View tab at the bottom of the 
Workspace window to see it.

• Click with the right mouse button on Measurement History to access 
“The Measurement View Root Context Menu”  (see page 113).

• Click on  to see the DUT, measurement and instrument settings for 
a measurement.
Click on  to hide the DUT, measurement and instrument settings for 
a measurement.

• Double-click on DUT Information to view the ID, serial number, tem-
perature information or comments for the DUT.

• Double-click on Measurement Parameters to view the parameters for 
the measurement. 

• Double-click on Instrument Setup to view the instruments used for 
the measurement.

• Double-click on Analysis Settings to view the parameters used for the 
analysis.

• Click with the right mouse button on a measurement name to access 
“The Measurement View Context Menu”  (see page 114). 
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• The Curve View lists all the available curves of the measurements 
currently in memory. Click on the Curve View tab at the bottom of the 
Workspace window to see it.

• Click with the right mouse button on Measurement Curves to access 
“The Curve View Root Context Menu”  (see page 119). 

• Click with the right mouse button on a measurement name to access 
“The Curve View Context Menu”  (see page 119). 

• Click on  beside a measurement name to see which results are avail-
able.
Click on  beside a measurement name to hide the results that are 
available for it. 

• Click on the check box beside a measurement name to toggle between 
show ( ) and hide ( ) for all the results for that measurement.
If the corresponding Graph windows are not already open, they are 
opened automatically.

• Click on the check box beside a measurement path to toggle between 
show ( ) and hide ( ) for all the results for that measurement path.
If the corresponding Graph windows are not already open, they are 
opened automatically.

• Click on the check box beside a result to toggle between show ( ) 
and hide ( ) for the result.
If the corresponding Graph window is not already open, it is opened 
automatically.

• Double-click on a result to show the curve and open the graph window 
for this result.
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Analysis Table If Analysis Table is selected, the analysis table is shown. Click on the 
Generic, Peak or Notch tab at the bottom of the Analysis Table window to 
see each of these three tables for the current measurement results or 
analysis.

One row of data is displayed per curve.

The first column shows the color of the curve, as used in the analysis 
Graph window.

The appearance of the cursor changes to indicate its current function:

Log If Log is selected, the log window is shown. This window records events 
and errors. You can set what is recorded in the Log menu, see “The Log 
Submenu” on page 102.

Standard Toolbar If Standard Toolbar is selected, the file and print icons ( )will 
be displayed at the top of the Photonic Analysis Toolbox window.

This toolbar is described in “The Standard Toolbar” on page 122.

Instrument
Toolbar

If Instrument toolbar is selected, the instrument icons ( ) will be 
displayed at the top of the Photonic Analysis Toolbox window.

This toolbar is described in “The Instrument Toolbar” on page 123.

Measurement
Toolbar

If Measurement Toolbar is selected, the measurement icons 
( ) will be displayed at the top of the Photonic Analysis 
Toolbox window.

This toolbar is described in “The Measurement Toolbar” on page 125.

cursor to select all the values in a column

cursor to reposition column in the table
click on a column to select it, then click and drag the column to its 
new position

cursor to resize a column
click on the division between column headers and drag to resize 
the column to the left of the cursor.

cursor to resize a row
click on the division between row headers and drag to resize the 
row above the cursor.

cursor to resize a hidden column
click on the division between column headers where the hidden 
column is, and drag to resize the hidden column
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Realtime
Measurement

Toolbar

If Realtime Measurement Toolbar is selected, the realtime measurement 
icons ( ) will be displayed at the top of the Photonic Analysis 
Toolbox window.

This toolbar is described in “The Realtime Measurement Toolbar” on 
page 129.

Graph Toolbar If Graph Toolbar is selected, the graph icons ( )will be 
displayed at the top of the Photonic Analysis Toolbox window.

This toolbar is described in “The Graph Toolbar” on page 130.

X-Axes
Dimension

Toolbar

If X-Axes Dimension Toolbar is selected, the X-Axes Dimension icons 
( ) will be displayed at the top of the Photonic Analysis Toolbox 
window.

This toolbar is described in “The X-Axes Dimension Toolbar” on page 132.

Statusbar If Statusbar is selected, status messages and short help texts will be 
displayed at the bottom of the Photonic Analysis Toolbox window.



The Options Menu The Photonic Analysis Toolbox Reference
The Options Menu

The options menu lets you control the layout of the windows on the 
screen, and which events are logged.

The Layout Submenu
Select Layout 1, Layout 2 or Layout 3 from the Layout submenu to select 
one of these three pre-configured layouts.
Each layout contains settings for the appearance of the Photonic Analysis 
Toolbox on the screen.

The current appearance is saved to the currently selected layout when you 
exit the Photonic Analysis Toolbox.

Reset to Default Restores the factory default layout (with the workspace window at the left, 
the analysis table at the bottom, and the Loss Transmission window open).
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The Log Submenu
The Photonic Analysis Toolbox's Log menu allows you to set the severity 
of events and errors that should be logged in the Log window; and to save, 
or clear, the current log.

Save... Opens a file browser window to name the file to which the log is to be 
saved.

Enter the name for the file and click on the Save button.

The log is saved.

Clear Clears the current log entries.

Show Latest
Entries

Automatically scrolls the log window so that the most recent entries are 
shown.

Event are classed as errors, warnings, or hints.
Only one of the following three levels of logging can be selected:

Log Errors Only Errors are logged. Warnings, and hints are not logged.

Log Errors and
Warnings

Errors and warnings are logged. Hints are not logged.

Complete Logging Errors, warnings, and hints are logged.
102 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



The Options Menu The Photonic Analysis Toolbox Reference
X-Axes Dimension Submenu
Wavelength • The X-Axes of all graphs are scaled in nm.

• The vertical marker position and the distance between the vertical 
markers are given nm.

• The position values in the Analysis Table are given in nm.

The same function is available 

• on “The X-Axes Dimension Toolbar”  using .

Frequency • The X-Axes of all measurements are scaled in THz.

• The vertical marker position and the distance between the vertical 
markers are given THz.

• The position values in the Analysis Table are given in THz.

The same function is available 

• on “The X-Axes Dimension Toolbar”  using .
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The Window Menu

The Graph windows are opened in the Window menu (see “The 
Transmission Graph Submenu” on page 92 and “The Reflection Graph 
Submenu” on page 93).

Cascade Arranges the graph windows one behind the other in the Photonic 
Analysis Toolbox window:

Tile Arranges the graph windows beside one other in the Photonic Analysis 
Toolbox window:
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Arrange Icons Arranges the icons for the minimized graph windows.
This is particularly useful if you have changed the size of the area used by 
the graph windows, and some of the icons for your minimized graph 
windows are hidden.

Arrange Window Arranges all the open graph windows to fill the Photonic Analysis Toolbox 
Graph window.

The same function is available 

• on “The Graph Toolbar”  using .

Close All Closes all of the graph windows.

The further entries in the Window menu depend on the graph windows 
that are open.
Select a graph window to highlight it. This can shorten the time it takes to 
find a particular graph window.
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The Help Menu

Contents Displays the contents of the online Help.

About Photonic
Analysis Toolbox

Displays version information for the Photonic Analysis Toolbox, and 
version information for the plug and play drivers and the VISA library.
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The Graph Context Menu

The appearance of the cursor changes to indicate its current function:

Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  cursor is 
shown.

cursor for zooming

cursor for scrolling the curve left/right

cursor for scrolling the curve up/down

cursor for moving a wavelength marker left/right

cursor for moving the loss, GD or DGD marker up/down (only if the 
markers are free, as described in “Free” on page 109)

cursor for positioning the horizontal and vertical markers at the 
indicated point on the curve. See “The Marker Context Menu” on 
page 111 for more details.
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The Zoom Submenu
Main Curves Zooming operations are based on the main curve. That is zooming affects 

both amplitude and wavelength.

Orientation Curve Zooming operations are based on the orientation curve. That is zooming 
only affects the amplitude.

Zoom out Select the zooming.

To zoom in: Click at one corner of the area of interest, drag to the 
second diagonally opposite corner of the area of interest, then release the 
mouse button. The curve is displayed in the range defined by the first and 
second points.

To zoom out: Double-click anywhere on the graph to return to the 
previous zooming. If you double-click on the graph twice the full curve is 
shown.

Scrolling a zoomed curve: To view another section of a zoomed curve, 
click and drag the scale of the X or Y axis.
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The Marker Submenu
The λ/ν and Loss/Delay/Dispersion markers can be dragged into position 
using the mouse. The marker position, and the difference between the 
marker positions, is displayed at the bottom of the Graph window.

Free To move the markers freely in the graph window. The λ/ν1, λ/ν2, 
Loss/Delay/Dispersion1 and Loss/Delay/Dispersion2 markers move 
independently.

Locked to Curve Lock the markers to the currently selected curve. The λ/ν1, and 
Loss/Delay/Dispersion1 markers are locked together, and the λ/ν2 and 
Loss/Delay/Dispersion2 markers are locked together. This means that as 
you move the λ/ν marker on the curve, the loss marker shows the 
corresponding loss measurement at that wavelength or frequency.

Locked to Sample Lock the markers to the measurement samples. The λ/ν1, and 
Loss/Delay/Dispersion1 markers are locked together, and the λ/ν2 and 
Loss/Delay/Dispersion2 markers are locked together. This means that as 
you move the λ/ν marker from sample to sample, the loss marker shows 
the corresponding loss measurement at that sample.

Averaging/PMD
Window

If Averaging/PMD Window is selected, the average loss, display or 
dispersion for the area between the λ/ν markers is shown at the bottom of 
the window (the area used for the calculation is highlighted).
In the Differential Group Delay window, the value of PMD for the area 
between the λ/ν markers is shown at the bottom of the window.

Off Switch off the markers in this graph window.
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Other Items in the Graph Context Menu
Loss Orientation

Curve
If this is selected, the loss orientation curve for this light path will be 
shown in the graph window, as a common visual element to help you 
correlate the results in different graphs.

Synchronize X
Axis

Zooms the X-axis for all open graph windows so that the wavelength range 
in the window where you select this item, is used for all graph windows 
that are open.

The zooming in Y-axis is unaffected.

Copy to Clipboard Copy the contents of the graph window to the clipboard, for pasting into 
other applications.

Print Graph Prints the current graph window.

Print Preview Shows a preview of the printout of the current graph window.
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The Marker Context Menu

Click with the right mouse button on the graph window on the curve - 
when you are on the curve the  cursor is shown.

Lock Marker AC Positions the λ/ν1, and Loss/Delay/Dispersion1 marker at the point where 
you clicked.

Lock Marker BD Positions the λ/ν2, and Loss/Delay/Dispersion2 marker at the point where 
you clicked.

Apply
Averaging/PMD

Window

If the Averaging/PMD Window is enabled (see “Averaging/PMD 
Window” on page 109), and more than one curve is currently open in the 
graph window, select Apply Averaging/PMD Window to display the 
average or PMD value for the selected curve.

The markers have to be in Locked to Curve or Locked to sample mode (in 
the “The Marker Submenu” on page 109) for either of the following items 
to work.

NOTE
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The Setup View Root Context 
Menu

New... This starts a new measurement, including setting up the hardware, 
measurement parameters, making a reference, and measuring a device, as 
described in “Making a First Measurement” on page 56.

The same function is available 

• in the Measurement menu, in the Measurement Setup menu, using 
New....

• on “The Measurement Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “N” 
key (CTRL+N).

Open... Opens a file browser window to select and load a measurement setup from 
file (*.omr).

If you want to protect the measurement setup from alteration, check the 
“Open as read-only” box at the bottom of the file browser window.

You will be able to alter the measurement setup, but you will not be able to 
overwrite the original file.
You can save the altered measurement setup to a different file using “Save 
Measurement Setup As...”  in the File menu.

Save Saves the current measurement setup to a file (*.omr).
The measurements is saved with its current name, as shown in the Setup 
View tab of the Workspace window.

Properties Shows the measurement information. 

If you want to change the operator identification for the following 
measurements, click on the Edit button.
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The Measurement View Root 
Context Menu

Click with the right mouse button on Measurement History in the 
Measurement View tab of the Workspace window to open the 
Measurement View Root context menu. See “The View Menu” on page 95 
for information on how to view the Workspace window.

Open... Opens a file browser window to select and load a measurement result and 
any analysis data that is available from file (*.omr).

The same function is available 

• from the File menu, Open... item

• on “The Standard Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “O” 
key (CTRL+O).

Close All

All the opened measurements are removed from memory.

Make sure you have saved any new measurements, or measurements for 
which you have changed the analysis parameters before you close all the 
measurements.

NOTE
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 113



The Photonic Analysis Toolbox Reference The Measurement View Context Menu
The Measurement View Context 
Menu

Click with the right mouse button on a measurement name in the 
Measurement View tab of the Workspace window to open the 
Measurement View context menu. See “The View Menu” on page 95 for 
information on how to view the Workspace window.

Show Analysis
and Measurement

Data

Opens all the graphs and analysis tables for the measurement.

This menu item is only available for the active measurement.

Set as Active
Measurement

Sets the measurement you have just clicked on as the active 
measurement.

This menu item is only available for non-active measurements.

The same function is available

• in the Measurement menu, select Set as Active Measurement.

• in the Curve View tab of the Workspace window by using Set as Active 
Measurement in “The Curve View Context Menu” .

Create Setup from
Measurement

Use the measurement setup from the measurement you have just clicked 
on for following measurements.

The same function is available for the active measurement

• in the Measurement menu, select Create Setup from Active 
Measurement.

Close The measurement you just clicked on is removed from memory.

To close the active measurement, in the File menu, select Close Active 
Measurement.

To close all the currently open measurements, in the File menu, select 
Close All.

If you change the measurement parameters, you may have to make a 
reference measurement before you can make further measurements.NOTE
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Save Saves the measurement you just clicked on to a file (*.omr).
The measurements is saved with its current name.

The same function is available for the active measurement

• on “The Standard Toolbar”  using , or 

• from the keyboard by holding down the CTRL key and pressing the “S” 
key (CTRL+S).

• in the File menu, select Save Active Measurement.

The same function is available for all the currently open measurement

• in the File menu, select Save All.

Save As... Saves the measurement you just clicked on to a file (*.omr) with a name 
you specify.

1 Enter the name for the file and click on the Save button.

The measurement is saved.

The same function is available for the active measurement

• in the File menu, select Save Active Measurement As....

Reanalyze
Phase...

Replaces the existing or nonexisting Chromatic Dispersion analysis for the 
measurement you just clicked on with an analysis based on the new value 
for the resolution bandwidth.

The chromatic dispersion is shown as a graph for the available light paths 
for the measurement. See “The Transmission Graph Submenu” on page 92 
and “The Reflection Graph Submenu” on page 93 for details on how to 
display the chromatic dispersion graph. 

1 Set the Resolution Bandwidth of the Chromatic Dispersion analysis by 
entering the number of adjacent samples used in the sliding window 
for the calculation.
The sliding window is centered on the current wavelength.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.
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2 Click on the OK button.

The same function is available for the one or more measurements

• in the Analysis menu, select Reanalyze Phase....

Reanalyze Loss... Replaces existing or nonexisting peak or notch loss analyses for the 
measurement you just clicked on with analyses based on the new values 
for the analysis parameters.

The loss analyses are shown in the Analysis Table window. See “The View 
Menu” on page 95 for details on how to display the Analysis Table window.

1 Click on the boxes to set a check mark in the row and column 
corresponding to the loss analyses you want to perform (generic, peak 
and notch analyses, in the transmission and reflection paths).

Click on the Next > button.

2 If you selected peak analyses, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing. 

For more information on these parameters and what effect they have, 
see “Reanalyzing the Generic, Peak and Notch Loss” on page 196.
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3 If you selected notch analyses, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing.
For more information on these parameters and what effect they have, 
see “Reanalyzing the Generic, Peak and Notch Loss” on page 196.

4 Click on the Finish button.

The same function is available for the one or more measurements

• in the Analysis menu, select Reanalyze Loss....

Compare Loss
Analysis with

Active
Measurement...

Temporarily replaces the existing generic, peak and notch loss analyses for 
the measurement you just clicked on with analyses based on the analysis 
parameters of the active measurement.

This menu item is only available for non-active measurements.

The analysis and analysis parameters for the measurement are not altered 
in the file or the measurement. If you change the active measurement, the 
analyses for the comparison are deleted.
To change the analyses for a measurement, use Reanalyze Phase... and 
Reanalyze Loss....

The loss analyses of the active measurement and the measurements 
selected for comparison are shown in the Analysis Table window.
See “The View Menu” on page 95 for details on how to display the 
Analysis Table window.

To compare the loss analyses for a number of measurements

• in the Measurement menu, select Compare Loss Analysis with Active 
Measurement....

1 Click on the boxes to set a check mark beside in the row and column 
corresponding to the loss analyses you want to compare with the 
active measurement (generic, peak and notch analyses, in the 
transmission and reflection paths).

2 Click on the Finish button.
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Properties Shows information about the file, measurement, and the operator.
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The Curve View Root Context 
Menu

Click with the right mouse button on Measurement Curves in the Curve 
View tab of the Workspace window to open the Curve View Root context 
menu.

Show Min/Max
Loss Curves

Select this to make the Loss Min and Loss Max curves available for 
display, in addition to the Loss Average curve which is normally displayed.

Show PDL
Calculation

Curves

Select this to make the Loss: Linear Horizontal, Loss: Linear +45°, Loss: 
Linear -45°, and Loss: Right Circular available for display.

The Linear Horizontal, Linear +45, Linear -45 and Right Circular are the 
measured curves. The Min, Max, Average and PDL curves are calculated 
from them.
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The Curve View Context Menu

Click with the right mouse button on a measurement name in the Curve 
View tab of the Workspace window to open the Curve View context menu.

Set as Active
Measurement

Sets the measurement you have just clicked on as the active 
measurement.

This menu item is only available for non-active measurements.

The same function is available

• in the Measurement menu, select Set as Active Measurement.

• using Set as Active Measurement in “The Measurement View Context 
Menu” .
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The Curve View Result Context 
Menu

Click with the right mouse button on a result in the Curve View tab of the 
Workspace window to open the Curve View Result context menu.

Activate Selects the curve and opens the corresponding graph window.
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The Standard Toolbar

Opens a file browser window to select and load a measurement result and 
any analysis data that is available from a file (*.omr).

The same function is available 

• in the File menu, select Open. 

• from the keyboard by holding down the CTRL key and pressing the “O” 
key (CTRL+O).

Saves the active measurement to a file (*.omr).
The measurements is saved with its current name, as shown in the 
Measurement View tab of the Workspace window. 

The same function is available 

• in the File menu, select Save Active Measurement. 

• from the keyboard by holding down the CTRL key and pressing the “S” 
key (CTRL+S).

To save the active measurement or any of the non-active measurements 
that are open, use Save in “The Measurement View Context Menu” .

Saves all the opened measurements to files (*.omr).
The measurements are saved with their current name, as shown in the 
Measurement View tab of the Workspace window. See “The View Menu” 
on page 95 for information on how to view the Workspace window.

The same function is available 

• in the File menu, select Save All.

Prints the measurement and analysis setup, any graphs which contain one 
or more curves (including such graphs that are currently minimized on the 
screen) and the tables for the active measurement result or analysis.

In the Print window, select the printer you want to use, and press the OK 
button.

The same function is available 

• in the File menu, select Print.

• from the keyboard by holding down the CTRL key and pressing the “P” 
key (CTRL+P).

Shows a preview of the printout of the active measurement results or 
analysis.

The same function is available 

• in the File menu, select Print Preview.
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The Instrument Toolbar

Scans the GPIB and the network bus for available measurement 
instruments.

The Photonic Analysis Toolbox scans the GPIB and the network on startup. 
If you add or remove an instrument, use Scan for Instruments to update 
the list of instruments.

If the list of instruments is not shown automatically after the scan has 
completed, use .

To show the list of instruments automatically after each scan,

1 In the Instrument toolbar, select .

2 Click on the box beside “Show this dialog after each instrument scan 
automatically” until it is checked.

The same function is available 

• in the Instruments menu, select Scan for Instruments.

Lists the measurement instruments recognized by the Photonic Analysis 
Toolbox.

If you scan the GPIB, or change the hardware selection, it automatically 
starts a new measurement procedure which has to be completed 
(including the setting of the measurement parameters, and the making of a 
reference measurement) before you can make further measurements.

NOTE
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• Click on an instrument to see its details.

• Click on  beside an instrument or module to see its modules or 
connections.

Use  to scan the bus again and update the list.

The same function is available 

• in the Instruments menu, select Show Instruments....

Zeros the three power sensors in the Lightwave Measurement System.

You may want to zero the power meters manually before making a 
reference measurement, if you load existing reference data from a file, or 
to ensure the best possible performance.

The same function is available 

• in the Instruments menu, select Zero all Power Sensors.

Make sure the three patchcords in the tubing from the back of the Optical 
Test Head are connected to the inputs of the power sensors before you 
zero them.

NOTE
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The Measurement Toolbar

This starts a new measurement, including setting up the hardware, 
measurement parameters, making a reference, and measuring a device, as 
described in “Making a First Measurement” on page 56.

The same function is available 

• in the Measurement menu, in the Measurement Setup submenu, 
select New.

• from the keyboard by holding down the CTRL key and pressing the “N” 
key (CTRL+N).

Allows examination and individual adjustment of the measurement 
parameters that will be used for the next measurement.

The same function is available 

• in the Measurement menu, in the Measurement Setup submenu, 
select Edit Parameters....

• by double clicking on the Measurement Parameters element of the 
current measurement in the Setup View tab of the Workspace window. 
See “The View Menu” on page 95 for information on how to view the 
Workspace window.

Select the hardware to be used for the measurement from the pull-down 
menus.

The same function is available 

• in the Measurement menu, select Reconfigure Instrument Setup.

After you have selected the hardware, you will automatically be required to 
check or change the measurement parameters.
Click on the Next > button.

If you change the measurement parameters, you may have to make a 
reference measurement before you can make further measurements.NOTE
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Provides a boilerplate for you to add information about the device under 
test (DUT).
Click on the Edit button to change the information.

This includes

The same function is available 

• in the Measurement menu, select DUT Information.

Sets the automatic analysis of results after they have been measured. The 
results of the analysis are shown in the Analysis Table window.

The same function is available 

• in the Analysis menu, select Auto-Analysis Setup.

ID The identification of the DUT

Serial Number The serial number of the DUT

DUT 
Temperature

The temperature of the DUT during the measurement. This is 
used for documentation purposes only. It is not used in any 
calculations.
The temperature range at which the Photonic All-Parameter 
Analyzer meets its specifications is given in “Performance 
Specifications” on page 216

Comment Space to add comments on the DUT and the measurement.
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1 Click on the boxes to set a check mark beside Loss Analysis or Phase 
Analysis, depending on which auto-analyses you want to perform.
Click on the Next > button.

2 If you selected loss analyses.

a Click on the boxes to set a check mark in the row and column 
corresponding to the loss analyses you want to perform (generic, 
peak and notch analyses, in the transmission and reflection paths).
Click on the Next > button.

b If you selected peak analyses, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing. 
For more information on these parameters and what effect they 
have, see “Reanalyzing the Generic, Peak and Notch Loss” on 
page 196.

c If you selected notch analyses, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing.
For more information on these parameters and what effect they 
have, see “Reanalyzing the Generic, Peak and Notch Loss” on 
page 196.
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3 If you selected phase analyses, set the Resolution Bandwidth of the 
Chromatic Dispersion analysis by entering the number of adjacent 
samples used in the sliding window for the calculation.
The sliding window is centered on the current wavelength.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.

4 Click on the Finish button.

Starts the measurement.

The same function is available 

• in the Measurement menu, select Start DUT Measurement.

• from the keyboard by pressing the “F5” key.

On completion, the results are displayed in the Graph window, in the 
Analysis Table window and the measurement is added to the 
Measurement View in the Workspace window.

The completed measurement becomes the current active measurement.

Until saved, results have the default filename Noname001, Noname002, 
and so on.

Starts the reference measurement.

The same function is available 

• in the Measurement menu, select Start Reference.

• from the keyboard by holding down the SHIFT key and pressing the “F5” 
key (SHIFT+F5).
128 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



The Realtime Measurement Toolbar The Photonic Analysis Toolbox Reference
The Realtime Measurement 
Toolbar

Starts a measurement with fasta update rate for checking device 
connections and measurement parameters, or as a prelude to measuring 
dispersion properties for devices such as Dispersion Compensating 
Gratings.

The same function is available 

• in the Measurement menu, select Start Realtime Measurement, or 

• from the keyboard by pressing the “F7” key.

The results are displayed in the Graph window and the measurement is 
added as the Current Measurement to the Measurement View in the 
Workspace window. 

Pauses a realtime measurement.

The same function is available 

• in the Measurement menu, select Paise Realtime Measurement, or 

• from the keyboard by pressing the “PAUSE” key.

Restart the measurement by selecting . 

Stops a realtime measurement, and clears the realtime traces.

The same function is available 

• in the Measurement menu, select Stop Realtime Measurement, or 

• from the keyboard by pressing the “Ctrl-F7” key.

a The update rate of the realitme measurement depends on the sweep 
range, but is typically 1Hz for a filter-type device.

The results of the realtime measurement do not provide as high an 
accuracy as the DUT measurement.NOTE
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The Graph Toolbar

Bring any transmission graphs that are active to the front. Any active 
reflection graphs will be minimized.

The same function is available 

• in the Graph menu, in the Transmission Graph submenu, select Bring 
to Front.

Bring any reflection graphs that are active to the front. Any active 
transmission graphs will be minimized.

The same function is available 

• in the Graph menu, in the Reflection Graph submenu, select Bring to 
Front.

Select this to show or hide all markers in the graph windows.

The same function is available 

• in the Graph menu, select Show Markers.

Use the graph context menu in a particular graph window to show or hide 
the markers in that window. See “The Graph Context Menu” on page 107 
for more information.

Select this to show or hide all the orientation curves in the graph windows.
If orientation curves are selected, the loss average curve is shown in the 
background of each curve. This provides a visual reference to help you 
correlate between different curves of the same measurement.

The same function is available 

• in the Graph menu, select Show Orientation Curves.

Use the graph context menu in a particular graph window to show or hide 
the orientation curves for that window. See “The Graph Context Menu” on 
page 107 for more information.

Zoom out to view the full curves in all the graph windows.

The same function is available

• in the Graph menu, select Zoom Out All.

Double-click in a graph window to zoom out to view the full curves in that 
window.
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Arranges all the open graph windows to fill the Photonic Analysis Toolbox 
Graph window.

The same function is available 

• in the Window menu, select Arrange Windows.
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The X-Axes Dimension Toolbar

• The X-Axes of all graphs are scaled in nm.

• The vertical marker position and the distance between the vertical 
markers are given nm.

• The position values in the Analysis Table are given in nm.

The same function is available 

• in the Options menu, in the X-Axes Dimension submenu, select 
Wavelength.

• The X-Axes of all measurements are scaled in THz.

• The vertical marker position and the distance between the vertical 
markers are given THz.

• The position values in the Analysis Table are given in THz.

The same function is available 

• in the Options menu, in the X-Axes Dimension submenu, select 
Frequency.
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Making Measurements

This chapter describes how to make measurements.

The chapter starts with selecting hardware and setting the parameters for 
the measurement and the auto-analysis of results.
This is followed by a description of how to make a reference measurement.
The chapter ends with performing measurements.
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136
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Starting a New Measurement

To start the complete new measurement procedure

• Click on .

Or.

• In the Measurement menu, in the Measurement Setup menu, select 
New....

If the current measurement setup is new or has been changed since it was 
opened, you will be asked if you want to save it before you proceed.
Click on Yes to save it before you proceed.
Click on No to continue without saving the measurement setup.
Click on Cancel to abort starting a new measurement.

Making a new measurement is described in “Making a First 
Measurement” on page 56.
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Checking or Selecting the 
Hardware for a Measurement

If you do not intend to change the currently selected hardware, you can 
view it by:

1 In the Instrument toolbar, select ,
OR
in the Instruments menu, select Show Instruments...,

• Click on an instrument to see its details.

• Click on  beside an instrument or module to see its modules or con-
nections.

If you scan the GPIB, or change the hardware selection, you will need to 
start a new measurement (including the setting of the measurement 
parameters, and the making of a reference measurement) before you can 
make further measurements.

NOTE
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Identifying Which Hardware is Available

If you have changed some of your hardware while the Photonic Analysis 
Toolbox has been running, or if you have added hardware, you can scan the 
instrument bus.

• In the Instrument toolbar, select ,
OR
in the Instruments menu, select Scan for Instruments.

The current measurement setup will be invalid if you scan for instruments. 
You are asked if you want to save it before you proceed.
Click on Yes to save it before you proceed.
Click on No to continue without saving the measurement setup.
Click on Cancel to abort the scan for instruments.
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Selecting Specific Instruments

If your measurement setup has more than one Optical Test Head, 
Lightwave Measurement System or Polarization Controller, you can select 
which is to be used for your measurements by:

1 In the Measurement toolbar, select 
OR
In the Measurement menu, in the Measurement Setup submenu, 
select Reconfigure Instrument Setup....

2 Select the instruments you want to use from the pull-down menus - the 
instruments are identified by their IP or GPIB addresses.

3 When you have finished, click on the Next > button.

If you change the instrument selection, you may have to confirm the 
measurement parameters and make a reference measurement before you 
can make further measurements.

NOTE
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Checking or Setting the 
Measurement Parameters

Selecting Measurement Parameters for 
Accuracy and Resolution
Graphs of uncertainty as a function of the spectral averaging time and the 
number of averages are given in “Supplementary dispersion measurement 
characteristicsa” on page 219.

The total time for each measurement cycle is closely related to the product 
of the spectral averaging time and the number of averages. You can 
optimize your measurement time by selecting the combination of spectral 
averaging time and number of averages that minimizes the test time, while 
producing results that are within the allowable measurement uncertainty 
for your test device. 

Checking the Measurement Parameters
In the Workspace window, in the Setup View tab, double-click on 
Measurement Parameters.

The measurement parameters are shown.

If you want to edit the parameters

1 Click on the Edit button.
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Setting the Measurement Parameters for All 
Parameter Mode
If you are not already editing the measurement parameters,

• Click on .

Or

• In the Measurement menu, in the Measurement Setup submenu, 
select Edit Parameters....

If your measurement was initially setup in All Parameter mode, you will 
see the following window:

Please note that this single window has tabs in the lower half for the 
Phase and Loss options.
If this window is not shown, you will need to start a New measurement, as 
described in “Starting a New Measurement” on page 135.

You can select DGD measurements even if DGD and PMD measurements 
are not possible on your All-Parameter Analyzer (option #005). However 
the DGD measurement will not be carried out, and the PMD analysis is not 
possible.

NOTE
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1 Select the measurements

2 Select the light path

Fast GD To make just a group delay measurement, using 
a single polarization state.
Reference measurements are optional for the 
Fast GD measurement.

Fast Loss To make just a loss measurement, using a single 
polarization state
Reference measurements are optional for the 
Fast Loss measurement..

Fast GD and Fast Loss To make just a group delay and a loss 
measurement, using a single polarization state 
for the Fast GD, and a second single polarization 
state for the Fast Loss measurement.
Reference measurements are optional for the 
Fast GD and Fast Loss measurements.

GD/DGD To make both group delay and differential group 
delay measurements, using two polarization 
states.
Reference measurements are required.

Loss/PDL To make both loss and polarization dependent 
loss measurements, using four polarization 
states.
Reference measurements are required.

GD/DGD and Loss/PDL To make group delay, differential group delay, 
loss and polarization dependent loss 
measurements, using two polarization states for 
the GD/DGD measurement and four polarization 
states for the Loss/PDL measurement.
Reference measurements are required.

Transmission To measure in the transmission path only.

Reflection To measure in the reflection path only.

Transmission + 
Reflection

To measure in both transmission and reflection 
paths.
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3 If you are running a GD/DGD measurement, you can also select to 
generate a Jones Matrix.
The Jones matrix can only be generated during a measurement. It 
cannot later be generated from existing measurement data. Once 
generated, the Jones Matrix is saved with your measurement data, 
increasing the size of a measurement file by approximately 50%.

4 Set the start and stop wavelengths, and the step size for the sweep.
The step size of the wavelength sweep limits the possible resolution 
bandwidth of the results for the group delay and differential group 
delay, as well as the resolution bandwidth of the chromatic dispersion 
analysis.
For measurements in All Parameter mode, the maximum step size is 
100 pm.
The maximum wavelength span depends on the sweep speed of the 
tunable laser source. The dependency between span and sweep speed 
is given in “Dispersion Measurement Specifications” on page 218.

5 Set the measurement parameters for the phase measurements
Click on the Phase Options tab to select this configuration if it is not 
already shown.

a Select the number of scans. The measurement result that is 
displayed is averaged across the selected number of scans.
Increasing the number of scans reduces the noise floor, but 
increases the measurement time. 
Graphs of uncertainty as a function of the spectral averaging time 
and the number of averages are given in “Supplementary dispersion 
measurement characteristicsa” on page 219.

b Set the Resolution Bandwidth of the group delay and differential 
group delay results, by entering the size factor of the sliding window 
for the calculation of the group delay and differential group delay. 
The sliding window is of Gaussian shape, centered on the current 
wavelength.
The resolution bandwidth is the 2σ value of the sliding window and 
is the product of the size factor and the step size for the sweep.
The resolution bandwidth of the chromatic dispersion analysis is 
described in “Setting up the Auto-Analysis of Results” on page 152 
and “Analyzing Chromatic Dispersion” on page 178.
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6 Set the sweep speed of the tunable laser by opening "Options..." and 
selecting the proper speed in "Phase Options":

The higher the sweep speed the lower is the impact of environmental 
disturbances. Increasing sweep speed improves phase measurement 
accuracy. The maximum usable sweep speed depends on the device 
length to be tested. The dependency between sweep speed and device 
length is given in “Dispersion Measurement Specifications” on 
page 218.

7 Set the measurement parameters for the loss and polarization 
dependent loss measurements

Click on the Loss Options tab to select this configuration if it is not 
already shown.

a Select the Number of Sweeps to use for the measurement.
Each sweep is performed at a different power sensor range, and the 
results are stitched together to provide an increased dynamic range.
A single sweep provides a dynamic range of 35 dB (typical), two 
sweeps provides a dynamic range of 50 dB (typical), three sweeps 
provides the specified dynamic range of over 55 dB in the 
transmission path and over 45 dB in the reflection path.
Increasing the number of sweeps increases the measurement time.
To set the start of the power sensor range for your measurement, 
please refer to “Setting the Start Range for the Power Sensor” on 
page 149.
To set the start of the coherence control for the Tunable Laser 
Source Module, please refer to “Controlling the Quality of the Laser 
Signal” on page 149.
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 143



Making Measurements Checking or Setting the Measurement Parameters
Setting the Measurement Parameters in 
Expert Mode

If you are not already setting the measurement parameters

• Click on .

Or

• In the Measurement menu, select Edit Parameters....

• If your measurement was initially setup in Expert mode, you will see 
the following window:

Please note that this window is one of two. The first offers the full set 
of parameters for phase measurements, the second offers the full set 
of parameters for loss measurements.
If these window are not shown, you will need to start a New 
measurement, as described in “Starting a New Measurement” on 
page 135.

Certain changes will invalidate the current reference data (see “Changing 
Parameters Without Invalidating Reference Data” on page 148).

If the reference data has been invalidated, you must perform a new 
reference measurement before you can make further measurements.

NOTE

You can select DGD measurements even if DGD and PMD measurements 
are not possible on your All-Parameter Analyzer (option #005). However 
the DGD measurement will not be carried out, and the PMD analysis is not 
possible.

NOTE
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1 For the phase measurement

a Select the measurement

b Select the light path

c If you are running a GD/DGD measurement, you can also select to 
generate a Jones Matrix.
The Jones matrix can only be generated during a measurement. It 
cannot be generated from existing measurement data. Once 
generated, the Jones Matrix is saved with your measurement data, 
increasing the size of a measurement file by approximately 50%.

d Set the start and stop wavelengths, and the step size for the sweep.
The step size of the wavelength sweep limits the possible 
resolution bandwidth of the results for the group delay and 
differential group delay, as well as the resolution bandwidth of the 
chromatic dispersion analysis.
For phase measurements, the maximum step size is 100 pm.
The maximum wavelength span depends on the sweep speed of the 
tunable laser source. The dependency between span and sweep 
speed is given in “Dispersion Measurement Specifications” on 
page 218.

e Set the Resolution Bandwidth of the group delay and differential 
group delay results, by entering the size factor of the sliding window 
for the calculation of the group delay and differential group delay. 
The sliding window is of Gaussian shape, centered on the current 
wavelength.
The resolution bandwidth is the 2σ value of the sliding window and 

Fast GD To make just a group delay measurement, using a single 
polarization state.
Reference measurements are optional for the Fast GD 
measurement.

GD/DGD To make both group delay and differential group delay 
measurements, using two polarization states.
Reference measurements are required.

Off To skip the measurement of group delay and differential group 
delay 

Transmission To measure in the transmission path only.

Reflection To measure in the reflection path only.

Both To measure in both transmission and reflection paths.
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is the product of the size factor and the step size for the sweep.
The resolution bandwidth of the chromatic dispersion analysis is 
described in “Setting up the Auto-Analysis of Results” on page 152 
and “Analyzing Chromatic Dispersion” on page 178.

f Select the number of scans. The measurement result that is 
displayed is averaged across the selected number of scans.
Increasing the number of scans reduces the noise floor, but 
increases the measurement time. 

g Set the sweep speed of the tunable laser by opening "Options..." 
and selecting the proper speed in "Phase Options":

The higher the sweep speed the lower is the impact of 
environmental disturbances. Increasing sweep speed improves 
phase measurement accuracy. The maximum usable sweep speed 
depends on the device length to be tested. The dependency 
between sweep speed and device length is given in “Dispersion 
Measurement Specifications” on page 218.

2 If you have finished setting all the measurement parameters, click on 
the Next> button.

Certain changes will invalidate the current reference data (see “Changing 
Parameters Without Invalidating Reference Data” on page 148).
If the reference data has been invalidated, you must perform a new 
reference measurement before you can make further measurements.

3 Set up the Loss measurements.
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a Select the Measurement

b Select the light path

c If you have set a phase measurement, select Use Phase settings to 
reuse the start and stop wavelengths, and the step size for the 
sweep that you set for the phase measurement.
Or, set the start and stop wavelengths, and the step size for the 
sweep.
For loss measurements, the maximum step size is 200pm.

d Select the Number of Sweeps to use for the measurement.
Each sweep is performed at a different power sensor range, and the 
results are stitched together to provide an increased dynamic range.
A single sweep provides a dynamic range of 35dB (typical), two 
sweeps provides a dynamic range of 50dB (typical), three sweeps 
provides the specified dynamic range of over 55dB in the 
transmission path and over 45dB in the reflection path.
Increasing the number of sweeps increases the measurement time.
To set the start of the power sensor range for your measurement, 
please refer to “Setting the Start Range for the Power Sensor” on 
page 149.

Fast Loss To make just a loss measurement, using a single polarization 
state
Reference measurements are optional for the Fast Loss 
measurement.

Loss/PDL To make both loss and polarization dependent loss 
measurements, using four polarization states.
Reference measurements are required.

Off To skip the measurement of loss and polarization dependent 
loss 

Transmission To measure in the transmission path only.

Reflection To measure in the reflection path only.

Both To measure in both transmission and reflection paths.
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4 If you have finished setting all the measurement parameters, click on 
Finish.

Click on Yes to change the parameters.
Click on No to preserve the current parameters.

Certain changes will invalidate the current reference data (see “Changing 
Parameters Without Invalidating Reference Data” on page 148).
If the reference data has been invalidated, you must perform a new 
reference measurement before you can make further measurements.

Changing Parameters Without Invalidating Reference Data

The reference data remain valid when you:

• increase the start wavelength or reduce the stop wavelength by any 
multiple of the step wavelength. (The grid of the measured data points 
is not affected), or

• switch from Both transmission and reflection to either Transmission or 
Reflection only.

For loss measurement parameters, the reference data remain valid when 
you:

• change the PWM start range,

• change the number of sweeps, or

• switch from IL/PDL to Fast IL.

For phase measurement parameters, the reference data remain valid when 
you:

• change the number of averages, or 

• change the number of data points for averaging, as long as the 
resulting resolution bandwidth is below 200pm.
If the resulting resolution bandwidth is larger than 200pm, the 
resolution bandwidth of the reference measurement and the DUT 
measurement have to match.
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Setting the Start Range for the Power Sensor

1 Click on the Options button.

2 Select the start range for the power sensor for the Transmission path.
The default value is Automatic, in which case the start range is chosen 
for a DUT with zero-loss.

3 Select the start range for the power sensor for the Reflection path.
The default value is Automatic, in which case the start range is chosen 
for a DUT with zero-loss.

Controlling the Quality of the Laser Signal

1 Click on the Options button.

2 Click beside Coherence Control to switch this on and off.
Coherence Control has no effect on the time taken to make a 
measurement.

3 Select the maximum sweep speed.
A faster sweep speed reduces the time taken for the measurement. A 
slower speed assists measuring devices with very steep spectral 
features or allow the instrument to use longer averaging times to 
reduce noise for weak signals from a high-loss DUT.
The default value is Automatic.
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Entering Information for the DUT

1 In the Measurement toolbar, select .
OR
In the Measurement menu, in the Measurement Setup submenu, 
select DUT Information....
The DUT information is displayed.

2 Click on the Edit button.

3 Enter the DUT identification and serial number.

4 If it is known, add the temperature of the DUT, and any additional 
comments you may have.

5 Click on the OK button.
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Entering the Operator ID

1 In the Measurement menu, in the Measurement Setup submenu, 
select Properties....
The measurement information is displayed. 

2 Click on the Edit button.

3 Enter the operator identification.

4 Click on the OK button.
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Setting up the Auto-Analysis of 
Results

1 In the Measurement toolbar, select 
OR
In the Analysis menu, select Auto-Analysis Setup....

2 Click on the boxes to set a check mark beside Loss Analysis or Phase 
Analysis, depending on which auto-analyses you want to perform.
Click on the Next > button. 
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3 If you selected Loss Analysis.

a Click on the boxes to set a check mark in the row and column 
corresponding to the loss analyses you want to perform (generic, 
peak and notch analyses, in the transmission and reflection paths).
Click on the Next > button.

b If you selected Peak Analysis, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing. These 
parameters are described in greater detail in “Reanalyze Loss...” on 
page 89.

c If you selected notch analyses, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing. 
These parameters are described in greater detail in “Reanalyze 
Loss...” on page 89.

4 If you selected phase analyses, set the Resolution Bandwidth of the 
Chromatic Dispersion analysis by entering the number of adjacent 
samples used in the sliding window for the calculation.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.

5 Click on the Finish button.
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Saving the Current 
Measurement Setup

The measurement setup saved to disk includes the current hardware 
setup, the measurement parameters and the results of the reference 
measurements.

To save the measurement setup with the current name

1 In the File menu, select Save Measurement Setup.

Saving a Measurement Setup with a Different Name

1 In the File menu, select Save Measurement Setup As....

2 Enter the name for the file.

3 Click on the Save button.
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Repeating Earlier Measurements

There are two ways of repeating an earlier measurement for the same or a 
different DUT, either by

• “Loading an Existing Measurement Setup” , or by

• “Using the Measurement Setup from a Previous Measurement”  that is 
already opened.

Loading an Existing Measurement Setup

The measurement setup loaded from disk includes the hardware setup, the 
measurement parameters and the results of the reference measurements.

1 In the File menu, select Open Measurement Setup.

If the current measurement setup is new or has been changed since it 
was opened, you will be asked if you want to save it before you 
proceed.
Click on Yes to save it before you proceed.
Click on No to continue without saving the measurement setup.
Click on Cancel to abort loading an existing measurement setup.

2 Select the file from which the measurement setup is to be loaded.

3 If you want to make sure the file cannot be overwritten, make sure the 
box beside Open As Read Only is checked.

4 Press on the OK button.

If you load a measurement setup from another Photonic All-Parameter 
Analyzer, or a measurement setup that is more than 24 hours old, you 
should make a new reference measurement, to ensure the system 
performs according to its specifications, before you make further 
measurements.

NOTE
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Using the Measurement Setup from a 
Previous Measurement

1 Make sure the measurement from which you want to use the 
measurement setup is open (see “Viewing Curves for New and 
Previous Measurements” on page 174) and that it is selected as the 
current measurement:

a In the Measurement menu, select Set as Active Measurement.

b Click on the measurement from the submenu that you want to set 
as the active measurement.

2 In the Measurement menu, select Create Setup from Active 
Measurement.

If the current measurement setup is new or has been changed since it 
was opened, you will be asked if you want to save it before you 
proceed.
Click on Yes to save it before you proceed.
Click on No to continue without saving the measurement setup.
Click on Cancel to abort creating the measurement setup from an 
previous measurement.

If you use a measurement setup from a measurement made on another 
Photonic All-Parameter Analyzer, or a measurement setup that is more 
than 24 hours old, you should make a new reference measurement, to 
ensure the system performs according to its specifications, before you 
make further measurements.

NOTE
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Zeroing the Power Sensors

• Click on .

Or

• In the Instruments menu, select Zero all Power Sensors. 

Disconnect any fibers and put protective caps on the input and output 
of the Optical Test Head.
Click on the Ok > button.
The power sensors are zeroed.
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Performing a Realtime 
Measurement

The realtime measurement lets you check that your test device, and other 
components are connected correctly, and lets you confirm measurement 
parameters, such as the wavelength range. This can be particularly useful 
when measuring dispersion properties for devices such as Dispersion 
Compensating Gratings.

1 If they are not already attached, attach patchcords to the input and 
output of the Optical Test Head.

2 Connect or splice the DUT from the input to the output of the Optical 
Test Head.
Fix the DUT on the optical bench of the Optical Test Head, and fix the 
input and output fibers, using the fiber clamps.

3 Click on .
Or
In the Measurement menu, select Start Realtime Measurement.

After a delay the first results are shown, and are then updated frequently 
(typically once a second, depending on the sweep range).

Never look directly into the end of a fiber or a connector, unless 
you are absolutely certain that there is no signal in the fiber.

Please make sure that any optical connectors that you are using are clean 
before making a connection.

CAUTIONWARNING

NOTE
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Pausing a Realtime Measurement
Click on .
Or
In the Measurement menu, select Pause Realtime Measurement.

You can now adjust your measurement setup.

Restarting a Paused Realtime Measurement

Click on .
Or
In the Measurement menu, select Start Realtime Measurement.

Stopping a Realtime Measurement
Click on .
Or
In the Measurement menu, select Stop Realtime Measurement.
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Performing a Reference 
Measurement

• Click on .

Or

• In the Measurement menu, select Start Reference.

you 

1 You are prompted to start the Initialization Reference. 

• If the system has been initialized recently and the hardware and meas-
urement setup has not been changed, click on the Next > button to 
skip the Initialization Reference.

a It is recommended that you zero the power sensors before 
beginning the reference measurement.

If the power sensors have been zeroed recently and the setup has 
not be changed, click on the box to remove the check mark.

# To meet the full Loss and PDL specifications, please zero the power 
sensors before you perform a reference measurement. See “Zeroing the 
Power Sensors” on page 157 for information on how to zero the power 
sensors.

NOTE

Never look directly into a connector, unless you are absolutely 
certain that there is no signal.

CAUTIONWARNING
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b If you have changed the setup, or if you want to ensure meeting the 
specifications, click on the Start... button.

• If you are zeroing the power meters, you are prompted to set up the 
Optical Test Head for the Initialization Measurement by disconnecting 
any fibers and putting protective caps on the input and output of the 
Optical Test Head. 

Click on the OK button.
The power sensors are zeroed and the initialization reference is made.

c If you are not zeroing the power meters, you are prompted to set up 
the Optical Test Head for the Initialization Measurement by 
disconnecting any fibers from the input and the output of the 
Optical Test Head.
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Click on the OK button.
The Initialization Reference runs.

2 When the Initialization Reference finishes, press the Next button.
You are prompted to set up the Optical Test Head for the Reference 
Measurement.

a Select the type of reference measurement you want to perform.

b Click on the Start... button.

3 If you have selected a transmission reference measurement, you are 
prompted to set up the Optical Test Head for this measurement.

a Connect or splice the Transmission Reference Fiber from the input 
to the output of the Optical Test Head.
Place the Transmission Reference Fiber on the optical bench of the 
Optical Test Head. 

b Click on the OK button.
The reference transmission measurement runs in one or two cycles, 
depending on the measurements selected, to calibrate the 
transmission path for the Loss/PDL measurements and then for the 
GD/DGD measurements.

c Disconnect the Transmission Reference Fiber from the Optical Test 
Head.

d If there are other reference measurement tasks to be done, click on 
the Start... button.
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4 If you have selected a reflection reference measurement, you are 
prompted to set up the Optical Test Head for this measurement.

Transmission To measure a reference in the transmission path 
only.
This option is only available if your 
measurement parameters specify only a 
measurement in the transmission path.

Reflection To measure a reference in the reflection path 
only using a reflective reference device.
This option is only available if your 
measurement parameters specify only a 
measurement in the reflection path.

Terminated Reflection To measure a reference in the reflection path 
using a reflective reference device and include a 
reference with a termination device.
This option is only available if your 
measurement parameters specify only a 
measurement in the reflection path.
The measurement of the terminated reflection 
reference extends the time for the reference 
measurement, but adds to the overall accuracy 
of the results.

Transmission and 
Reflection

To measure a reference in both transmission 
and reflection paths.

Transmission and 
Terminated Reflection

To measure a reference in both transmission 
and reflection paths, including a termination 
reference.
The measurement of the terminated reflection 
reference extends the time for the reference 
measurement, but adds to the overall accuracy 
of the results.

Please make sure that any optical connectors that you are using are clean 
before making a connection.NOTE

Please make sure that any optical connectors that you are using are clean 
before making a connection.NOTE
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5 Connect or splice the Reflectance Reference Device

a to the output of the Optical Test Head.

b Place the Reflectance Reference Fiber on the optical bench of the 
Optical Test Head. Fix the fiber using the fiber clamps.

c Click on the OK button.
The reference reflection measurement runs in one or two cycles, 
depending on the measurements selected, to calibrate the 
reflection path for the Loss/PDL measurements and for the 
GD/DGD measurements.

d If there are other reference measurement tasks to be done, click on 
the Start... button.

6 If you have selected a terminated reflection reference measurement, 
you are prompted to set up the Optical Test Head for this measurement.

a Connect or splice a termination to the output of the Optical Test 
Head.
You can make a termination as described in “Making a Termination” 
on page 51, or you can use any termination with a return loss 
greater than 70dB.

b Place the termination in the optical bench of the Optical Test Head. 
Fix the fiber using the fiber clamps. See “Using the Termination 
Rod” on page 51 and “Using the Fiber Clamps” on page 49 for more 
information on making a termination and fixing the fiber.

Please make sure that any optical connectors that you are using are clean 
before making a connection.NOTE
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c Click on the OK button.
The reference termination measurement runs.

d If there are other reference measurement tasks to be done, click on 
the Start... button.

7 Disconnect the fiber from the Optical Test Head.

8 Click on the Finish button.
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Performing a Two-Port DUT 
Measurement

1 If they are not already attached, attach patchcords to the input and 
output of the Optical Test Head.

2 Click on 
OR
From the Measurement menu, select Start DUT Measurement. 

3 Click on .in the “DUT Measurement Control” panel. 

4 Connect or splice the DUT from the input to the output of the Optical 
Test Head.
Fix the DUT on the optical bench of the Optical Test Head, and fix the 
input and output fibers, using the fiber clamps. See “Using the DUT 
Holder” on page 52 and “Using the Fiber Clamps” on page 49 for more 
information on fixing the DUT and the fibers.

The measurement runs, showing the measurement status as it 
progresses.
When the measurement finishes, the results are shown.

5 When you have finished measuring your device, click on  in the 
“DUT Measurement Control” panel.

To measure further devices, click on , and repeat step 3 to step 5.

Never look directly into the end of a fiber or a connector, unless 
you are absolutely certain that there is no signal in the fiber.

Please make sure that any optical connectors that you are using are clean 
before making a connection.

CAUTIONWARNING

NOTE
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Performing a Multi-Port DUT 
Measurement

1 If they are not already attached, attach patchcords to the input and 
output of the Optical Test Head.

2 Click on 
OR
From the Measurement menu, select Start DUT Measurement.

3 Click on .

4 Connect or splice the DUT from the input to the output of the Optical 
Test Head.
Fix the DUT on the optical bench of the Optical Test Head, and fix the 
input and output fibers, using the fiber clamps. See “Using the DUT 
Holder” on page 52 and “Using the Fiber Clamps” on page 49 for more 
information on fixing the DUT and the fibers.

The measurement runs, showing the measurement status as it 
progresses.
When the measurement finishes, the results are shown.

5 Click on , and repeat step 3 to step 4 for the next output port.

If you want to abort the measurement of a port, click on .
This will affect only the port that is currently being measured.

6 When you have finished measuring all the ports of your device, click on 
.

To measure further devices, click on , and repeat step 3 to step 6.

Never look directly into the end of a fiber or a connector, unless 
you are absolutely certain that there is no signal in the fiber.

Please make sure that any optical connectors that you are using are clean 
before making a connection.

CAUTIONWARNING

NOTE
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Cancelling a Reference or DUT 
Measurement

To cancel the current reference or DUT measurement click the Cancel 
button in the measurement status box.

The cancellation of the measurement can take several seconds.
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Saving and Closing 
Measurements

If you want to use a measurement for further reference or analysis, you 
should save it.

When you have finished analyzing a measurement, you should close it to 
remove it from memory.

Saving a Measurement
1 In the Measurement View tab of the Workspace window click with the 

right mouse button on the measurement name, select Save.

You can also save the active measurement, in the File menu, by selecting 
Save Active Measurement.

Saving a Measurement with a Different Name

1 In the Measurement View tab of the Workspace window click with the 
right mouse button on the measurement name, select Save As....

2 Enter the name for the file.

3 Click on the Save button.

You can also save the active measurement with a Different Name

1 In the File menu, select Save Active Measurement As....

2 Enter the name for the file.

3 Click on the Save button.

Saving All Measurements

1 In the File menu, select Save All.
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Closing Measurements
1 In the Measurement View tab of the Workspace window click with the 

right mouse button on the measurement name, select Close.

You can also save the active measurement, in the File menu, by selecting 
Close Active Measurement.

Closing All Measurements

1 In the File menu, select Close All.
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Analyzing Results

This chapter describes how to analyze recently measured and previously 
stored results. 

This includes configuring and analyzing graphical and tabular results, and 
how to export results for further analysis and save them.

Opening a Previous Measurement for Analysis . . . . . . . 173
Viewing Curves for New and Previous Measurements . 174

Selecting the Curves to Display  . . . . . . . . . . . . . . . . . . . . . . . . . 174

Opening and Closing Graph Windows . . . . . . . . . . . . . . . . . . . . 176

Eliminating Noisy Sections from the Displayed Graphs . . . . . 176

Examining the Measurement Conditions . . . . . . . . . . . . . . . . . 177

Analyzing Chromatic Dispersion . . . . . . . . . . . . . . . . . . . . 178

Reanalyzing the CD. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178

Analyzing a Curve in the Graph Window . . . . . . . . . . . . .180

Changing between Wavelength and Frequency  . . . . . . . . . . . 180

Zooming In and Out  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181

Using Markers to Analyze Curves  . . . . . . . . . . . . . . . . . . . . . . . 183

Analyzing PMD, or Average Loss, Group Delay or Chromatic 
Dispersion Over Passband . . . . . . . . . . . . . . . . . . . . . . . . . 188

Analyzing PMD Over Passband  . . . . . . . . . . . . . . . . . . . . . . . . . 189

Analyzing Average Loss, Group Delay or Chromatic Dispersion 

Over Passband. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190

Using Results in Your Documentation  . . . . . . . . . . . . . . .191

Copying Graphs into Documentation . . . . . . . . . . . . . . . . . . . . . 192

Printing Graphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
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Printing Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .194

Selecting the Results Displayed in the Analysis Table. . 195

Changing between Wavelength and Frequency. . . . . . . . . . . .195

Reanalyzing the Generic, Peak and Notch Loss . . . . . . . . . . . .196

Comparing Loss Analyses for Several Measurements . . . . . .205

Arranging the Analysis Table  . . . . . . . . . . . . . . . . . . . . . . . . . . .206

Exporting Data for Further Processing . . . . . . . . . . . . . . . 207

Exporting Trace Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .207

Exporting the Jones Matrix . . . . . . . . . . . . . . . . . . . . . . . . . . . . .210

Exporting the Mueller Matrix  . . . . . . . . . . . . . . . . . . . . . . . . . . .211

Saving and Closing Analyses . . . . . . . . . . . . . . . . . . . . . . . 212

Saving Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .212

Closing Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .213

Closing All Measurements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .213
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Opening a Previous 
Measurement for Analysis

If you want to open one or more previous measurements 

• in the File menu, select Open

• on “The Standard Toolbar”  use , or 

• press CTRL+O on the keyboard 

to open a file browser window to select and load measurement results or 
analyses from files (*.omr).

To open a single file:

1 Click on the file.

2 Click on the Open button.

To open a number of files:

• If the files are listed one after the other, 

a Click on the first file.

b Press SHIFT and click on the last file.

c Click on the Open button.

• If the files are not listed one after the other, 

a Click on the first file.

b Press CTRL and click on the next file.

c Repeat step b until all of the files you want to open are highlighted.

d Click on the Open button.

The last measurement you open automatically becomes the active 
measurement.
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Viewing Curves for New and 
Previous Measurements

The curves that are displayed depend on two factors:

• which curves are selected for display, and

• which graph windows are open.

Selecting the Curves to Display
Loading a new measurement, or changing the active measurement, 
automatically displays all the curves and analysis tables associated with 
the new active measurement. Any curves or analysis tables for the 
previous active measurement are deselected.

To view all the curves for the active measurement

1 In the Measurement View tab of the Workspace window click with the 
right mouse button on the active measurement name, select Show 
Analysis and Measurement Data.

To select a particular set of curves from the active and non-active 
measurements.

1 In the Workspace window, select the Curve View tab.

2 Click on  beside a measurement name to see which results are 
available.
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Click on  beside a measurement name to hide the results that are 
available for it. 

• Click on the check box beside a measurement name to toggle between 
show ( ) and hide ( ) for all the results for that measurement.
If the corresponding graph windows are not already open, they are 
opened automatically.

• Click on the check box beside a measurement path to toggle between 
show ( ) and hide ( ) for all the results for that measurement path.
If the corresponding graph windows are not already open, they are 
opened automatically.

• Click on the check box beside a result to toggle between show ( ) 
and hide ( ) for the result.
If the corresponding graph window is not already open, it is opened 
automatically.

See “Opening and Closing Graph Windows” on page 176 for information 
on how to open or close graph windows to display the curves you have 
selected, or to close empty graph windows.

For information on the measurements, see “Examining the Measurement 
Conditions” on page 177.

Showing the Calculation Curves for Loss and PDL

• To view the minimum and maximum loss curves,
click with the right mouse button on Measurement Curves in the Curve 
View tab of the Workspace window to open the Curve View Root 
context menu.

• Select Show Min/Max Loss Curves to make the Loss Min and Loss 
Max curves available for display, in addition to the Loss Average curve 
which is normally displayed.
You can now select these curves for display, as described above.
The curves are displayed in the Loss graph window.

• To view the calculation loss curves used to calculate PDL,
Select Show PDL Calculation Loss Curves to make the Loss: Linear 
Horizontal, Loss: Linear +45°, Loss: Linear -45°, and Loss: Right 
Circular available for display.
The Linear Horizontal, Linear +45, Linear -45 and Right Circular are the 
measured loss curves. The Min, Max, Average and PDL curves are 
calculated from them.

If a graph window is empty, it probably indicates the measured results for 
the DUT were outside the specified range of the All-Parameter Analyzer.
For example, if you were to specify a reflection loss measurement for a 
patchcord, the resulting Loss Reflection graph window would be empty.

NOTE
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• You can now select the linear horizontal, linear +45°, linear -45°, and 
right-hand circular polarization loss curves for display, as described 
above.
The curves are displayed in the Loss graph window.

Opening and Closing Graph Windows
Any combination of Graph windows can be selected.
The selected curves are displayed in the windows that are open. See 
“Selecting the Curves to Display” on page 174 for information on how to 
select curves.

In the Graph menu, in the Transmission or Reflection submenu, select the 
graphs you want to view.

• Select Loss, PDL, GD, DGD, or CD in the submenu to activate any 
individual graph or combination of these graphs.

If you want to view a particular curve immediately,

• In the Curve View tab of the Workspace window, 

• double-click on the result, or

• click with the right mouse button on the result, select Activate. 

The curve is selected (if it is not already selected), and the graph window 
is opened.

Eliminating Noisy Sections from the 
Displayed Graphs
By defining a noise threshold, sections of the curves that contain no useful 
information can be suppressed on the screen.

The Loss curve in the measurement path for the currently active graph is 
compared with the threshold that you enter. For any wavelength on the 
Loss curve that has a signal strength below the noise threshold the curve 
is eliminated in the all corresponding graph windows for the measurement 
path.
Noise suppression can only be applied to measurements that use the 
same parameters as the loss measurement.
The full Loss curve continues to be displayed.

1 Identify the lowest signal level of interest on the loss curve.

2 In the Graph menu, select Noise Suppression....

3 Enter the value for the threshold and click on the OK button.
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Examining the Measurement Conditions
To examine the DUT information, the measurement parameters or the 
instrument setup,

1 In the Workspace window, click on the Measurement View tab.

2 Make sure the measurement you want to examine is expanded (click 
on , if necessary)

3 Double-click on DUT Information to see, or edit, the information about 
the device under test.
Double-click on Measurement Parameters to see the parameters used 
for the measurement.
Double-click on Instrument Setup to see the setup used for the 
measurement.
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Analyzing Chromatic Dispersion

The initial curve for chromatic dispersion (CD) is determined by how you 
configured the automatic phase analysis. See “Setting up the Auto-
Analysis of Results” on page 152 for information on setting up the 
automatic analysis.

Reanalyzing the CD
If you did not configure a phase analysis, or if you would like to reanalyze 
the chromatic dispersion, or to apply the same analysis to a number of 
measurements so you can compare them:

1 In the Analysis menu, select Reanalyze Phase....

2 Click on the boxes to set a check mark beside the measurements you 
want to reanalyze.

3 Set the Resolution Bandwidth of the Chromatic Dispersion analysis by 
entering the number of adjacent samples used in the sliding window 
for the calculation.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.

4 Click on the OK button.
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Reanalyzing CD for the Active Measurement

This is an alternative to reanalyzing CD when you just want to change the 
analysis for the active measurement.

1 In the Measurement View tab of the Workspace window click with the 
right mouse button on the measurement name, select Reanalyze 
Phase.

2 Set the Resolution Bandwidth of the Chromatic Dispersion analysis by 
entering the number of adjacent samples used in the sliding window 
for the calculation.
The resolution bandwidth is the product of the number of samples and 
the step size used for the wavelength sweep of the original 
measurement.

3 Click on the OK button.

The chromatic dispersion is shown as a graph for the available light paths 
for the measurement. See “Viewing Curves for New and Previous 
Measurements” on page 174 for details on how to display the chromatic 
dispersion curve.
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Analyzing a Curve in the Graph 
Window

The Graph window lets you view the detail on the curves, and position 
markers on the curves to measure values and differences.

Changing between Wavelength and 
Frequency
To change the position values on the graph to wavelength (nm):

• In the X-Axes Dimension toolbar, select 
OR
in the Options menu, in the X-Axes Dimension submenu, select 
Wavelength.

To change the position values on the graph to frequency (THz):

• In the X-Axes Dimension toolbar, select 
OR
in the Options menu, in the X-Axes Dimension submenu, select 
Frequency.
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Zooming In and Out

Zooming In on the Curves in a Graph Window

1 Click on one corner of the area of interest and, holding down the left 
mouse button, drag a rectangle to the opposite corner of the area of 
interest.

2 Release the mouse button.

If you can only zoom along the y-axis, check that the zoom is selected for 
the main curves (see “Zooming on the Orientation Curve” on page 187 for 
information on returning to normal zooming).

Returning to the Previous Zoom for a Graph Window

Double-click anywhere in the graph window.

Zooming All Graphs Identically

If you have zoomed in on an area of interest in one graph window, and 
want to compare the same wavelength range for all the graph windows:

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Synchronize X Axis.

The X-axis of all open graph windows is synchronized.

The zooming in the Y-axis is unaffected.
If you want to zoom in the Y-axis, you should do this before synchronizing 
the X-axis.
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Zooming Out Fully for a Graph Window

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Zoom.

3 Select Zoom Out.

The same function is available by double-clicking twice in the graph 
window.

Zooming Out Fully for All Graph Windows

• Click on the  icon.

OR

• In the Graph menu, select Zoom Out All.
182 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Analyzing a Curve in the Graph Window Analyzing Results
Using Markers to Analyze Curves
Four markers are provided. 

• Use the two vertical markers, λ/ν1 and λ/ν2, to determine wavelength 
or frequency on the curves.

• Use the two horizontal markers, like (Loss1 and Loss2, GD1 and GD2, or 
DGD1 and DGD2, depending on the graph window) to determine loss, 
GD, DGD, etc. on the curves.

The positions of the markers are given at the bottom of the Graph window. 

The third pair of values shows the difference in wavelength or frequency, 
∆λ/∆ν, between the positions of the vertical markers, and the difference in 
loss, GD, DGD or CD, ∆, between the horizontal markers.

Moving Vertical Markers

1 Move the cursor over the vertical marker.
When the cursor is over the marker it changes to .

2 Click on the marker and drag it to the new position.

If the markers are locked together, the horizontal marker corresponding to 
the vertical marker you have moved will move to the point where the 
vertical marker intersects the curve of the active measurement. See 
“Locking the λ/ν and Loss/Delay/Dispersion Markers Together” on 
page 183 for information on locking the vertical and horizontal markers 
together.
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Moving Horizontal Markers

1 Make sure the marker is free (see “Positioning the Four Markers 
Freely” on page 184). 
If the horizontal markers are not free, you can only position them by 
moving the corresponding vertical marker, as described in “Moving 
Vertical Markers” on page 183.

2 Move the cursor over the horizontal marker.
When the cursor is over the marker it changes to .

3 Click on the marker and drag it to the new position.

Positioning Both Markers on the Curve

1 Make sure the markers are locked together (see “Locking the λ/ν and 
Loss/Delay/Dispersion Markers Together” on page 183).

2 Click with the right mouse button on the graph window on the curve at 
the point where you want to position the markers - when you are on the 
curve the  cursor is shown.

• Select Lock Marker AC to position the λ/ν1, and Loss/De-
lay/Dispersion1 marker at the point where you clicked.

• Select Lock Marker BD to position the λ/ν2, and Loss/De-
lay/Dispersion2 marker at the point where you clicked.

Positioning the Four Markers Freely

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Marker.

3 Select Free.

You can now position the vertical and horizontal markers independently.
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Locking the λ/ν and Loss/Delay/Dispersion Markers Together

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Marker.

• Select Locked to Curve so that as you move the λ/ν marker it moves 
smoothly along the curve. The corresponding Loss/Delay/Dispersion 
marker will show the loss, GD, DGD or CD on the curve.

• Select Locked to sample so that as you move the λ/ν marker it steps 
from measurement sample to measurement sample. The 
corresponding Loss/Delay/Dispersion marker will show the loss, GD, 
DGD or CD on the curve.

Switching the Markers Off

Click on the  icon.

OR

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Marker.

3 Select Off.

To turn the markers back on again: 

• Click on the  icon again.

OR

• In the Graph menu, select Show Markers.
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Using the Orientation Curve
The Orientation Curve puts the Loss Average curve for the measurement 
path in the background of the graph window to give you a common 
element to help comparisons between different curves.

The axis for the orientation curve is shown at the right side of the graph.

Turning On the Orientation Curve in All Graph Windows

• Click on the  icon.

OR

• In the Graph menu, select Show Orientation Curves.

Turning On or Off the Orientation Curve in a Graph Window

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Select Loss Orientation Curve.

Orientation
Curve

Orientation
Curve Axis

Main

Curve
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Zooming on the Orientation Curve

If you need to see more detail on the Orientation Curve to correlate 
information from two different graph windows:

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Zoom.

3 Select Orientation Curve.

You can now zoom on the orientation curve:

1 Click at the top of the area of interest and, holding down the left mouse 
button, drag to the bottom of the area of interest.

2 Release the mouse button.

The Orientation Curve will be zoomed in the y-axis only. The main curve 
and the zooming in the x-axis are unaffected.

To return to normal zooming

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Zoom.

3 Select Main Curves.
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Analyzing PMD, or Average Loss, 
Group Delay or Chromatic 
Dispersion Over Passband

In many cases you are interested in

• “Analyzing PMD Over Passband” 

• or “Analyzing Average Loss, Group Delay or Chromatic Dispersion Over 
Passband” .
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Analyzing PMD Over Passband
The PMD over passband can only be measured on the Differential Group 
Delay curve, as the wavelength-averaged DGD.

1 Click with the right mouse button on the DGD graph window away from 
the curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Marker.

3 Select Averaging/PMD Window

4 If it is not already being displayed, select the Loss Orientation Curve (as 
described in Using the Orientation Curve 186).

5 Position the two markers at the lower and upper wavelengths or 
frequencies of the passband:

a Move the cursor over the vertical marker.
When the cursor is over the marker it changes to .

b Click on the marker and drag it to the new position.

When both of the markers are positioned, the value for the PMD as 
averaged DGD in the highlighted passband is shown below the graph.

If there is more than one curve in the window, right click on the curve - 
when you are on the curve the  cursor is shown - and select Apply 
Averaging/PMD Window.
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Analyzing Average Loss, Group Delay or 
Chromatic Dispersion Over Passband
The average can be measured on the PDL or Loss Average, Group Delay or 
Chromatic Dispersion curve.

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Click on Marker.

3 Select Averaging/PMD Window.

4 If it is not already being displayed, select the Loss Orientation Curve (as 
described in Using the Orientation Curve 186).

5 Position the two markers at the lower and upper wavelengths or 
frequencies of the passband:

a Move the cursor over the vertical marker.
When the cursor is over the marker it changes to .

b Click on the marker and drag it to the new position.

When both of the markers are positioned, the value for the average in the 
highlighted passband is shown below the graph.
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Using Results in Your 
Documentation

You can print graphs, or paste the contents of the graph windows into your 
other documents.

For information on using tabular results in your documentation, see 
“Exporting Data for Further Processing” on page 207.
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Copying Graphs into Documentation
Before you start to copy a graph for use in a documentation, make sure the 
graph is displayed on the screen as you want to use it in your 
documentation.
That is

• Make sure the correct area is zoomed.

• Make sure the markers are positioned correctly.

• Make sure the orientation curve is selected or deselected, as required.

• Make sure the size and aspect ratio of the graph are more or less 
correct for use in your documentation.
You can adjust these in most word processing packages, but large 
adjustments can mean that the axis labelling becomes illegible, or that 
the resolution is insufficient.

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

2 Select Copy to Clipboard.

You can now paste the graph into your document (assuming this is 
supported by the application you are using to generate your 
documentation).

Choosing a small size increases the relative label size.
NOTE
192 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Using Results in Your Documentation Analyzing Results
Printing Graphs

Setting up the Printer

Before you print any graphs, make sure the printer is set up correctly. To do 
this you

• In the File menu, select Printer Setup...

The rest of the procedure is specific to your printer, but the graph will be 
formatted to fit the size and orientation of the selected paper, so in 
particular make sure the correct size of paper and the correct orientation 
(Portrait or Landscape) is selected.

Printing Individual Graphs

Before you print a graph, make sure it is displayed on the screen as you 
want to print it.
That is

• Make sure the correct area is zoomed.

• Make sure the markers are positioned correctly.

• Make sure the orientation curve is selected or deselected, as required.

1 Click with the right mouse button on the graph window away from the 
curve - when you are away from the curve the , , , , or  
cursor is shown.

• If you want to check your graph before you print it, 

a select Print Preview.

b If the layout is correct, click on the Print button.
If the layout is not correct, click on the Close button, make the 
necessary adjustments and repeat the procedure.

• If you just want to print the graph, select Print Graph....

2 Make sure the correct printer is selected, and the settings of your 
printer driver are okay.

3 Click on the OK button.
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Printing Results
A printout of the results of a measurement includes 

• the measurement and analysis setup

• any graphs which contain one or more curves (including such graphs 
that are currently minimized on the screen), and

• the tables for the active measurement result or analysis.

Before you print a result, make sure any graphs in the result are displayed 
on the screen as you want to print them.
That is

• Make sure correct area is zoomed.

• Make sure the markers are positioned correctly.

• Make sure the orientation curve is selected or deselected, as required.

1 If you want to check your printout before you print it:

a In the File menu, select Print Preview.

b If the layout is correct, click on the Print button.
If the layout is not correct, click on the Close button, make the 
necessary adjustments and repeat the procedure.

If you just want to print the result:

In the File menu, select Print.

2 Make sure the correct printer is selected, and the settings of your 
printer driver are okay.

3 Click on the OK button.
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Selecting the Results Displayed 
in the Analysis Table

Loading a new measurement, or changing the active measurement, 
automatically displays all the curves and analysis tables associated with 
the new active measurement. Any curves or analysis tables for the 
previous active measurement are deselected.

To display the results of more than one measurement in the analysis 
tables, the analyses must be equivalent. This is described in “Comparing 
Loss Analyses for Several Measurements” on page 205.

The initial values in the peak and notch loss analysis tables are determined 
by how you configured the automatic loss analysis. See “Setting up the 
Auto-Analysis of Results” on page 152 for information on setting up the 
automatic analysis.

Changing between Wavelength and 
Frequency
To change the position values in the table to wavelength (nm):

• In the X-Axes Dimension toolbar, select 
OR
in the Options menu, in the X-Axes Dimension submenu, select 
Wavelength.

To change the position values in the table to frequency (THz):

• In the X-Axes Dimension toolbar, select 
OR
in the Options menu, in the X-Axes Dimension submenu, select 
Frequency.
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Reanalyzing the Generic, Peak and Notch 
Loss

If you did not configure an automatic loss analysis, or if you would like to 
reanalyze the generic, peak or notch loss, or to apply the same analysis to 
a number of measurements to make the data comparable in external 
applications:

1 In the Analysis menu, select Reanalyze Loss....

2 Click on the boxes to set a check mark beside the measurements you 
want to reanalyze.

Click on the Next > button.

The results of the generic analysis are shown on the Generic tab of the 
Analysis table window. The columns displayed are:

If you want to compare a number of different loss analyses, see 
“Comparing Loss Analyses for Several Measurements” on page 205.

Meaningful results for Peak and Notch analyses are only possible for 
measurements of devices with peak or notch characteristics.

NOTE

NOTE

Color Indicates the color of the corresponding graph

Measurement The name of the file in which the 
measurement is stored.

Light Path Whether the measurement was made in the 
transmission or reflection light path

Curve The type of measurement (PDL, Loss,...).
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3 If you selected peak analysis, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing.

The ITU Channel Spacing (in the frequency domain) defines which of 
the channels, as defined by the International Telecommunication Union 
(ITU), are being used.

Min Loss [dB] The minimum loss measured.

Wvl at Min [nm]
Frq at Min [THz]

The wavelength or frequency at which the 
minimum loss was measured

Max Loss [dB] The maximum loss measured.

Wvl at Max [nm]
Frq at Max [THz]

The wavelength or frequency at which the 
maximum loss was measured

loss

λ/ν
Wvl or Frq at Max

Max Loss

Min Loss

Wvl or Frq at Min

The Photonic All-Parameter Analyzer uses 193.1 THz as the ITU Channel 0 
frequency.NOTE
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The Channel Bandwidth is the nominal value of the width of each 
channel, centered around the ITU channel frequency.

The NdB Offset defines a change in signal loss indicating the effective 
width of the channel. For example, for a 3dB bandwidth, the value for 
NdB Offset should be set to “3”.

The results of the peak analysis are shown on the peak tab of the 
Analysis table window. The columns displayed are:

Color Indicates the color of the corresponding graph

Measurement The name of the file in which the measurement 
is stored.

Light Path Whether the measurement was made in the 
transmission or reflection light path

Curve The type of measurement (PDL, Loss,...).

loss

ν

ITU Channel Spacing

ITU Channeln ITU Channeln+1

Channel
Bandwidth

NdB Offset

loss

λ/ν
Peak Wavelength or Frequency

Max Loss Passband

Loss at Peak

Channel Bandwidth
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Peak Wavelength [nm]
Peak Frequency [THz]

The wavelength or frequency at which the 
minimum loss was measured.

Max Loss Passband 
[dB]

The maximum loss measured in the passband 
centered at the peak wavelength or frequency 
with the specified channel bandwidth.

Loss at Peak [dB] The value of the minimum loss.

ITU-Ch The number of the ITU Channel closest to the 
peak wavelength or frequency

ITU Wavelength [nm]
ITU Frequency [THz]

The center wavelength or frequency of the 
ITU Channel

Loss at ITU [dB] The loss at the ITU center wavelength or 
frequency

Min Loss ITU-Ch [dB] The minimum loss in the ITU Channel 
centered at the ITU wavelength or frequency, 
with the specified channel bandwidth.

Max Loss ITU-Ch [dB] The maximum loss in the ITU Channel 
centered at the ITU wavelength or frequency, 
with the specified channel bandwidth.

loss

λ/ν
ITU Wavelength or Frequency

Channel Bandwidth

Loss at ITU

Max Loss ITU-Ch

Min Loss ITU-Ch

loss

n dB Center
λ/ν

NdB Offset

n dB Bandwidth

Loss at Center
Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition 199



Analyzing Results Selecting the Results Displayed in the Analysis Table
n dB Center [nm]
n dB Center [THz]

The wavelength or frequency half way 
between the points on either side of the peak 
that are offset from the peak loss by the value 
specified for NdB Offset.

Loss at Center [dB] The loss at the wavelength or frequency half 
way between the two NdB points.

n dB Bandwidth [nm]
n dB Bandwidth [THz]

The bandwidth between the two NdB points.

Crosstalk Adjacent Ch. 
Short Wvl. [dB]

The difference between the maximum loss in 
the ITU channel, and the minimum loss in the 
next ITU channel at a shorter 
wavelength/longer frequency.

Crosstalk Adjacent Ch. 
Long Wvl. [dB]

The difference between the maximum loss in 
the ITU channel, and the minimum loss in the 
next ITU channel at a longer 
wavelength/lower frequency.

loss

λ

Channel Bandwidth

ITU Channeln-1ITU ChannelnITU Channeln+1

CrosstalkCrosstalk
Adjacent Ch.
Short Wvl.

Adjacent Ch.
Long Wvl.

loss

ν

Channel Bandwidth

ITU Channeln+1ITU ChannelnITU Channeln-1

CrosstalkCrosstalk
Adjacent Ch.
Long Wvl.

Adjacent Ch.
Short Wvl.
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4 If you selected notch analysis, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing.

The ITU Channel Spacing (in the frequency domain) defines which of 
the channels, as defined by the International Telecommunication Union 
(ITU), are being used.

The Channel Bandwidth is the nominal value of the width of each 
channel, centered around the ITU channel frequency.

The Drop Range Bandwidth is the bandwidth to the edges of the 
passband.

The results of the notch analysis are shown on the notch tab of the 
Analysis table window. The columns displayed are:

The Photonic All-Parameter Analyzer uses 193.1 THz as the ITU Channel 0 
frequency.NOTE

Color Indicates the color of the corresponding graph

Measurement The name of the file in which the 
measurement is stored.

Light Path Whether the measurement was made in the 
transmission or reflection light path

Curve The type of measurement (PDL, Loss,...).

loss

ν

ITU Channel Spacing

ITU Channeln ITU Channeln+1

Channel
Bandwidth

loss

ν

Channel
Bandwidth

Drop Range Bandwidth

Passband Passband
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Notch Wavelength [nm]
Notch Frequency [THz]

The wavelength or frequency at which the 
maximum loss was measured

Loss at Notch [dB] The value of the maximum loss.

ITU-Ch The number of the ITU Channel closest to the 
notch wavelength or frequency

ITU Wavelength [nm]
ITU Frequency [THz]

The center wavelength or frequency of the 
ITU Channel

Loss at ITU [dB] The loss at the ITU center wavelength or 
frequency

Min Loss ITU-Ch [dB] The minimum loss in the ITU Channel 
centered at the ITU wavelength or frequency, 
with the specified channel bandwidth.

Max Loss ITU-Ch [dB] The maximum loss in the ITU Channel 
centered at the ITU wavelength or frequency, 
with the specified channel bandwidth.

loss

λ/ν
Notch Wavelength or Frequency

Loss at Notch

loss

λ/ν
ITU Wavelength or Frequency

Channel Bandwidth

Loss at ITU
Max Loss ITU-Ch

Min Loss ITU-Ch
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5 Click on the Finish button.

Min Loss Short Wvl 
Passband [dB]

The minimum loss measured at shorter 
wavelengths/higher frequencies, outside the 
drop range.

Max Loss Short Wvl 
Passband [dB]

The maximum loss measured at shorter 
wavelengths/higher frequencies, outside the 
drop range.

Min Loss Long Wvl 
Passband [dB]

The minimum loss measured at longer 
wavelengths/lower frequencies, outside the 
drop range.

Max Loss Long Wvl 
Passband [dB]

The maximum loss measured at longer 
wavelengths/lower frequencies, outside the 
drop range.

λ

Channel BandwidthChannel Bandwidth

Drop Range Bandwidth

Min Loss Short Wvl

Max Loss Short Wvl

Min Loss Long Wvl

Max Loss Long Wvl

loss

ν

Channel BandwidthChannel Bandwidth

Drop Range Bandwidth

Min Loss Long Wvl

Max Loss Long Wvl

Min Loss Short Wvl

Max Loss Short Wvl
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Reanalyzing the Generic, Peak and Notch Loss for the Active 
Measurement

1 in the Measurement View tab of the Workspace window click with the 
right mouse button on the measurement name, select Reanalyze Loss.

2 Click on the boxes to set a check mark in the row and column 
corresponding to the loss analyses you want to perform (generic, peak 
and notch analyses, in the transmission and reflection paths).
Click on the Next > button.

3 If you selected peak analyses, enter the values for the Channel 
Bandwidth, NdB Offset, and the ITU Channel Spacing. 

4 If you selected notch analyses, enter the values for the Channel 
Bandwidth, Drop Range Bandwidth, and the ITU Channel Spacing.

5 Click on the Finish button.

The loss analyses are shown in the Analysis Table window. See “The View 
Menu” on page 95 for details on how to display the Analysis Table window.
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Comparing Loss Analyses for Several 
Measurements
Comparing the loss analyses for several measurements temporarily 
reanalyzes the generic, peak and notch loss analyses for the selected 
measurements with analyses based on the analysis parameters of the 
active measurement, and adds the resulting analyses to the analysis 
tables.

The analyses and analysis parameters for the selected measurements are 
not altered in the file or the measurement.
If you change the active measurement, the analyses for the comparison 
are deleted.
To change the analyses for a measurement, see “Reanalyzing the Generic, 
Peak and Notch Loss” on page 196.

1 In the Analysis menu, select Compare Loss Analysis with Active 
Measurement....
To compare the loss analyses for any individual non-active 
measurement with the active measurement, in the Measurement View 
tab of the Workspace window click with the right mouse button on the 
measurement name, use Compare Loss Analysis with Active 
Measurement.

2 Click on the boxes to set a check mark beside in the row and column 
corresponding to the loss analyses you want to compare with the 
active measurement (generic, peak and notch analyses, in the 
transmission and reflection paths).

3 Click on the Finish button.

The loss analyses of the active measurement and the measurements 
selected for comparison are shown in the Analysis Table window.
See “The View Menu” on page 95 for details on how to display the 
Analysis Table window.
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Arranging the Analysis Table

Reordering the Table

You can reorder the table according to the data in any column by double-
clicking on the header for that column.

For example, after you have first opened a file, double-clicking on Min Loss 
[dB] will sort the table in the order of ASCENDING minimum losses. Double 
clicking on Min Loss [dB] a second time will sort the table in the order of 
DESCENDING minimum losses.

Rearranging Columns in the Table

You can rearrange the columns in the table by clicking once on the header, 
then clicking on the header and, holding down the left mouse button, 
dragging the column to its new position.

While you are dragging the column, the cursor changes to . The position 
where the column will be reinserted into the table is shown as a red line.

Resizing and Hiding Columns

You can resize a column by clicking on the division between this column 
and the column to its right. The cursor changes to  when you are over 
the division between columns.
Hold down the mouse button and drag the column to the new width.

You can hide a column by reducing its width to zero.

You can resize a hidden column by moving over the gap between columns 
where the hidden column is, until the cursor changes to .
Hold down the mouse button and drag the column to the new width.
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Exporting Data for Further 
Processing

Exporting Trace Data
To export the trace data for the active measurement as a comma-
delimited ASCII text file:

1 In the File menu, select ASCII Export....

2 Click on the measurement for which you want to export results.

3 Click on the Next button.

4 Make sure the only boxes checked are beside the parts of the 
measurement you want to export.

5 Select the number of samples you want to export for each curve.
If you select “All”, all of the samples used to draw the measurement 
curve will be exported.
If you select a number, that number of equally spaced samples will be 
exported. This makes it easier for you to compare curves, to generate 
consistent curves in an external application, or to reduce the quantity 
of data for post-processing by other applications.

6 Click on the Next button.
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7 Enter the name for the file and click on the Finish button.

The selected results are exported to an ASCII text file using comma (,) 
separated values (.csv).

The Trace Data
Export File

• The file starts with three lines listing the name and revision of the 
library and software used.

• Each section of the file starts with an empty line followed by a section 
header in angled brackets, for example:

<Measurement parameters>.

The remaining sections are repeated for each measurement selected for 
export.

• The sections for DUT Settings and Measurement parameters, are 
followed by a number of lines, each starting with a label, followed by 
the parameter corresponding to that label, separated by commas. Some 
of the labels are indented (the line starts with a comma), such as the 
loss parameters, for example:

<Measurement parameters>
Loss measurement,Pdl
,Measure transmission,On
,Measure reflection,On
,Start wavelength [nm],1535
,Stop wavelength [nm],1575
,Wavelength step [nm],0.005
,Coherence control,Off
...

• The section for the Instrument setup has 

• The first line contains the labels for the data columns (Resource, Seri-
al number, Software version), separated by commas.

• The following rows contain the instrument setup data, separated by 
commas, for example:

<Instrument setup>
Resource,Serial number,Software version
GPIB0::24::INSTR[POL(8169A)],3425G00857,V2.0
GPIB0::30::INSTR[8164A],DE38200050,V3.50(87702)
...
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• The remaining sections contain the Measurement traces. For each 
trace:

• The first line contains information on the number of samples that fol-
low (the number of rows of data).

• The next line contains the labels for the data columns, separated by 
commas.

• The following rows contain the trace data, separated by commas, for 
example:

<Measurement traces>
<DATA_ 201 samples>
Lambda[nm],DGD Ch.1 Tx[s],GD Ch.1 Tx[s],
1552.9,2.94033368261844e-014,8.21228823385218e-008,
1552.95,2.9039955403708e-014,8.21228953115737e-008,
1553,2.83575259191074e-014,8.21229085668691e-008,
1553.05,2.75106681223847e-014,8.21229222722829e-008,
1553.1,2.65939957128623e-014,8.21229365245315e-008,
1553.15,2.55078013585895e-014,8.21229513412002e-008,
1553.2,2.50851464762884e-014,8.21229666754103e-008,
1553.25, ...
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Exporting the Jones Matrix

To export the Jones Matrix for the active measurement as a comma -
delimited ASCII text file:

1 In the File menu, select ASCII Export Jones Matrix....

2 Enter the name for the file and click on the Save button. 

The selected results are exported to an ASCII text file (.txt) using comma 
separated values.

The Jones Matrix
Export File

• The first three lines start with a “%”, and contain the name and revision 
of the software and the labels for the data.

• The second line contains the labels for the data columns.
The first column for each reference or DUT measurement is the wave-
length, and the following 8 columns correspond to the elements of the 
amplitude and phase matrices (interleaved), as indicated by the label.

• The third line contains the label for the measurement (the channel 
number, whether it is in transmission or reflection, and whether it is a 
reference or a DUT measurement).

• The labels are positioned in their respective columns by commas.

• The remaining lines contain the data for the matrices for each 
wavelength, separated by commas.
For example:

You can only export the Jones Matrix for GD and DGD measurements 
where this matrix was generated at the time that the measurement was 
made.
See “Setting the Measurement Parameters for All Parameter Mode” on 
page 140, and “Setting the Measurement Parameters in Expert Mode” on 
page 144 for information on generating the Jones Matrix.

NOTE
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Exporting the Mueller Matrix

To export the Mueller Matrix data for the active measurement as a comma 
-delimited ASCII text file:

1 In the File menu, select ASCII Export Mueller Matrix....

2 Enter the name for the file and click on the Save button. 

The selected results are exported to an ASCII text file (.txt) using comma 
separated values.

The Mueller
Matrix Export File

• The first three lines start with a “%”, and contain the name and revision 
of the software and the labels for the data.

• The second line contains the labels for the data columns.
The first column for each reference or DUT measurement is the wave-
length, and the following 4 columns correspond to the elements of the 
matrix, as indicated by the label.

• The third line contains the label for the measurement (the channel 
number, and whether it is in transmission or reflection).

• The labels are positioned in their respective columns by commas.

• The remaining lines contain the data for the first row of the matrices for 
each wavelength, separated by commas.
For example:

The Mueller Matrix information can only be generated from PDL 
measurements.
See “Setting the Measurement Parameters for All Parameter Mode” on 
page 140, and “Setting the Measurement Parameters in Expert Mode” on 
page 144 for information on specifying the measurement of PDL.

The Mueller Matrix information is restricted to the four first-row 
coefficients used in the calculation of PDL.

NOTE
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Saving and Closing Analyses

If you have changed the analysis of a measurement, you may want to save 
it, either replacing the original measurement, or using a different name to 
preserve the original analysis.

When you have finished analyzing a measurement, you should close it to 
remove it from memory.

Saving Measurements
• In the Measurement View tab of the Workspace window click with the 

right mouse button on the measurement name, select Save.

You can also save the active measurement, in the File menu, by selecting 
Save Active Measurement.

Saving a Measurement with a Different Name

• In the Measurement View tab of the Workspace window click with the 
right mouse button on the measurement name, select Save As....

• Enter the name for the file.

• Click on the Save button.

You can save the active measurement with a Different Name

• In the File menu, select Save Active Measurement As....

• Enter the name for the file.

• Click on the Save button.

Saving All Measurements

• In the File menu, select Save All.
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Closing Measurements
• In the Measurement View tab of the Workspace window click with the 

right mouse button on the measurement name, select Close.

You can also save the active measurement, in the File menu, by selecting 
Close Active Measurement.

Closing All Measurements
• In the File menu, select Close All.
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Performance Specifications

Guaranteed
Specifications

Each 81910A  is individually tested for each specification and has passed 
test limits which are tighter than what is displayed as specification. The 
test and specification process follows strict guidelines and is controlled by 
our metrology laboratory. The system specifications are traceable to 
national standards or equivalent according to Agilent guidelines. Offering a 
thorough data sheet backed by stringent quality control measures 
guarantees best performance and application fit over time.

Agilent 81910A Photonic All-parameter Analyzer
Configuration for Measurement of Spectral Loss, Polarization 
Dependent Loss, Group Delay and Differential Group Delay

The specifications given in this section are valid after warm-up, at the 
stated operating conditions and measurement settings, at uninterrupted 
line voltage, and after a reference measurement. Constant ambient 
temperature ±1 K after reference measurement. All optical patchcords and 
fibers fixed and settled for Š 3 minutes.

Technical Specifications

Wavelength range for warranted 
operation

1520 nm to 1620 nm 

Operating wavelength range 1498.1 nm to 1620 nm (option #001 and #002)
1477 nm to 1620 nm (option #003 or #004)

Operating conditions Ambient temperature 5°C  to 45°C, relative humidity <80%, non-condensing 
conditions; environmental conditions suitable for precise optical measurements

Conditions for specified operation Ambient temperature 23°C  ±5 K, relative humidity <80%, non-condensing 
conditions; environmental conditions suitable for precise optical measurements 

Warm-up time 1 hour

Environmental storage conditions -40 to +50°C

Measurement time Typically 60 seconds for a fully specified measurement of a narrow-band device, 
including all loss and dispersion measurements in transmission and reflection. 
Includes instrument initialization, measurement of device under test, data 
acquisition and display. Reference measurements excluded. 
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Loss and Polarization Dependent Loss 
Measurement Specifications

Loss uncertaintya Transmission Reflection b

loss ≤  0.5 dB ±0.010 dB ±0.020 dB

loss ≤  10 dB ±0.015 dB ±0.025 dB

loss ≤  30 dB c ±0.025 dB ±0.040 dB

loss ≤  40 dB c ±0.050 dB

Loss range (typical) > 55 dB > 45 dB

Polarization dependent loss (PDL) uncertainty d

loss ≤  0.5 dB ±(0.040 dB + 3% of device PDL)
typ.: ±(0.030 dB +3% of device PDL)

±(0.040 dB + 3% of device PDL)
typ.: ±(0.030 dB +3% of device 
PDL)

loss ≤ 10 dB ±(0.050 dB + 3% of device PDL) ±(0.055 dB + 3% of device PDL)

loss ≤ 30 dB ±(0.060 dB + 3% of device PDL) ±(0.100 dB + 3% of device PDL)

Absolute wavelength uncertainty e ±4 pm (±1.5 pm typ.)

Relative wavelength uncertainty e ±3 pm (±0.8 pm typ.)

Wavelength repeatability (typical) ±0.3 pm

Measurement settings as follows: 2 pm step size; ≤ 5 nm/s sweep speed; coherence control off; after zeroing of power meters.
For measurements of, and around, steep slopes, choose sweep speed in nm/s ≤ 200 divided by slope in dB/nm for a device loss ≤ 10 
dB, else sweep speed in nm/s ≤ 50 divided by slope in dB/nm.
Device PDL ≤ 1 dB.

a   For polarization dependent devices, the measurement result corresponds to the loss for non polarized light.
Valid for PDL ≤ 0.1 dB if loss ≤  0.5 dB, and PDL ≤ 0.4 dB if loss ≤ 10 dB.

b   Loss results are relative to the loss of a reference reflector (with return loss ≤ 0.3 dB) used in the reference measurement. 
Note: the reference gold reflector supplied with the test head has a return loss of typ. (0.16 ± 0.13) dB.

c   Source spontaneous emission (SSE) of tunable laser sources (TLS) limits the measurable loss dynamic range of components with narrow 
stop band and broad transmission band (like Fiber Bragg Gratings in transmission). This means an additional loss uncertainty in the stop 
band depending on the amount of total SSE of the source used. The Signal-to-total-SSE ratio of the Agilent 81600B #160 TLS at 
wavelengths up to 1610 nm is ≥ 55 dB.

d   Excludes the polarization dependent loss of all optical connections to the optical test head. In reflection, PDL uncertainty specifications 
are typical if the straight or angled reference kit has been used

e   Valid in the wavelength range of an H13C14N molecular gas cell (NIST SRM 2519), 1528.5 - 1561.6 nm. Outside this range add typ. ±1 pm.
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Dispersion Measurement Specifications

For a detailed relation between uncertainty, resolution and number of 
averages, please refer to the supplementary dispersion measurement 
characteristics allowing to choose best parameter fit for an individual 
application.

Group Delay (GD) Transmission Reflection

Group Delay dynamic range (typical) 10 ns

Group Delay loss range (typical) 30 dB

Group Delay resolution <0.1 fs

Group Delay uncertainty a b

Group Delay noise c d < ± 50 fs (< ± 35 fs typical) e

Group Delay relative uncertaintyf ±1.5 % of device relative Group Delay

Differential Group Delay (DGD) Transmission Reflection

Differential Group Delay measurement range 
(typical)

0.5 ns

Differential Group Delay loss range (typical) 30 dB

DGD resolution <0.1 fs

Differential Group Delay uncertainty a

Differential Group Delay noise cd < ± 80 fs (< ± 55 fs typical) e

Polarization Mode Dispersion (PMD) 
uncertaintyg (typical)

<±5.0 fs n/a

Absolute wavelength uncertainty h ± 1.5 pm

Maximum device optical path length (typical) 15 m (80 nm/s sweep speed)
30 m (40 nm/s sweep speed)
60 m (20 nm/s sweep speed)
120 m (10 nm/s sweep speed)

a   Any 50 nm within 1520 and 1620 nm.
b   For polarization dependent devices, the measurement result corresponds to the GD for non polarized light.
c   30 measurements averaged, wavelength resolution bandwidth 30 pm, 40 nm/s sweep speed..

For a detailed relation between uncertainty, resolution, and number of averages, please refer to the supplementary dispersion 
measurement characteristics. This relation allows you to choose the best parameter fit for an individual application.

d   Measuring a patch cord, made of 2 m standard single mode fiber and a 0.1 m section of polarization maintaining fiber with ~0.1 ps DGD in 
transmission. In reflection, measuring a patch cord, made of 1 m standard single mode fiber and a 0.1 m section of polarization maintaining 
fiber with ~0.1 ps DGD, terminated by a gold reflector.

e   30 measurements averaged, wavelength resolution bandwidth 30 pm, 80 nm/s sweep speed over full operating wavelength range.
f   Measuring a GD peak of ~16.5 ps amplitude at wavelength 1550.515 nm of a H13C14N molecular gas cell (NIST SRM 2519).

The peak GD value is derived from spectral loss data using the Kramers-Kronig relation. Double pass of the cell in reflection.
30 measurements averaged, wavelength resolution bandwidth 10 pm. 

g   Measurement of NIST Standard Reference Material 2518 (Mode-coupled PMD artifact, 50 nm wavelength range from 1520 to 1570 nm, 
PMD ~300 fs).

h   Valid in the wavelength range of an H13C14N molecular gas cell, 1528.5 - 1561.6 nm. Outside this range uncertainty values are typical.
Between 1595 nm and 1620 nm uncertainties are as given in the Loss and PDL section. 
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Supplementary dispersion measurement 
characteristics
Group Delay and Differential Group Delay measurement uncertainty can be 
customized to any application requirements in terms of accuracy, 
resolution, and measurement time by adjusting resolution bandwidth and 
number of averaged sweeps. The relation between accuracy, resolution 
bandwidth and averages is shown in Figure 17 and Figure 18. 

Figure 17 Group Delay noise as a function of resolution bandwidth and number of averages

Figure 18 Differential Group Delay noise as a function of resolution bandwidth and number 
of averages

Graphics depict the performance of a representative unit measured on an 
optical bench. Note that with 30 pm spectral averaging and 30 averages a 
Group Delay uncertainty of 25 fs is achieved. Valid between 1520 and 1620 
nm at 40 nm/s.

NOTE
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Ordering instructions

The Agilent 81910A Photonic All-Parameter Analyzer must be ordered with 
option #001 or #002, #003, or #004.
Option #005 can be combined with any of these options.

81910A #001: complete system.
Includes 81600B #160 tunable laser, 8164B mainframe, 8169A polarization 
controller, 81634B power meters, system controller, licensed software, 
three reference kits, accessories and optical test head.
Each reference kit consists of transmission fiber and pigtailed reflector 
equipped with straight or angled connectors or with bare fibers.
System controller may be used as host PC.

81910A #002: same as #001, but integrates a pre-owned tunable laser.
Customer has to send back either one tunable laser source 81640A, 
81680A/B, or 81480A/B for conversion into an 81600B #160 tunable laser 
and integration in the system, or a tunable laser source 81600B #160 or 
81640B with option #072 (angled connector) for integration.

81910A #003: same as #001, but includes a 81600B #200 tunable laser.

81910A #004: same as #003, but integrates a pre-owned 81600B #200 
tunable laser. Customer has to send back one tunable laser source 81600B 
#200 to Agilent Technologies for integration in the system.

81910A #005: system without DGD and PMD measurement functions. 
If these capabilities are required later, they can be added by ordering 
81911A retrofit DGD and PMD measurement function. Every system 
shipped is verified for DGD and PMD measurement accuracy, whether or 
not #005 is ordered, to ensure upgrading is possible.

81911A: retrofit DGD and PMD measurement function to an 81910A 
with option #005.
The upgrade is carried out on site by an Agilent Technologies 
representative. Performance verification is included. Please state the 
81910A system serial number when ordering.

Optional: if a second PC is used as a host, the following performance is 
required: PC with min. 500 MHz CPU, 192 MB RAM or more, Windows XP, 

Windows 2000 or Windows NT with SP6, 200 MB free hard disk space; 2 
free PCI slots; 81910A operated by a SW revision greater 2.5.
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Operational Verification Test

Purpose

Although this verification is a subset of the total process for verifying the 
system’s conformance to specifications, this procedure can be used alone 
as a functional test and can be helpful in the following ways:

• It can be used at incoming inspection to check that no major 
degradation has occurred in the system during shipment

• It provides a means to periodically monitor measurement stability

• It can help isolate the cause of incorrect measurement results. (When 
the system passes the test, you will have confidence the system is 
operating correctly and any problem is in the setup or with the DUT)

Introduction

This chapter covers the verification procedure for the 81910A All-
Parameter Analyzer.

Before running the verification procedures, turn the system on and allow it 
to warm up for one hour (1 h). Please close the hood of the optical test 
head before making any measurement.

Figure 19 81910A All-parameter Analyzer Setup

Optical Test Head

PC with Photonic 
Analysis Toolbox and 
System Controller 
software

Lightwave 
Measurement 
System

Polarization 
Controller
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Equipment Required

Required equipment to perform the operational verification test is 
delivered with the 81910A All-parameter Analyzer system. For reference, 
the additional accessories required during the operational verification test 
are listed in the table below.

Fix the DUT on the bench of the Optical Test Head and fix the optical 
cables, using the fiber clamps, to ensure minimum cable movement during 
the tests.

Ensure you run the recommended tests after exchanging the Optical Test 
Head adapter patchcords for maintenance.

Qty Part Number Part Description

1 ea 81910-88706 Reference Fiber Kit Angled, incl.

• 16 m Transmission Reference Fiber

• 8 m Reflection Reference Fiber with Reflector

• 2.2 m SMF/PMF Mixed Fiber for Transmission

• 1.1 m SMF/PMF Mixed Fiber with Reflector

2 ea 81000FI + Protective 
Cap

FC/PC Connector Interface

Make sure that all optical connections for the test setups given in the 
procedure are dry and clean. DO NOT USE INDEX MATCHING OIL. For 
cleaning, use the cleaning instructions given in “Cleaning” on page 270.

NOTE

DO NOT DISCONNECT AND CLEAN THE FIBERS CONNECTED TO 
THE THREE POWERMETERS. These fibers have a special anti-
reflection (AR) coating that is removed by cleaning the connectors 
with anything other than clean and compressed air. Removing this 
coating results in performance degradation.

CAUTION
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Performing Diagnostics
Before taking any measurements, make sure the system passes the 
diagnostics. 

The Diagnostic Tool is a part of the software installed with the Photonic 
Analysis Toolbox application on the PC. It can be accessed through the 
windows start menu. 

Please visit our website www.agilent.com for the latest release of the 
Diagnostic Tool. 

The tests are performed in a hierarchical sequence, starting with general 
requirements and finishing with testing specific power levels in different 
configurations. The last step requires user interaction and the following 
equipment

• transmission reference fiber

• reflection reference fiber

• caps to darken optical input and output

Sequence

1 On the PC, where the Photonic Analysis Toolbox is installed, start the 
Diagnostic Tool.

• Click on the Windows Start menu.

• Select Programs and then Photonic Tools.

• In Photonic Tools select Diagnostic Tool.

2 In the Diagnose menu, select All.

3 Follow the instructions as required while the program executes the 
Optical Layer Test. 

The tests are, in detail:

• Operating System Layer
Purpose: Verification of the system requirements to successfully run 
measurements
User Interaction: none

• Software Layer
Purpose: Check availability and revision of required libraries and 
licenses
User Interaction: none

• Controller Layer
Purpose: Triggering and verification of self-test status of the system 
controller
User Interaction: none
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• Instrument Layer
Purpose: Verification of hardware test setup, check availability of 
required instruments
User Interaction: none

• Optical Layer
Purpose: Verification of instrument setup, cabling and performance of 
subparts
User Interaction: yes

The optical layer test requires following user interactions:

a Verification that no DUT is connected to the Optical Test Head 

b Connection of reference patchcord to the Optical Test Head

c Connection of a reference reflection to the Optical Test Head

If the optical layer test fails, a dialog box gives further advice on how to 
proceed. Please follow the advise in order to resolve the issue.

If the error cannot be resolved by following the suggestions given in the 
diagnostic analyzer, contact your Agilent Service representative. Please 
save a log of the diagnostic test.

Please find below a schematic drawing for your reference. The diagnostic 
tool lists the power readings according to the scheme below.

Figure 20 Schematic Drawing of the Optical Architecture
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Problem Analysis and Solution

warning Low monitoring power

cause Patchcord to power module in slot 1

description The Diagnostic Tool has found at least one expected 
power value within the given test limit, but the test for 
monitoring power failed. This indicates, the connection 
to the Optical Test Head is ok, but the connector or fiber 
to the power module in slot 1 has too much insertion 
loss

potentially affected 
components 

Connection to power module in slot 1

solution Using clean and dry air, blow clean the connection of the 
power module in slot 1 (fiber connector and module 
input lens) – but do not physically touch or otherwise 
clean the special treated fiber connector

warning Low transmission power

cause • Adapter patchcord on the optical input of the Optical 
Test Head

• Patchcord used as device under test
• Patchcord to power module slot 3

description The Diagnostic Tool has found monitoring and reflection 
power levels are within test limits, but the transmission 
power is below test limit. This indicates a high insertion 
loss for the transmission measurement

potentially affected 
components 

• Adapter patchcord on the input of the Optical Test 
Head (right connector)

• Transmission device under test
• Patchcord to power module in slot 3 

solution • Clean the connectors of the adapter patchcord 
connected to the input of the Optical Test Head and 
the patchcord used as device under test

• Use another adapter patchcord on the optical input of 
the Optical Test Head

• Use another patchcord as device under test
• Using clean and dry air, blow clean the connection of 

the power module in slot 3 (fiber connector and 
module input lens) – but do not physically touch or 
otherwise clean the special treated fiber connector
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warning Low reflection power

cause • Adapter patchcord on the optical output of the Optical 
Test Head

• Reflection device under test
• Patchcord to power module slot 2

description The Diagnostic Tool has found monitoring and 
transmission power levels are within test limits, but the 
reflection power is below test limit. This indicates a high 
insertion loss for the reflection measurement

potentially affected 
components 

• Adapter patchcord on the output of the Optical Test 
Head (left connector)

• Reflection device under test
• Patchcord to power module in slot 2 

solution • Clean the connectors of the adapter patchcord 
connected to the output of the Optical Test Head and 
the reflection device

• Use another adapter patchcord on the optical output 
of the Optical Test Head

• Use another reflection device
• Using clean and dry air, blow clean the connection of 

the power module in slot 2 (fiber connector and 
module input lens) – but do not physically touch or 
otherwise clean the special treated fiber connector

warning Low monitoring, transmission and reflection power

cause • Connection TLS - Polarization Controller - Optical Test 
Head has a high loss

• Leading fibers from Optical Test Head to power 
modules defect
(fiber break or connector loss)

description The Diagnostic Tool has found power values at all power 
modules in slot 1, 2 and 3 are below test limit; indicating 
an unusually high loss at the beginning of the optical 
path (TLS to Optical Test Head). 

potentially affected 
components 

• Short and long semi-rigid fibers 
• Connections on TLS, Polarization Controller and 

Optical Test Head

solution • Clean the semi-rigid fibers connections and 
reconnect. Do not apply stress to the short semi rigid 
fiber.

• Using clean and dry air, blow clean the connections 
on the 3 power modules 1, 2 and 3 (fiber connector 
and module input lens) – but do not physically touch 
or otherwise clean the special treated fiber 
connectors
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warning Low transmission and reflection power

cause • Adapter patchcords on the optical input and output of 
the Optical Test Head

• Reflection device used as device under test
• Connection TLS - Polarization Controller - Optical Test 

Head has a high loss

description The Diagnostic Tool has found low transmission and 
reflection power, while the monitoring power was within 
test limits. This may happen if either the adapter 
patchcords / DUT has too high a loss or if the 
connection to the Optical Test Head has a high insertion 
loss.

potentially affected 
components 

• Adapter patchcords within Optical Test Head
• Reflection / Transmission device under test
• Connection TLS – Polarization Controller – Optical 

Test Head
• Three patchcords in the tubing from the back of the 

Optical Test Head

solution • Clean the connectors of the adapter patchcords and 
the device under test

• Use another adapter patchcord on the optical output 
of the Optical Test Head

• Clean the semi-rigid fibers connections and reconnect 
them

warning Low monitoring power, high reflection and 
transmission power

cause Patchcord to power module slot 1

description The Diagnostic Tool has found the power value at power 
module in slot 1 to be below the given test limit, while 
the power values for slot 2 and 3 were above the upper 
test limit. This failure is a result of two different errors, 
but proceed with suggested solution first (second failure 
is: High transmission or reflection power)

potentially affected 
components 

Connection to power module in slot 1

solution Using clean and dry air, blow clean the connection of the 
power module in slot 1 (fiber connector and module 
input lens) – but do not physically touch or otherwise 
clean the special treated fiber connector
228 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Operational Verification Test Performance Verification
warning High monitoring power

cause Wrong optical connection to power module in slot 1

description The Diagnostic Tool has found the power value at power 
module in slot 1 exceeds the upper limit. If this happens, 
the fiber optic connections are incorrect. Please refer to 
the installation description.

potentially affected 
components 

• All fiber optic connections
• Optical Test Head

solution Connect the correct patchcord to the power module in 
slot 1

warning High reflection power

cause High reflection from input connector (normal if your 
connector optical output power is straight)

description NOTE! This test will fail for all straight ended 
connections due to the high back reflection (low return 
loss). No action is needed if a bare fiber or a straight 
output connector is used. To run an extensive test, 
change the adapter patchcord to angled connections and 
verify whether this test passes or fails.
This test may fail also, if the output connection of the 
Optical Test Head shows too little return loss due to 
wear or physical damage (scratches)

potentially affected 
components 

Adapter patchcord at the output of the Optical Test Head 
(left connector)

solution • If a straight or bare adapter patchcord is connected to 
the optical output of the Optical Test Head, this test is 
intended to fail

• If an adapter patchcord with angled output connector 
is connected to the optical output, then

a clean this adapter patchcord,
b use another angled adapter patchcord at the optical 

output
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warning High transmission or reflection power

cause Semi-rigid fiber connection

description The Diagnostic Tool has found too much power is applied 
to the power modules in slot 2 and 3, leading to over 
ranging when starting a measurement. This failure is 
really rare and might only happen if the state of 
polarization at the input of the polarization controller is 
near to an ideal linear input state. Disconnecting, 
bending and reconnecting the semi-rigid fibers resolves 
this failure.

potentially affected 
components 

Short and long semi-rigid fiber connections

solution • Reconnect the semi-rigid fibers
• Reconnect the short semi-rigid fiber with flipped 

connections (that is, connecting what was previously 
the TLS output to Polarization Controller input, and 
vice versa.)

warning The power expected in transmission and reflection are 
interchanged

cause Two patchcords to power modules have been 
interchanged

description The Diagnostic Tool has found the expected power 
values for transmission and reflection measurements to 
be interchanged. This can happen if either the adapter 
patchcords within the Optical Test Head or the 
patchcords to the power module in slot 2 and 3 are 
interchanged. 

potentially affected 
components 

• Three patchcords in the tubing from the back of the 
Optical Test Head

• Adapter patchcords within Optical Test Head

solution Interchange patchcords to power module in slot 2 and 3
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warning Transmission power equal to expected monitoring 
power

cause Two patchcords to power modules have been 
interchanged

description The Diagnostic Tool has found unexpected power values 
applied to power module in slot 1 and 3. This can happen 
if either the adapter patchcords within the Optical Test 
Head or the patchcords to the power module in slot 1 
and 3 are interchanged. 

potentially affected 
components 

• Three patchcords in the tubing from the back of the 
Optical Test Head

• Adapter Patchcords within Optical Test Head

solution Interchange patchcords to power module in slot 1 and 3

warning Reflection power equal to expected monitoring power

cause Two patchcords to power modules have been 
interchanged

description The Diagnostic Tool has found unexpected power values 
applied to power module in slot 1 and 2. This can happen 
if either the adapter patchcords within the Optical Test 
Head or the patchcords to the power module in slot 1 
and 2 are interchanged. 

potentially affected 
components 

• Connection to power module in slot 1, 2 and 3
• Adapter patchcords within Optical Test Head

solution Interchange patchcords to power module in slot 1 and 2

warning Internal optical loss failure

cause WRU failure

description The power values detected at the Optical Test Head 
internal wavelength reference unit (WRU) are too low

potentially affected 
components 

Optical Test Head

solution Contact your Agilent Service representative
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warning Internal optical loss failure

cause Local oscillator failure

description The power values at the Optical Test Head internal 
oscillator are too low

potentially affected 
components 

Optical Test Head

solution Contact your Agilent Service representative

warning Internal optical loss failure

cause WRU or local oscillator failure

description Diagnostic has detected too much power at the Optical 
Test Head internal wavelength reference unit (WRU) or 
at the internal oscillator

potentially affected 
components 

Optical Test Head

solution Contact your Agilent Service representative
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Verification Test
If the diagnostic tool has passed all layer tests, start testing the 
functionality of the system.

Transmission Measurements

Test Setup and
Measurement

1 If the system has been warmed up for an hour, start the Photonic 
Analysis Toolbox.

2 Set up the measurement with the following parameters:

3 Start the reference measurement

a Perform the Initialization Reference, including  the Zero Power 
Sensor function, using protective caps on the connectors of the 
Optical Test Head to prevent light from entering the fibers.

b Connect the transmission reference device (16 m fiber) to the 
output and input of the Optical Test Head. Allow 3 min. for the fiber 
to settle.

c Perform the Transmission Reference. This will be used for the 
phase measurement verification (GD and DGD).

d Press Finish.

4 Disconnect the transmission reference device and connect the 2.2 m 
mixed-fiber transmission device to the output and input of the Optical 
Test Head. Fix the fiber on the Test Head so that it does not move during 
the measurements.

 Parameters Test Settings

Measurement GD / DGD and 
Loss/PDL

Direction Transmission

Start Wavelength 1550.0

Stop Wavelength 1555.0

 Wavelength Step 1.0 pm

Number of Scans 30

Range of Data Points for Averaging 30

Dynamic Range Low (One Sweep)

Coherence Control Off

Maximum Sweep Speed 5 nm/s

Power Sensor Start Range, Transmission automatic

Power Sensor Start Range, Reflection n/a
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5 Start the DUT Measurement. The result will be used to verify the 
measurement of GD and DGD.

6 When the measurement is finished, and particularly if the test limits 
are exceeded, save the measurement results to a file.
a) If not already set as active measurement, set as active measurement 
in the Curve View tab.
b) From the File menu, select Save Active Measurement.

7 Analyze the GD and DGD measurement curves to verify the phase 
measurements in transmission. Sample results are shown below.

Figure 21 Group Delay (GD)

There is a linear increase of GD vs. wavelength due to fiber dispersion. The 
fluctuation in GD other than this increase should stay within the test limit.
Test limit: ±0.05 ps around the fitted regression of the GD curve.
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Figure 22 Differential Group Delay (DGD)

Test Limit: ± 0.08 ps around the mean of the DGD curve. The mixed test 
fiber provides a DGD of about 0.150 ps.

8 Leaving the mixed-fiber transmission device attached and unmoved, 
repeat the Transmission Reference measurement. It is not necessary 
to repeat the initialization reference.

9 Then reposition the mixed fiber device without disconnecting. For 
example flip the coils of the fiber over. The goal is to change the 
polarization states inside the fiber. Fix the fiber again so it does not 
move. Then wait 3 minutes for the fiber to settle.

10 Start the DUT measurement. The result will be used to verify the 
measurement of IL and PDL.

11 When the measurement is finished, and particularly if the test limits 
are exceeded, save the measurement results to a second file.

12 Analyze the IL and PDL measurement curves to verify the loss 
measurements in transmission. Sample results are shown below.
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Figure 23 Insertion Loss (IL)

Test limit: ±0.010 dB

Figure 24 Polarization Dependent Loss (PDL))

Test limit: ±0.040 dB
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Reflection Measurements

Test Setup and
Measurement

1 If the system has been warmed up for an hour, start the Photonic 
Analysis Toolbox.

2 Set up the measurement with the following parameters:

3 Start the Reference Measurement

a Perform the Initialization Reference, with no fibers attached to the 
connectors of the Optical Test Head. (If the Zero Power Sensor 
function was already used before the transmission measurement it 
does not need to be repeated.)

b Connect the reflection reference device (8 m fiber) to the output of 
the Optical Test Head. Allow 3 min. for the fiber to settle.

c Perform the Reflection Reference. This will be used for the phase 
measurement verification (GD and DGD). (It is not necessary to 
make the Termination Reference for these verifications so select 
only Reflection from the drop-down menu on the reference tab).

d Press Finish.

4 Disconnect the reflection reference device and connect the 1.1 m 
mixed-fiber reflection device to the output of the Optical Test Head. 
Fix the fiber on the Test Head so that it does not move during the 
measurements.

5 Start the DUT Measurement. The result will be used to verify the 
measurement of GD and DGD.

 Parameters Test Settings

Measurement GD / DGD and 
Loss/PDL

Direction Reflection

Start Wavelength 1550.0

Stop Wavelength 1555.0

 Wavelength Step 1.0 pm

Number of Scans 30

Range of Data Points for Averaging 30

Dynamic Range Low (One Sweep)

Coherence Control Off

Maximum Sweep Speed 5 nm/s

Power Sensor Start Range, Transmission n/a

Power Sensor Start Range, Reflection automatic
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6 When the measurement is finished, and particularly if the test limits 
are exceeded, save the measurement results to a third file.

7 Analyze the GD and DGD measurement curves to verify the phase 
measurements in reflection. Sample results are shown below.

Figure 25 Group Delay (GD)

There is a linear increase of GD vs. wavelength due to fiber dispersion. The 
fluctuation in GD other than this increase should stay within the test limit. 
Test limit: ± 0.05 ps around the fitted regression of the GD curve.
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Figure 26 Differential Group Delay (DGD)

Test Limit: ± 0.08 ps around the mean of the DGD curve. The mixed test 
fiber provides a DGD of about 0.150 ps.

8 Leaving the mixed-fiber reflection device attached and unmoved, 
repeat the Reflection Reference measurement. It is not necessary to 
repeat the initialization reference.

9 Then reposition the mixed fiber device without disconnecting. For 
example flip the coils of the fiber over. The goal is to change the 
polarization states inside the fiber. Fix the fiber again so it does not 
move. Then wait 3 minutes for the fiber to settle.

10 Start the DUT measurement. The result will be used to verify the 
measurement of IL (RL) and PDL.

11 When the measurement is finished, and particularly if the test limits 
are exceeded, save the measurement results to a fourth file.
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12 Analyze the IL and PDL measurement curves to verify the loss 
measurements in reflection. Sample results are shown below.

Figure 27 Insertion Loss (IL) / Return Loss (RL)

Test Limit: ± 0.020 dB.

Figure 28 Polarization Dependent Loss (PDL)

Test Limit: ±0.040 dB.
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Condensed Performance 
Verification Test

Introduction
The procedures in this section outline the performance test for the 
measurement system. The complete specifications to which the system is 
tested are given in “System Specifications” on page 215. All tests can be 
performed without access to the interior of the instruments.

The procedure outline in this section is intended to clarify the calibration 
method. The procedures require many measurements, detailed analysis 
and specialized equipment and are not intended to be performed manually 
by the user. Agilent Technologies offers a standards compliant system 
calibration. Contact your nearest Agilent Sales/Service Office for details.

Equipment Required

Equipment required for the performance test is listed in the table below. 
Any equipment that satisfies the critical specifications of the equipment 
given in the table may be substituted for the recommended models.

a Equivalent devices are provided in the Angled Fiber Reference Kit, 
supplied with the 81910A

The calibration of the 81910A All Parameter Analyzer does not require the 
calibration of the individual 81910A system components.NOTE

Qty Part Description

1 ea Wavelength Reference (HCN Gas Cell)

1 ea Polarization Scrambler Transmission (E2000 connectors)

1 ea Polarization Scrambler Reflection (E2000 connectors)

1 ea Polarizer (E2000 connectors)

1 ea Short Reflection Reference Fiber

1 ea Transmission Reference Fiber a

1 ea Long Reflection Reference Fiber a

1 ea GD/DGD Standard Transmission a

1 ea GD/DGD Standard Reflection a

2 ea 81000NI and Protective Caps
FC/PC Connector Interface (required for each test, not mentioned in 
the rest of this description)
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Troubleshooting

If the All-Parameter Analyzer measurement system does not perform 
according to specifications, please run the 'Diagnostic Tool'. This tool will 
help troubleshoot the failure and, in most cases, help you identify the root 
cause, which can usually be fixed easily. 

Please visit our website www.agilent.com for the latest release of the 
Diagnostic Tool. 

Instrument Specification

To test the overall system specification it is required that each instrument 
is within specification. 

Specifications are the performance characteristics of the instrument that 
is certified. These specifications are the performance standards or limits 
against which the test system can be tested. This chapter also lists some 
supplementary performance characteristics. Supplemental performance 
characteristics should be considered as additional information.

Any changes in the specifications due to manufacturing changes, design, 
or traceability to the National Institute of Standards and Technology 
(NIST), will be covered in a manual change supplement, or revised manual. 
Such specifications supersede any that were previously published.

Fix the DUT on the bench of the Optical Test Head and fix the optical 
cables, using the fiber clamps, to ensure minimum cable movement during 
the tests.

Make sure you run the recommended test after exchanging the adapter 
patchcords for maintenance.

Make sure that all optical connections used in the test setups described 
are dry and clean. DO NOT USE INDEX MATCHING OIL. For cleaning, use 
the cleaning instructions described in “Cleaning” on page 270.

NOTE

DO NOT DISCONNECT AND CLEAN THE FIBERS CONNECTED TO 
THE THREE POWERMETERS. These fibers have a special anti-
reflection (AR) coating which can be removed by cleaning the 
connectors in any other way than with clean and compressed air. 
The removal of this coating results in performance degradation.

CAUTION
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Test Procedure

Due to the statistical nature of the measurement results the data analysis 
described in the test procedure is based on the post data processing of the 
saved measurement results. Generally, each test is divided in following 
sections:

• Test Equipment
lists all additional equipment necessary to carry out the individual test

• Test Setup
shows the setup used during the DUT measurement

• Test Settings
lists all measurement settings in the parameter table

• Measurement
describes the test procedure

• Analysis
generally describes the post data processing sequence

At the end of the performance test procedure a test record is listed for all 
measured and analyzed parameters. Within the test procedure, cross-
references are made to the appropriate part of this test record.

Prior to first delivery, the 81910A All Parameter Analyzer is extensively 
tested using the procedure described here. For re-calibration, a reduced 
set of ranges can be used for testing. To account for both, two different 
settings are given in the procedure.

To eliminate repetition of some frequently used sub-procedures, these are 
described in the general procedures section. 
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General Procedures
This section describes procedures which are frequently required for the 
81910A verification. 

Before beginning the performance tests, you should prepare a separate 
folder on the PC (e.g. c:\data\81910A\) to save the measurement results.

Some performance tests must be programmed with the application 
programming interface (API) because they require access to unprocessed 
measurement data.

Photonic Analysis Toolbox Operations

Save
measurement

result

File – Save Active Measurement as... – Move to measurement results 
folder, enter the given filename and Save

Export
measurement

result

File – Export... – 

1 Select the given file

2 Deselect 'Analysis Table'

3 Move to measurement results folder, enter the given filename and Save

New
measurement

setup

Measurement – Measurement Setup – New... – Measurement Parameter 
menu appears

Edit measurement
setup

Measurement – Measurement Setup – Edit Parameters... – Measurement 
Parameter menu appears

Referencing

Each DUT measurement requires a set of reference measurements. A 
number of measurements have a two-step initial reference measurement 
in common. The initial reference zeroes the power-meters and performs a 
referencing of the internal optical assemblies of the 81910TH:

• zeroing the power meters is necessary once after the system has 
warmed up and can be skipped for further measurements

• the reference measurements require reference fibers as DUT, 
depending on the type of measurement

Each test provides a set of parameters which have to be entered in the 
Measurement Parameter menuNOTE

Each test provides a set of parameters which have to be entered in the 
Measurement Parameter menuNOTE
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Test Setup

Ensure that the hood of the 81910TH is closed before taking any 
measurement.

Wavelength Calibration
Parameters under test: 

• Absolute Wavelength Uncertainty for Loss Specifications in 
Transmission and Reflection (WLA)

• Relative Wavelength Uncertainty for Loss Specifications in 
Transmission and Reflection (WLR)

• Absolute Wavelength Uncertainty for Dispersion Specifications in 
Transmission and Reflection (WPA)

The test measures the absorption lines of a HCN gas cell in the 
wavelength range from 1528nm to 1562nm. 

Due to the limited sample points of the power meters the wavelength 
range is split into two sweeps which are performed consecutively.

Optical Test Head

PC with Photonic 
Analysis Toolbox and 
System Controller 
software

Lightwave 
Measurement 
System

Polarization 
Controller
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Test Equipment

Test Settings (using Expert Mode)

Qty Part Description

1 ea Wavelength Reference (HCN Gas Cell)

1 ea Transmission Reference Fiber

Phase Parameters Initial Test Re-calibration

Measurement GD/DGD GD/DGD

Light Path Transmission Transmission

Sweep Wavelength, Start a 1528.0
b 1550.0

a 1528.0
b 1550.0

Sweep Wavelength, Stop a 1540.0
b 1562.0

a 1540.0
b 1562.0

Sweep Wavelength, Step 1.0 pm 1.0 pm

Resolution Bandwidth, Sliding Window 10.0 pm 10.0 pm

Averaging, Number of Scans 10 10

Sweep Speeds 40 nm/s 40 nm/s

Loss Parameters

Measurement Fast Loss Fast Loss

Light Path Transmission Transmission

Sweep Wavelength Use Phase 
Settings

Use Phase 
Settings

Dynamic Low Low

Loss Parameters, Options

TLS, Coherence Control off off

TLS, Max. Sweep Speed 5 nm/s 5 nm/s

Power Sensor Start Range, Trans. automatic automatic

Power Sensor Start Range, Refl. n/a n/a

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement a) wave_r1 wave_r1

Measurement b) wave_r2 wave_r2
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Measurement

1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Set the sweep wavelength range according to setting a)

4 Start the reference measurement

a Zero the power meters and perform the internal reference 
protective caps.

b Connect the transmission reference fiber and wait 3 min. for it to 
settle.

c Perform the transmission reference measurement.

5 Connect the gas cell, wait 3 min. for the fibers to settle.

6 Perform the DUT measurement.

7 Save and Export the measurement results to wave_r1.omr / 
wave_r1.csv

8 Set the wavelength range to setting b), and repeat steps 3 to 8 of the 
test procedure.

9 Save and Export the measurement results to wave_r2.omr / 
wave_r2.csv

Analysis

Analysis of
Amplitude Data

The basic part of the data evaluation of insertion loss and group delay data 
is the Lorentz-function. This includes a linear regression to ensure 
independence from “background” slopes, due to slight amplitude ripples in 
IL or fiber dispersion in GD.

1 For each file wave_r#.csv a Lorentz-function has to be fitted to each 
peak listed in Table 1, as shown below, that is, for the part of the 
wavelength range covered by the individual range of the file, with 
regard to its loss (amplitude). For the fit, use a 70% of the maximum 
peak value as a threshold criteria to get a selection of useful data 
points around each center. Parameter of interest is the center 
wavelength λc. The fit has to be applied to single peaks. 

2 Calculate the absolute wavelength uncertainty in amplitude for peak k:

where
 is the absolute deviation of peak k,

 the center wavelength from fit of peak k and
 the tabulated wavelength of peak k from Table 1.

Compare each  against the specification.

Test Record Reference: WLA: = MAXk (  )
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3 Calculate the relative wavelength uncertainty in amplitude:

Test Record Reference: WLR: = WLenRelUncertAmp

Analysis of Phase
Data

1 For each file wave_r#.csv a Lorentz-function has to be fitted to each 
peak listed in Table 1, that is, for that part of the wavelength range 
covered by the range of the individual file, with regard to its group delay 
(phase). The Lorentzian fit can be applied to the group delay data, 
regardless of the non-lorentzian shape of the complete curve. In a 
region that is 70% of peak height there is a strong correspondence with 
a Lorentzian shape and the fit easily converges, delivering the correct 
peak location.
Parameter of interest is the center wavelength λc. The fit has to be 
applied to single peaks. 

2 Calculate the absolute wavelength uncertainty in phase for peak k:

where
 is the absolute deviation of peak k,
 the center wavelength from fit of peak k and

 the tabulated wavelength of peak k from Table 1.
Compare each against the specification.

Test Record Reference: WPA: = MAXk( )

Table 1 Selected peaks with very small wavelength uncertainty (0.6 pm specified by NIST used for the test.

no.(k) λ [nm] no.(k) λ [nm]

1 1528.4862 9 1536.7034

2 1528.9271 10 1537.2997

3 1529.8376 11 1538.5224

4 1531.2764 12 1550.5149

5 1532.8024 13 1554.5892

6 1534.4159 14 1555.4346

7 1535.5401 15 1560.7185

8 1536.1170 16 1561.6344
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Loss and Polarization Dependent Loss 
Calibration
Parameters under test:

• Loss Measurement Uncertainty in Transmission and Reflection (LT0, 
LT1, LT2, LT3 / LR0, LR1, LR2)

• Polarization Dependent Loss (PDL) Uncertainty in Transmission and 
Reflection (PT0, PT1, PT2 / PR0, PR1, PR2 / PDA)

Post data processing analysis is required because the saved power values 
are only expressed relative to the monitoring power over wavelength. That 
is, the Photonic Analysis Toolbox shows data in the form of (power in 
transmission (reflection) / monitoring power). A special Service Center 
program is necessary which monitors and logs the monitoring power.

The measurement consists of four parts, with the given results:

a Noise Power Measurement in Transmission and Reflection

b Zero Device Measurement of Loss and PDL in Transmission

c Zero Device Measurement of Loss and PDL in Reflection

d PDL Device Measurement

Noise Power Measurement

Test Equipment

Qty Part Description

1 ea Transmission Reference Fiber

1 ea Long Reflection Reference Fiber
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Test Settings

Measurement 1 Start the Photonic Analysis Toolbox software.

2 Setup new measurement according to the parameters given above.

3 Set the dynamic range according to the settings for a)

Phase Parameters Initial Test Re-calibration

Measurement Off off

… … …

Loss Parameters

Measurement Loss / PDL Loss / PDL

Light Path Both Both

Sweep Wavelength Set manually Set manually

Sweep Wavelength, Step 10.0 pm 10.0 pm

Sweep Wavelength, Start 1520.0 1520.0

Sweep Wavelength, Stop 1620.0 1620.0

Dynamic a Low (1 
sweep)

b Medium (2 
sweeps)

c High (3 
sweeps)

a Low (1 
sweep)

b Medium (2 
sweeps)

c High (3 
sweeps)

Loss Parameters, Options

TLS, Coherence Control off off

TLS, Max. Sweep Speed 40 nm/s 40 nm/s

Power Sensor Start Range, Trans. automatic automatic

Power Sensor Start Range, Refl. automatic automatic

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement a) range1 range1

Measurement b) range2 range2

Measurement c) range3 range3

Measurement d) monitoring.txt monitoring.txt
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4 Start the reference measurement

a Zero the power meters and perform the internal reference with 
protective caps. Note that if the system is stable, the power meter 
zeroing need not always be repeated.

b Unwrap the fiber and connect the fiber end to the optical input of 
the test head; wait 3 min. for the fiber to settle.

c Perform the transmission reference measurement.

d Connect the long reflection reference fiber and wait 3 min. for it to 
settle.

e Perform the reflection reference calibration.

f Connect the transmission reference fiber to the optical output and 
wrap the other fiber end about 8 times around a rod of about 5 mm 
diameter and wait 3 minutes for it to settle.

g Perform the termination reference measurement.

5 As DUT, use the transmission reference fiber, where the fiber end is 
wrapped about 8 times around the termination rod.

6 Perform the DUT measurement.

7 Save and Export the results to range1.omr / range1.csv

8 Change the measurement parameters for Dynamic to b).

9 Ignore/cancel the reference warnings and start the DUT measurement.

10 Save and Export the results to range2.omr/ range2.csv

11 Change the measurement parameters for Dynamic to c).

12 Ignore/cancel the reference warnings and start the DUT measurement.

13 Save and Export the results to range3.omr/ range3.csv

14 Use the Service Center program to perform the power-monitor 
measurement. (Only available for the Agilent Service Center.)

15 Save the results of the monitor power measurement to monitoring.txt.

Zero Device Measurement in Transmission

This test measures the transmission power levels for N = 10 stochastic 
state of polarizations (SOP). The SOP's are generated by the Polarization 
Scrambler Transmission.

Test Equipment

Qty Part Description

1 ea Polarization Scrambler Transmission
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Test Settings

File Names range from T_LossPdl_0.omr to T_LossPdl_9.omr

Random polarization states

The Polarization scrambler is composed of 4 fiber loops that can be rotated 
independently. The position of a loop is defined by a number between 0 
and 999, equivalent to an angular rotation of the loop between 0 and 180°. 

Each state of polarization (SOP) is achieved by setting the 4 loops at a 
random angle position. Measurement

1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Start the reference measurement.

a Zero the power meters and perform the internal reference with 
protective caps.

b Connect the Polarization scrambler in transmission and set its SOP 
to SOP0.

c Perform the transmission reference measurement.

Phase Parameters Initial Test Re-calibration

Measurement off off

… … …

Loss Parameters

Measurement Loss / PDL Loss / PDL

Light Path Transmission Transmission

Sweep Wavelength Set manually Set manually

Sweep Wavelength, Start 1520.0 1520.0

Sweep Wavelength, Stop 1620.0 1620.0

Sweep Wavelength, Step 10.0 pm 10.0 pm

Dynamic Low (1 sweep) Low (1 sweep)

Loss Parameters, Options

TLS, Coherence Control off off

TLS, Max. Sweep Speed 40 nm/s 40 nm/s

Power Sensor Start Range, Trans. automatic automatic

Power Sensor Start Range, Refl. automatic automatic

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement [i], i ∈ [0, N-1], N = 10 T_LossPdl_[i] T_LossPdl_[i]
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4 Repeat steps 5 to 7 for i = 0 to N-1 (N=10).

5 On the Polarization scrambler, set the SOP to SOPi.

6 Perform the DUT measurement i.

7 Save and Export the results to T_LossPdl_[i].omr / T_LossPdl_[i].csv

Zero Device Measurement in Reflection

This test measures the reflection power levels for ten stochastic state of 
polarizations (SOP). The SOP's are generated by the Polarization 
Scrambler Reflection.

Test Equipment

Test Settings

File Names range from R_LossPdl_0.omr to R_LossPdl_9.omr

Qty Part Description

1 ea Polarization Scrambler Reflection

1 ea Long Reflection Reference Fiber

Phase Parameters Initial Test Re-calibration

Measurement off off

… … …

Loss Parameters

Measurement Loss / PDL Loss / PDL

Light Path Reflection Reflection

Sweep Wavelength Set manually Set manually

Sweep Wavelength, Start 1520.0 1520.0

Sweep Wavelength, Stop 1620.0 1620.0

Sweep Wavelength, Step 10.0 pm 10.0 pm

Dynamic Low (1 sweep) Low (1 sweep)

Loss Parameters, Options

TLS, Coherence Control off off

TLS, Max. Sweep Speed 40 nm/s 40 nm/s

Power Sensor Start Range, Trans. automatic automatic

Power Sensor Start Range, Refl. automatic automatic

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement [i], i ∈ [0, N-1], N = 10 R_LossPDL_[i] R_LossPDL_[i]
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Measurement 1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Start the reference measurement.

a Zero the power meters and perform the internal reference with 
protective caps.

b Connect the reflection termination reference (fiber wrapped 8 times 
around the termination rod).

c Perform the termination reference.

d Connect the Polarization Scrambler Reflection and set its SOP to 
SOP0.

e Perform the reflection reference measurement.

4 Repeat steps 5 to 7 for i = 0 to N-1 (N=10).

5 On the Polarization scrambler, set the SOP to SOPi.

6 Perform the DUT measurement i.

7 Save and Export the results to R_LossPdl_[i].omr / R_LossPdl_[i].csv 

PDL Device Measurement

This test measures the 3% device PDL by using N=10 stochastic state of 
polarizations (SOP) - set by the polarization scrambler - which are applied 
to a polarizer, which accounts for device dependent PDL.

Test Equipment

Qty Part Description

1 ea Polarization Scrambler Transmission

1 ea Polarizer
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Test Settings

File Names range from T_PdlDev_0.omr to T_PdlDev _9.omr

Measurement 1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Start the reference measurement.

a Zero the power meters and perform the internal reference with 
protective caps.

b Connect the Polarization Scrambler Transmission and set its SOP to 
SOP0.

c Perform the transmission reference measurement.

4 Connect the polarizer between the Polarization scrambler and the input 
port (right side) of the optical test head.

5 Repeat steps 6 to 8 for i = 0 to N-1 (N=10).

6 On the Polarization scrambler, set the SOP to SOPi.

7 Perform the DUT measurement i.

8 Save and Export the results to T_ PdlDev _[i].omr / T_ PdlDev _[i].csv

Phase Parameters Initial Test Re-calibration

Measurement off off

… … …

Loss Parameters

Measurement Loss / PDL Loss / PDL

Light Path Transmission Transmission

Sweep Wavelength Set manually Set manually

Sweep Wavelength, Start 1520.0 1520.0

Sweep Wavelength, Stop 1620.0 1620.0

Sweep Wavelength, Step 10.0 pm 10.0 pm

Dynamic Low (1 sweep) Low (1 sweep)

Loss Parameters, Options

TLS, Coherence Control off off

TLS, Max. Sweep Speed 40 nm/s 40 nm/s

Power Sensor Start Range, Trans. automatic automatic

Power Sensor Start Range, Refl. automatic automatic

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement [i], i ∈ [0, N-1], N = 10 T_PdlDev_[i] T_PdlDev_[i]
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Analysis

As a result of all the measurements performed above, 2 types of data are 
available:

• Noise data

• Loss / PDL data

• ZeroLossTransmission(λ,i) / ZeroPdlTransmission(λ,i)

• ZeroLossReflection(λ,i) / ZeroPdlReflection(λ,i)

• DevicePdlTransmission(λ,i)

where 
i = 0 .. N-1 represents the ten random states of polarization set by the 
Polarization Scrambler and 
λ is the wavelength. 

The number of wavelength points is given by:

Noise
Contribution

Reference Power Evaluation The reference power evaluation 
determines the quasi-statistical minimum power levels in dBm which are 
applied to the transmission / reflection power meters when a reference 
device (0 dB loss) is used.

1 From range1.omr, calculate transmission power levels for each 
polarization used by the Mueller by eliminating the monitoring power 
level.

2 From range1.omr, calculate reflection power levels for each polarization 
used by the Mueller by eliminating the monitoring power level.

3 Calculate the lowest power value over wavelength:

a Determine both the quasi-statistical minimum power levels for 
Transmission and Reflection over all polarizations used by the 
Mueller method.

b Convert the minimum power levels into dBm.
for transmission: T_SP = 10 * log (1000 * T_min)
for reflection: R_SP = 10 * log (1000 * R_min)

Noise Evaluation in Transmission Calculate the noise level T_Noise (j) 
for each range j, j ∈ [0, 3]):

1 From files range1.omr, range2.omr and range3.omr, calculate the 
transmission power levels by eliminating the monitoring power for 
each power range and each polarization (SOP) used by the Mueller 
method.
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2 Calculate for each SOP and for each power range j ∈ [1, 3] the average 
noise over wavelength for individual SOPs and power ranges in 
transmission.

3 Determine the maximum average noise over all SOPs for each power 
range, to get the noise level in transmission, T_N (j).

4 Calculate the absolute noise level in dBm, corresponding to the noise 
level in Watt in power meter range 3:
T_NdBm = 10 * LOG(1000 * T_N(3))

5 Calculate the noise to signal ratio for each range. For

a j = 1: T_lim_Noise(j):= 0

b j ∈ [2, 3]: 

c j ∈ [1, 3]: 

d Calculate the T_Noise (j) parameter:
i. j = 0: T_Noise(j):= 0
ii. j ∈ [1, 3]: T_Noise(j) = MAX(T_lim_Noise (j), T_IL_Noise (j))

Noise Evaluation in Reflection In the same way, determine the 
R_Noise (j) value by the given procedure:

1 From files range1.omr, range2.omr and range3.omr calculate the 
reflection power values by eliminating the monitoring power for each 
power range and each polarization (SOP) used by the Mueller method.

2 Calculate for each SOP and for each power range j ∈ [1, 2] the average 
noise over wavelength for individual SOPs and power ranges in 
transmission.

3 Determine for each power range j ∈ [1, 2] the maximum average noise 
over all SOPs to get the noise level in reflection R_N(j).

4 Calculate the absolute noise level in dBm, corresponding to the noise 
level in Watt in power meter range 2:
R_NdBm = 10 * LOG(1000 * R_N(2))
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5 Calculate for each range j, j ∈ [0, 2] the noise to signal. For

a j = 1: R_lim_Noise(j):= 0

b j = 2: 

c j ∈ [1, 2]: 

d Calculate now the R_Noise(j) parameter:
i. j = 0: R_Noise(j):= 0
ii. j ∈ [1, 2]: R_Noise(j) = MAX(R_lim_Noise(j), R_IL_Noise(j))

Evaluation of the
Zero Loss Device

Results

With the results from previous calculations and the Zero Device Loss 
results in transmission and reflection the Zero Device Loss Errors in 
transmission and reflection can be determined.

1 Divide the wavelength range of the Zero Device Loss in transmission 

and the Zero Device Loss in reflection into 20 equally spaced 

subranges.

2 For each wavelength-subrange and over all N-1 random polarization 
states, calculate the average Zero Device Loss Transmission and the 
average Zero Device Loss Reflection.

3 With the T_Noise(j) parameter, calculate the Zero Device Loss 
uncertainty for each range in each wavelength subrange.

4 Determine the maximum error from the previous result and compare 
against the specifications for each range.

Test Record Reference: 
LTj: = Zero Device Maximum Loss Error in Transmission

LRj: = Zero Device Maximum Loss Error in Reflection

Evaluation of the
Zero PDL Device

Results

With the results from the previous calculations and the Zero Device PDL in 
transmission and Zero Device PDL in reflection results, the Zero Device 
PDL errors in transmission and reflection are determined in the same way 
as the calculations for zero loss error.

1 Divide the wavelength range of the Zero Device PDL Transmission and 
the Zero Device PDL Reflection into 20 equally spaced subranges.

2 For each wavelength-subrange and over all N-1 random polarization 
results, calculate the average Zero Device PDL for transmission and 
reflection.

3 With the T_Noise(j) parameter, calculate the PDL uncertainty for each 
range in each wavelength subrange.
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4 Determine the maximum error in transmission and reflection from the 
previous result and compare it against the specifications for each range 
j ∈ [0, 2].

Test Record Reference:
PTj: = Zero Device Maximum PDL Error in Transmission

PRj: = Zero Device Maximum PDL Error in Reflection

Evaluation of the Polarizer PDL Device Results

A similar approach is taken for this evaluation. The range is subdivided into 
20 ranges and PDL device measurement results are transformed by 
removing all invalid values within the given wavelength range. This 
function is named here ValidValues and removes for example negative 
values given by the power meter reading.

1 Divide the wavelength range of the PDL device measurement into 20 
equally spaced subranges.

2 Remove all invalid values of the PDL device measurement for each 
wavelength-subrange over all random polarization states.

3 For each wavelength subrange, calculate the maximum determinable 
PDL.

4 For each wavelength subrange calculate the average and the standard 
deviation of the previous result.

5 Calculate the PDL Device error

6 The measurement result of the relative PDL uncertainty test has to be 
converted from the “root-sum-square” (RSS) value to the “arithmetic 
addition value” before it can be checked against the test limit.

This is necessary because, statistically, the specification is expressed 
correctly as 
RSS (0.04dB, 5.7% × P)
where
P = DUT PDL value.

However, for convenience the specification is actually given in the form 
of an arithmetic addition:
0.04dB + 3% × P”.

The difference in the percentage values compensates for the relation 
between the RSS operation and the addition.

7 Compare the maximum of the Arithmetic PDL Error against the 
specification of 3%

Test Record Reference:
PDA: = Maximum Arithmetic PDL Error
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Group Delay and Differential Group Delay 
Calibration
Parameters under test:

• Group Delay (GD) Uncertainty with GD/DGD Standard in Transmission 
and Reflection (GTA, GRA)

• Differential Group Delay (DGD) Uncertainty with GD/DGD Standard in 
Transmission and Reflection (DTA, DRA)

• Relative Group Delay Uncertainty with Wavelength Reference in 
Transmission and Reflection (GTH, GRH)

Noise Calibration

Noise Calibration
in Transmission

Test Equipment

Test Settings

Qty Part Description

1 ea Transmission Reference Fiber

1 ea GD/DGD Standard Transmission

Phase Parameters Initial Test Re-calibration

Measurement GD/DGD GD/DGD

Light Path Transmission Transmission

Sweep Wavelength, Start a 1520.0
b 1560.0
c 1595.0

a 1520.0
b 1560.0
c 1595.0

Sweep Wavelength, Stop a 1560.0
b 1595.0
c 1620.0

a 1560.0
b 1595.0
c 1620.0

Sweep Wavelength, Step 1.0 pm 1.0 pm

Resolution Bandwidth, Sliding Window 30.0 pm 30.0 pm

Averaging, Number of Scans 30 30

Sweep Speeds 40 nm/s 40 nm/s

Loss Parameters

Measurement off off

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement a) fiber_s1_r1 fiber_s1_r1

Measurement b) fiber_s1_r2 fiber_s1_r2

Measurement c) fiber_s1_r3 n/a
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Measurement

1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Set the sweep wavelength range to setting a)

4 Perform the reference measurement.

a Zero the power meters and perform the internal reference with 
protective caps.

b Connect the Transmission Reference Fiber and wait 3 min. for it to 
settle.

c Perform the transmission reference measurement.

5 Connect the GD/DGD Standard and wait 3 min. for it to settle.

6 Perform the DUT Measurement.

7 Save and Export the results to file_s1_r1.omr / fiber_s1_r1.csv

8 Repeat steps 3 to 7 for settings b) and c).

Noise Calibration
in Reflection

Test Equipment

Test Settings

Qty Part Description

1 ea Long Reflection Reference Fiber

1 ea GD/DGD Standard Reflection

Phase Parameters Initial Test Re-calibration

Measurement GD/DGD GD/DGD

Light Path Reflection Reflection

Sweep Wavelength, Start 1520.0
1560.0
1595.0

1520.0
1560.0
1595.0

Sweep Wavelength, Stop 1560.0
1595.0
1620.0

1560.0
1595.0
1620.0

Sweep Wavelength, Step 1.0 pm 1.0 pm

Resolution Bandwidth, Sliding Window 30.0 pm 30.0 pm

Averaging, Number of Scans 30 30

Sweep Speeds 40 nm/s 40 nm/s

Loss Parameters

Measurement off off
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Measurement 1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Set the sweep wavelength range according to setting a)

4 Perform the reference measurement

a Zero the power meters and perform the internal reference with 
protective caps.

b Connect the long reflection reference fiber and wait 3 min. for it to 
settle.

c Perform the reflection reference measurement.

5 Connect the GD/DGD Standard and wait 3 min. for it to settle.

6 Perform the DUT Measurement.

7 Save and Export the results to file_s2_r1.omr / fiber_s2_r1.csv.

8 Repeat steps 3 to 7 for settings b) and c).

Analysis 1 In each data file fiber_s#_r#.csv the group delay data consists of the 
noise floor and an increase due to the fiber dispersion, which has to 
been corrected for each file individually by a 2nd order polynomial 
function

Figure 29 Expected group delay profile for T/R including fiber dispersion contribution

2 Correct the group delay with the fitted polynomial function to calculate 
the group delay noise floor for transmission and reflection.

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement a) fiber_s2_r1 fiber_s2_r1

Measurement b) fiber_s2_r2 fiber_s2_r2

Measurement c) fiber_s2_r3 n/a
262 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Condensed Performance Verification Test Performance Verification
3 The data arrays obtained by the different wavelength range 
measurements have to be concatenated to one data array for GD and 
DGD.

4 Divide the wavelength range of the GD noise and the DGD noise into 20 

equally spaced subranges for transmission and reflection.

5 For each wavelength-subrange, calculate the standard deviation, σ, of 
the GD and DGD noise.

6 The uncertainties are calculated as 2σ in each wavelength subrange 
for transmission and reflection.

Test Record Reference:
GTA: = Maximum GD uncertainty in transmission

GRA: = Maximum GD uncertainty in reflection
DTA: = Maximum DGD uncertainty in transmission

DRA: = Maximum DGD uncertainty in reflection

HCN Gas Cell Calibration

HCN Gas Cell
Calibration in
Transmission

Test Equipment

Test Settings

Qty Part Description

1 ea Wavelength Reference (HCN Gas Cell)

1 ea Transmission Reference Fiber

Phase Parameters Initial Test Re-calibration

Measurement GD/DGD GD/DGD

Light Path Transmission Transmission

Sweep Wavelength, Start 1550.0 1550.0

Sweep Wavelength, Stop 1551.0 1551.0

Sweep Wavelength, Step 1.0 pm 1.0 pm

Resolution Bandwidth, Sliding Window 10.0 pm 10.0 pm

Averaging, Number of Scans 300 300

Sweep Speeds 40 nm/s 40 nm/s

Loss Parameters

Measurement off off

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement a) hcn_s1 hcn_s1
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Measurement

1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Start the reference measurement.

a Zero the power meters and perform the internal reference with 
protective cap.

b Connect the transmission reference fiber and wait 3 min. for it to 
settle.

c Perform the transmission reference measurement.

4 Connect the gas cell and perform the DUT measurement.

5 Save and Export the results to hcn_s1.omr / hcn_s1.csv

HCN Gas Cell
Calibration in

Reflection

Test Equipment

Test Settings

Qty Part Description

1 ea Wavelength Reference (HCN Gas Cell)

1 ea Long Reflection Reference Fiber

1 ea Short Reflection Reference Fiber (connected to output of Wavelength 
Reference)

Phase Parameters Initial Test Re-calibration

Measurement GD/DGD GD/DGD

Light Path Reflection Reflection

Sweep Wavelength, Start 1547.0 1547.0

Sweep Wavelength, Stop 1548.0 1548.0

Sweep Wavelength, Step 1.0 pm 1.0 pm

Resolution Bandwidth, Sliding Window 10.0 pm 10.0 pm

Averaging, Number of Scans 30 30

Sweep Speeds 40 nm/s 40 nm/s

Loss Parameters

Measurement off off

File Name (*.omr / *.csv) Initial Test Re-calibration

Measurement hcn_s2 hcn_s2
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Measurement

1 Start the Photonic Analysis Toolbox software.

2 Setup a new measurement according to the parameters given above.

3 Start the reference measurement.

a Zero the power meters and perform the internal reference with 
protective cap.

b Connect the long reflection reference fiber and wait 3 min. for it to 
settle.

c Perform the reflection reference measurement.

4 Connect the gas cell with the short reflection reference fiber and 
perform the DUT measurement.

5 Save and Export the results to hcn_s2.omr / hcn_s2.csv

Analysis From file hcn_s#.csv investigate the peak in more detail

1 Build the difference between the maximum and the minimum peak 
height of the group delay data for transmission and reflection.

2 Use the specific group delay calibration data of the gas cell for this 
peak in transmission and reflection to calculate the uncertainty for this 
specific device with serial number SN. Compare the group delay 
uncertainty for transmission and reflection against the specification.

Test Record Reference:
GTH: = Group Delay uncertainty transmission

GRH: = Group Delay uncertainty reflection
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Performance Test for the 81910A
Page 1 of 3

Model  81910A All Parameter Analyzer Date    ___________

Serial No.    _________________________ Ambient Temperature    ________°C

Options    _________________________ Relative Humidity    ________%

Software Rev.    _________________________ Line Frequency    ________ Hz

Test Facility    _________________________ Customer    _________________________

Performed by    _________________________ Report No    _________________________

Special Notes    ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________

   ________________________________________________________________
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__

__

__

__

__

__

__

__

__

 Date

____

____

____

____

____

____

____

____

____
       

Performance Test for the 81910A Test Equipment Used

Page 2 of 3

System Component List

Description Model No. Serial No

1 Optical Test Head 81910TH _____________________

2 System Controller 81910SC _____________________

3 Lightwave Measurement System 8164B _____________________

4 Tunable Laser Source 81600B _____________________

5 Optical Power Meter 81634B _____________________

6 Optical Power Meter 81634B _____________________

7 Optical Power Meter 81634B _____________________

8 Polarization Controller 8169A _____________________

9 Optical Head, Reference 81521B _____________________

Test Equipment List

Description Model No. Trace No Cal. Due

1 Wavelength Reference (HCN Gas Cell) __________ _______

2 Polarization Scrambler Transmission __________ _______

3 Polarization Scrambler Reflection ___________ _______

4 Polarizer ___________ _______

5 Short Reflection Reference Fiber with Reflector ___________ _______

6 Transmission Reference Fiber ___________ _______

7 Long Reflection Reference Fiber with Reflector ___________ _______

8 GD/DGD Standard Transmission ___________ _______

9 GD/DGD Standard Reflection ___________ _______

Accessories # Product

Connector Interfaces 2 81000FI

Protective Caps 2 5040-9351
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Performance Test for the 81910A Report No. _______________

Page 3 of 3 Date _______________

Test Description Reference Result Spec Uncertainty Reference Result Spec Uncertainty

Transmission Reflection

Wavelength [pm] [pm]

Loss, absolute WLA _______ <± 4

Loss, relative WLR _______ <± 3

Phase, absolute WPA _______ <± 1.5

Loss [dB] [dB] [dB] [dB]

Loss < 0.5 dB LT0 _______ <± 0.010 LR0 _______ <± 0.020

Loss < 10 dB LT1 _______ <± 0.015 LR1 _______ <± 0.025

Loss < 30 dB LT2 _______ <± 0.025 LR2 _______ <± 0.040

Loss < 40 dB LT3 _______ <± 0.050

PDL [dB] [dB] [dB] [dB]

Loss < 0.5 dB PT0 _______ <± 0.040 PR0 _______ <± 0.040

Loss < 10 dB PT1 _______ <± 0.050 PR1 _______ <± 0.055

Loss < 30 dB PT2 _______ <± 0.060 PR2 _______ <± 0.100

Device PDL PDA ______% < 3%

Dispersion

GD, fiber GTA ______fs <± 50 fs GRA ______fs <± 50 fs

GD, HCN GTH ______% <± 1.5% GRH ______% <± 1.5%

DGD, fiber DTA ______fs <± 80 fs DRA ______fs <± 80 fs
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Cleaning

Safety Precautions
The following Cleaning Instructions contain some general safety 
precautions, which must be observed during all phases of cleaning. 
Consult the manuals or guides for the Polarization Controller, Lightwave 
Measurement System, Power Sensor Modules, and Tunable Laser Source 
Module for full information on safety matters.

Please try, whenever possible, to use physically contacting connectors, 
and dry connections. Clean the connectors, interfaces, and bushings 
carefully after use.

If you are unsure of the correct cleaning procedure for your optical device, 
we recommend that you first try cleaning a dummy or test device.

Agilent Technologies assumes no liability for the customer is failure to 
comply with these requirements.

Please follow the following safety rules.

Do not remove instrument covers when operating.

Ensure that the instrument is switched off throughout the cleaning 
procedures.

Use of controls or adjustments or performance of procedures 
other than those specified may result in hazardous radiation 
exposure.

Make sure that you disable all sources when you are cleaning any 
optical interfaces.

Under no circumstances look into the end of an optical device 
attached to optical outputs when the device is operational. The 
laser radiation is not visible to the human eye, but it can seriously 
damage your eyesight.

To prevent electrical shock, disconnect the instrument from the 
mains before cleaning. Use a dry cloth, or one slightly dampened 
with water, to clean the external case parts. Do not attempt to 
clean internally.

Do not install parts or perform any unauthorized modification to 
optical devices.

Refer servicing only to qualified and authorized personnel.

CAUTIONWARNING
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Why is it important to clean optical 
devices?
In transmission links optical fiber cores are about 9 µm (0.00035“) in 
diameter. Dust and other particles, however, can range from tenths to 
hundredths of microns in diameter. Their comparative size means that they 
can cover a part of the end of a fiber core, and thus degrade the 
transmission quality. This will reduce the performance of your system.

Furthermore, the power density may burn dust into the fiber and cause 
additional damage (for example, 0 dBm optical power in a single mode 
fiber causes a power density of approximately 16 million W/m2). If this 
happens, measurements become inaccurate and non-repeatable.

Cleaning is, therefore, an essential yet difficult task. Unfortunately, when 
comparing most published cleaning recommendations, you will discover 
that they contain several inconsistencies. We want to suggest ways to 
help you clean your various optical devices, and thus significantly improve 
the accuracy and repeatability of your lightwave measurements.
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What do I need for proper cleaning?

Standard Cleaning Equipment

Before you can start your cleaning procedure you need the following 
standard equipment:

• Dust and shutter caps

• Isopropyl alcohol

• Cotton swabs

• Soft tissues

• Pipe cleaner

• Compressed air

Dust and shutter caps All Agilent Technologies lightwave instruments 
are delivered with either laser shutter caps or dust caps on the lightwave 
adapter. Any cables come with covers to protect the cable ends from 
damage or contamination.

We suggest these protective coverings should be kept on the equipment at 
all times, except when your optical device is in use. Be careful when 
replacing dust caps after use. Do not press the bottom of the cap onto the 
fiber too hard, as any dust in the cap can scratch or pollute your fiber 
surface.

If you need further dust caps, please contact your nearest Agilent 
Technologies sales office.

Isopropyl alcohol This solvent is usually available from any local 
pharmaceutical supplier or chemist’s shop.

If you use isopropyl alcohol to clean your optical device, do not 
immediately dry the surface with compressed air (except when you are 
cleaning very sensitive optical devices). This is because the dust and the 
dirt is solved and will leave behind filmy deposits after the alcohol is 
evaporated. You should therefore first remove the alcohol and the dust 
with a soft tissue, and then use compressed air to blow away any 
remaining filaments.

If possible avoid using denatured alcohol containing additives. Instead, 
apply alcohol used for medical purposes. Never drink this alcohol, as it may 
seriously damage to your health.

Do not use any other solvents, as some may damage plastic materials and 
claddings. Acetone, for example, will dissolve the epoxy used with fiber 
optic connectors. To avoid damage, only use isopropyl alcohol.
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Cotton swabs We recommend that you use swabs such as Q-tips or 
other cotton swabs normally available from local distributors of medical 
and hygiene products (for example, a supermarket or a chemist’s shop). 
You may be able to obtain various sizes of swab. If this is the case, select 
the smallest size for your smallest devices. 

Ensure that you use natural cotton swabs. Foam swabs will often leave 
behind filmy deposits after cleaning. 

Use care when cleaning, and avoid pressing too hard onto your optical 
device with the swab. Too much pressure may scratch the surface, and 
could cause your device to become misaligned. 

It is advisable to rub gently over the surface using only a small circular 
movement.

Swabs should be used straight out of the packet, and never used twice. 
This is because dust and dirt in the atmosphere, or from a first cleaning, 
may collect on your swab and scratch the surface of your optical device.

Soft tissues These are available from most stores and distributors of 
medical and hygiene products such as supermarkets or chemists’ shops.

We recommend that you do not use normal cotton tissues, but multi-
layered soft tissues made from non-recycled cellulose. Cellulose tissues 
are very absorbent and softer. Consequently, they will not scratch the 
surface of your device over time.

Use care when cleaning, and avoid pressing on your optical device with 
the tissue. Pressing too hard may lead to scratches on the surface or 
misalignment of your device.

Just rub gently over the surface using a small circular movement.

Use only clean, fresh soft tissues and never apply them twice. Any dust 
and dirt from the air which collects on your tissue, or which has gathered 
after initial cleaning, may scratch and pollute your optical device.

Pipe cleaner Pipe cleaners can be purchased from tobacconists, and 
come in various shapes and sizes.The most suitable one to select for 
cleaning purposes has soft bristles, which will not produces scratches.

The best way to use a pipe cleaner is to push it in and out of the device 
opening (for example, when cleaning an interface). While you are cleaning, 
you should slowly rotate the pipe cleaner.

Only use pipe cleaners on connector interfaces or on feedthrough 
adapters. Do not use them on optical head adapters, as the center of a pipe 
cleaner is hard metal and can damage the bottom of the adapter.

Your pipe cleaner should be new when you use it. If it has collected any 
dust or dirt, this can scratch or contaminate your device.
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The tip and center of the pipe cleaner are made of metal. Avoid 
accidentally pressing these metal parts against the inside of the device, as 
this can cause scratches.

Compressed air Compressed air can be purchased from any laboratory 
supplier.

It is essential that your compressed air is free of dust, water and oil. Only 
use clean, dry air. If not, this can lead to filmy deposits or scratches on the 
surface of your connector. This will reduce the performance of your 
transmission system.

When spraying compressed air, hold the can upright. If the can is held at a 
slant, propellant could escape and dirty your optical device. First spray into 
the air, as the initial stream of compressed air could contain some 
condensation or propellant. Such condensation leaves behind a filmy 
deposit.

Please be friendly to your environment and use a CFC-free aerosol.

Additional Cleaning Equipment

Some Cleaning Procedures need the following equipment, which is not 
required to clean each instrument:

• Microscope with a magnification range about 50X up to 300X

• Ultrasonic bath

• Warm water and liquid soap

• Premoistened cleaning wipes

• Lens papers

• Polymer film

• Infrared Sensor Card

Microscope with a magnification range about 50X up to 300X
A microscope can be found in most photography stores, or can be obtained 
through or specialist mail order companies.

Special fiber-scopes are available from suppliers of splicing equipment.

Ideally, the light source on your microscope should be very flexible. This 
will allow you to examine your device closely and from different angles.

A microscope helps you to estimate the type and degree of dirt on your 
device. You can use a microscope to choose an appropriate cleaning 
method, and then to examine the results. You can also use your 
microscope to judge whether your optical device (such as a connector) is 
severely scratched and is, therefore, causing inaccurate measurements.
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Ultrasonic bath Ultrasonic baths are also available from laboratory 
suppliers or specialist mail order companies. 

An ultrasonic bath will gently remove fat and other stubborn dirt from your 
optical devices. This helps increase the life span of the optical devices.

Only use isopropyl alcohol in your ultrasonic bath, as other solvents may 
cause damage.

Warm water and liquid soap Only use water if you are sure that there 
is no other way of cleaning your optical device without causing corrosion 
or damage. Do not use water that is too hot or too cold, as this may cause 
mechanical stress, which can damage your optical device.

Ensure that your liquid soap has no abrasive properties or perfume in it. 
You should also avoid normal washing-up liquid, as it can cover your device 
in an iridescent film after it has been air-dried.

Some lenses and mirrors also have a special coating, which may be 
sensitive to mechanical stress, or to fat and liquids. For this reason we 
recommend you do not touch them.

If you are not sure how sensitive your device is to cleaning, please contact 
the manufacturer or your sales distributor.

Premoistened cleaning wipes Use pre-moistened cleaning wipes as 
described in each individual cleaning procedure. Cleaning wipes may be 
used in every instance where a moistened soft tissue or cotton swab is 
applied.

Lens cleaning papers Some special lens cleaning papers are not 
suitable for cleaning optical devices like connectors, interfaces, lenses, 
mirrors and so on. To be absolutely certain that a cleaning paper is 
applicable, please ask the salesperson or the manufacturer.

Polymer film Polymer film is available from laboratory suppliers or 
specialist mail order companies.

Using polymer film is a gentle method of cleaning extremely sensitive 
devices, such as reference reflectors and mirrors.

Infrared Sensor Card Infrared sensor cards are available from 
laboratory suppliers or specialist mail order companies.

With this card you are able to control the shape of laser light emitted. The 
invisible laser beam is projected onto the sensor card, then becomes 
visible to the normal eye as a round spot.

Take care never to look into the end of a fiber or any other optical 
component when they are in use. This is because the laser can 
seriously damage your eyes.

CAUTIONWARNING
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Preserving Connectors
Listed below are some hints on how best to keep your connectors in the 
best possible condition.

Making Connections

Before you make any connection you must ensure that all cables and 
connectors are clean. If they are dirty, use the appropriate cleaning 
procedure.

When inserting the ferrule of a patchcord into a connector or an adapter, 
make sure that the fiber end does not touch the outside of the mating 
connector or adapter. Otherwise you will rub the fiber end against an 
unsuitable surface, producing scratches and dirt deposits on the surface of 
your fiber.

Dust Caps and Shutter Caps

Be careful when replacing dust caps after use. Do not press the bottom of 
the cap onto the fiber as any dust in the cap can scratch or dirty your fiber 
surface.

When you have finished cleaning, put the dust cap back on, or close the 
shutter cap if the equipment is not going to be used immediately.

Always keep the caps on the equipment when it is not in use.

All Agilent Technologies lightwave instruments and accessories are 
shipped with either laser shutter caps or dust caps. If you need additional 
or replacement dust caps, contact your nearest Agilent Technologies 
Sales/Service Office.

Immersion Oil and Other Index Matching Compounds

Wherever possible, do not use immersion oil or other index matching 
compounds with your device. They are liable to impair and dirty the surface 
of the device. In addition, the characteristics of your device can be 
changed and your measurement results affected.
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Cleaning Instrument Housings

Use a dry and very soft cotton tissue to clean the instrument housing and 
the keypad. In the case of heavy dirt, you can moisten the cotton tissue in 
water. 

Do not open the instruments as there is a danger of electric shock, 
or electrostatic discharge.

Do not open instruments. Opening the instrument can cause 
damage to sensitive components, and in addition your warranty will 
be voided.

Do not use isopropyl alcohol to clean instrument housings.

CAUTIONWARNING

CAUTION

CAUTION
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Which Cleaning Procedure should I use for 
Optical Components and Connectors?

Light dirt

If you just want to clean away light dirt, observe the following procedure 
for all devices.

• Use compressed air to blow away large particles.

• Clean the device with a dry cotton swab.

• Use compressed air to blow away any remaining filament left by the 
swab.

Heavy dirt

If the above procedure is not enough to clean your instrument, follow one 
of the procedures below.

If you are unsure of how sensitive your device is to cleaning, please 
contact the manufacturer or your sales distributor.

How to clean connectors

Cleaning connectors is difficult, as the core diameter of a single-mode fiber 
is only about 9µm. This generally means you cannot see streaks or 
scratches on the surface. To be certain of the condition of the surface of 
your connector and to check it after cleaning, you need a microscope. 

In the case of scratches, or of dust that has been burnt onto the surface of 
the connector, you may have no option but to polish the connector. This 
depends on the degree of dirtiness, or the depth of the scratches. This is a 
difficult procedure and should only be performed by a skilled person, and 
as a last resort, as it wears out your connector.

To assess the projection of the emitted light beam you can use an infrared 
sensor card. Hold the card approximately 5 cm from the output of the 
connector. The invisible emitted light is projected onto the card and 
becomes visible as a small circular spot.

Preferred Procedure Use the following procedure on most occasions.

1 Clean the connector by rubbing a new, dry cotton swab over the surface 
using a small circular movement.

2 Blow away any remaining lint with compressed air.

Never look into the end of an optical cable that is connected to an 
active source.

CAUTIONWARNING
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Procedure for Stubborn Dirt Use this procedure when there is greasy 
dirt on the connector.

1 Moisten a new cotton swab with isopropyl alcohol.

2 Clean the connector by rubbing the cotton swab over the surface using 
a small circular movement.

3 Take a new, dry soft tissue and remove the alcohol, dissolved sediment 
and dust, by rubbing gently over the surface using a small circular 
movement.

4 Blow away any remaining lint with compressed air.

An Alternative Procedure A better, more gentle, but more expensive 
cleaning procedure is to use an ultrasonic bath with isopropyl alcohol.

1 Hold the tip of the connector in the bath for at least three minutes.

2 Take a new, dry soft tissue and remove the alcohol, dissolved sediment 
and dust, by rubbing gently over the surface using a small circular 
movement.

3 Blow away any remaining lint with compressed air.

How to clean connector interfaces

Preferred Procedure Use the following procedure on most occasions.

1 Clean the interface by pushing and pulling a new, dry pipe cleaner into 
the opening. Rotate the pipe cleaner slowly as you do this.

2 Blow away any remaining lint with compressed air.

Procedure for Stubborn Dirt Use this procedure when there is greasy 
dirt on the interface.

1 Moisten a new pipe cleaner with isopropyl alcohol.

2 Clean the interface by pushing and pulling the pipe cleaner into the 
opening. Rotate the pipe cleaner slowly as you do this.

3 Moisten a new cotton swab with isopropyl alcohol.

4 Using a new, dry pipe cleaner, remove the alcohol, any dissolved 
sediment and dust.

5 Blow away any remaining lint with compressed air.

Be careful when using pipe cleaners, as the core and the bristles of 
the pipe cleaner are hard and can damage the interface.CAUTION
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How to clean bare fiber adapters

Bare fiber adapters are difficult to clean. Protect from dust unless they are 
in use.

Preferred Procedure Use the following procedure on most occasions.

1 Blow away any dust or dirt with compressed air.

Procedure for Stubborn Dirt Use this procedure when there is greasy 
dirt on the adapter.

1 Clean the adapter by pushing and pulling a new, dry pipe cleaner into 
the opening. Rotate the pipe cleaner slowly as you do this.

2 Clean the adapter by rubbing a new, dry cotton swab over the surface 
using a small circular movement.

3 Blow away any remaining lint with compressed air.

How to clean lenses

Some lenses have special coatings that are sensitive to solvents, grease, 
liquid and mechanical abrasion. Take extra care when cleaning lenses with 
these coatings.

Lens assemblies consisting of several lenses are not normally sealed. 
Therefore, use as little alcohol as possible, as it can get between the 
lenses and in doing so can change the properties of projection.

Preferred Procedure Use the following procedure on most occasions.

1 Clean the lens by rubbing a new, dry cotton swab over the surface 
using a small circular movement.

2 Blow away any remaining lint with compressed air. 

Never use any kind of solvent when cleaning a bare fiber adapter as 
solvents can:

• damage the foam inside some adapters;

• deposit dissolved dirt in the groove, which can then dirty the sur-
face of an inserted fiber.

CAUTION

Be careful when using pipe cleaners, as the core and the bristles of 
the pipe cleaner are hard and can damage the adapter.CAUTION
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Procedure for Stubborn Dirt Use this procedure when there is greasy 
dirt on the lens.

1 Moisten a new cotton swab with isopropyl alcohol.

2 Clean the lens by rubbing the cotton swab over the surface using a 
small circular movement.

3 Using a new, dry cotton swab remove the alcohol, any dissolved 
sediment and dust.

4 Blow away any remaining lint with compressed air.

How to clean instruments with a fixed connector interface

You should only clean instruments with a fixed connector interface when it 
is absolutely necessary. This is because it is difficult to remove any used 
alcohol or filaments from the input of the optical block.

It is important, therefore, to keep dust caps on the equipment at all times, 
except when your optical device is in use.

If you do discover filaments or particles, the only way to clean a fixed 
connector interface and the input of the optical block is to use compressed 
air.

If there are fluids or oil in the connector, please refer the instrument to the 
skilled personnel of the Agilent service team.

How to clean instruments with a physical contact interface

Remove any connector interfaces from the optical output of the instrument 
before you begin the cleaning procedure. 

Cleaning interfaces is difficult as the core diameter of a single-mode fiber 
is only about 9µm. This generally means you cannot see streaks or 
scratches on the surface. To be certain of the degree of pollution on the 
surface of your interface and to check whether it has been removed after 
cleaning, you need a microscope.

Only use clean, dry compressed air. Make sure that the air is free of 
dust, water, and oil. If the air that you use is not clean and dry, this 
can lead to filmy deposits or scratches on the surface of your 
connector interface. This will degrade the performance of your 
transmission system.

Never try to open the instrument and clean the optical block by 
yourself, because it is easy to scratch optical components, and 
cause them to become misaligned.

CAUTION
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To assess the projection of the emitted light beam you can use an infrared 
sensor card. Hold the card approximately 5 cm from the interface. The 
invisible emitted light is projected onto the card and becomes visible as a 
small circular spot.

Preferred Procedure Use the following procedure on most occasions.

1 Clean the interface by rubbing a new, dry cotton swab over the surface 
using a small circular movement.

2 Blow away any remaining lint with compressed air.

Procedure for Stubborn Dirt Use this procedure when there is greasy 
dirt on the interface.

1 Moisten a new cotton swab with isopropyl alcohol.

2 Clean the interface by rubbing the cotton swab over the surface using a 
small circular movement.

3 Take a new, dry soft tissue and remove the alcohol, dissolved sediment 
and dust, by rubbing gently over the surface using a small circular 
movement.

4 Blow away any remaining lint with compressed air.

How to clean instruments with a recessed lens interface

For instruments with a deeply recessed lens interface (for example the 
Agilent Technologies 81633A and 81634A Power Sensors) do NOT follow 
this procedure. Alcohol and compressed air could damage your lens even 
further.

Keep your dust and shutter caps on when your instrument is not in use. 
This should prevent it from getting too dirty.

If you must clean such instruments, please refer the instrument to the 
skilled personnel of the Agilent service team.

Preferred Procedure Use the following procedure on most occasions.

1 Blow away any dust or dirt with compressed air.

If this is not sufficient, then

a Clean the interface by rubbing a new, dry cotton swab over the 
surface using a small circular movement.

b Blow away any remaining lint with compressed air.

Never look into an optical output, because this can seriously 
damage your eyesight.

CAUTIONWARNING
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Procedure for Stubborn Dirt Use this procedure when there is greasy 
dirt on the interface, and using the procedure for light dirt is not sufficient.

Using isopropyl alcohol should be your last choice for recessed lens 
interfaces because of the difficulty of cleaning out any dirt that is washed 
to the edge of the interface.

1 Moisten a new cotton swab with isopropyl alcohol.

2 Clean the interface by rubbing the cotton swab over the surface using a 
small circular movement.

3 Take a new, dry soft tissue and remove the alcohol, dissolved sediment 
and dust, by rubbing gently over the surface using a small circular 
movement.

4 Blow away any remaining lint with compressed air.

How to clean optical devices which are sensitive to mechanical 
stress and pressure

Some optical devices, such as Reference Reflectors, are very sensitive to 
mechanical stress or pressure. Do not use cotton swabs, soft tissues or 
other mechanical cleaning tools, as these can scratch or destroy the 
surface.

Preferred Procedure Use the following procedure on most occasions.

1 Blow away any dust or dirt with compressed air.

Procedure for Stubborn Dirt To clean devices that are extremely 
sensitive to mechanical stress or pressure you can also use an optical 
clean polymer film. This procedure is time-consuming, but you avoid 
scratching or destroying the surface.

1 Put the film on the surface and wait at least 30 minutes to make sure 
that the film has had enough time to dry.

2 Remove the film and any dirt with special adhesive tapes.

Alternative Procedure For these types of optical devices you can often 
use an ultrasonic bath with isopropyl alcohol. Only use the ultrasonic bath 
if you are sure that it won’t cause any damage to any part of the device.

1 Put the device into the bath for at least three minutes.

2 Blow away any remaining liquid with compressed air.

If there are any streaks or drying stains on the surface, repeat the cleaning 
procedure.
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How to clean bare fiber ends

Bare fiber ends are often used for splices or, together with other optical 
components, to create a parallel beam.

The end of a fiber can often be scratched. You make a new cleave. To do 
this:

1 Strip off the cladding.

2 Take a new soft tissue and moisten it with isopropyl alcohol.

3 Carefully clean the bare fiber with this tissue.

4 Make your cleave and immediately insert the fiber into your bare fiber 
adapter in order to protect the surface from dirt.
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Replacing the Optical Test Head 
Adapter Patchcord

The Optical Test Head adapter patchcords should be replaced every 1,000 
uses, or if you suspect the connector has been damaged.

You can also replace the patchcord to accommodate the type of 
connection (straight, angled or bare) of your devices under test.

To replace the Optical Test Head patchcords you will need

• 2 replacement patchcords (Agilent part number 81910-88710 for 
straight connectors, 81910-88711 for angled connectors and 81910-
88712 for bare fiber).

• A 3mm Allen key, (supplied as part of the Mounting Kit with the 
Photonic All-Parameter Analyzer).

• A Termination Reflectance Rod (supplied as part of the Mounting Kit 
with the Photonic All-Parameter Analyzer).

1 Using the Allen key, remove the bolt 
holding the patchcord cover.

2 Lift the cover up and away from the Optical 
Test Head.

3 Disconnect the existing 
patchcords from the 
internal connectors

4 Disconnect the existing 
patchcords from the 
external connectors.

5 Unscrew the protective 
cap from the new 
patchcord.

6 Connect the first new 
patchcord to the internal 
and external connector of 
the Optical Test Head output port.

3

4

Output

Output

Input

Input
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7 Check the PDL in reflection:

a Connect or splice the reference reflector patchcord (gold reflector) 
to the external end of the output adapter patchcord.

b Fix the reference reflector patchcord and the output adapter 
patchcord so they cannot move, and let them settle (3 minutes 
recommended).

c Perform a PDL reference measurement in reflection over the desired 
wavelength range.
Set the parameters for the PDL measurement, as described in 
“Checking or Setting the Measurement Parameters” on page 139.

Make sure that the phase measurement is off (see “Setting the 
Measurement Parameters in Expert Mode” on page 144).
Make a reference measurement, as described in “Performing a 
Reference Measurement” on page 160.

d Move the patchcord to change the polarization of the 
reflected light.
Create different loops.
No part of the fiber should be bent to tighter than a 
10 cm diameter.

e Fix the reference reflector patchcord and the output adapter 
patchcord so they cannot move, and let them settle (3 minutes 
recommended).

f Perform the PDL measurement, as described in “Performing a 
Multi-Port DUT Measurement” on page 167.

g Check the PDL result against the specified PDL uncertainty in 
reflection.
See “Performance Specifications” on page 216 for the specified 
PDL uncertainty in reflection.
More than 95% of all results must be below the limit.

Note: This result includes the parasitic PDL of the connection (or 
splice) between output adapter patchcord and reference reflector 
patchcord.
These parasitics are not part of the system uncertainty. If they lead 
to a failure of the test, improve that connection (or splice) and 
repeat the test.

Measurement Loss/PDL

Light Path Reflection

Sweep Wavelength According to the maximum wavelength range and 
resolution you use for your measurements.

Dynamic 3
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If the PDL results exceed the specified uncertainty, check and 
improve the internal connection, or install a new patchcord, and 
repeat the test.
If a second patchcord fails to satisfy the PDL uncertainty in 
reflection, contact your Agilent Service representative.

h For increased confidence in the PDL uncertainty in reflection, repeat 
steps step d to step g(10 times is recommended).

8 Connect the second new patchcord to the internal connector of the 
Optical Test Head input port.

9 Check the PDL in transmission:

a Connect or splice the external ends of the adapter patchcords 
together.
If the test head input patchcord is shorter than 75 cm, extend it 
using the transmission reference fiber.

b Fix the patchcords so they cannot move, and let them settle (3 
minutes recommended).

c Change the light path for the PDL measurement to transmission, as 
described in “Checking or Setting the Measurement Parameters” 
on page 139.

Make a reference measurement, as described in “Performing a 
Reference Measurement” on page 160.

d Move the input adapter patchcord (and the 
transmission reference fiber, if used) to change the 
polarization of the reflected light.
Create different loops (see diagram).
No part of the fiber should be bent to tighter than a 
10 cm diameter.

e Fix the patchcords so they cannot move, and let them settle
(3 minutes recommended).

f Perform the PDL measurement, as described in “Performing a 
Multi-Port DUT Measurement” on page 167.

g Check the PDL result against the specified PDL uncertainty in 
transmission.
See “Performance Specifications” on page 216 for the specified 
PDL uncertainty in transmission.
More than 95% of all results must be below the limit.

Measurement Loss/PDL

Light Path Transmission

Sweep Wavelength According to the maximum wavelength range and 
resolution you use for your measurements.

Dynamic 3
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Note: This result also covers the parasitic PDL of the connection (or 
splice) between the input adapter patchcord and transmission 
reference patchcord (if used).
These parasitics are not part of the system uncertainty. If they lead 
to a failure of the test, improve the connection (or splice) and repeat 
the test.

If the PDL results exceed the specified uncertainty, check and 
improve the internal connection, or install a new patchcord, and 
repeat the test.
If a second patchcord fails to satisfy the PDL uncertainty in 
transmission, contact your Agilent Service representative.

h For increased confidence in the PDL uncertainty in transmission, 
repeat steps step d to step g (10 times is recommended).

10 Make sure the patchcords are looped with the largest possible radius, 
and are fixed to minimize stress on the patchcord and the connectors.

11 Connect the new patchcords to the external connectors.

12 Replace the patchcord cover, and return the bolt and tighten it.
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Troubleshooting

If the 81910A All Parameter Analyzer does not perform according to its 
specifications, please perform an operational verification test, as decribed 
in “Operational Verification Test” on page 222. This test consists of 

• system diagnostics, and a 

• simplified performance verification.

If one or both of these tests fail, please make sure you save all the test 
results, and contact your Agilent Service representative.

Further Information
For further information, please consult the All-Parameter Analyzer support 
website at http://www.agilent.com/comms/allparameter; then choose 
“Technical Support”.
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Transporting the Optical Test 
Head

If you are transporting the Optical Test Head for any reason, 

• Reinsert the 4 fixing bolts to the Optical Test Head.
These bolts prevent suspension of the Optical Test Head from being 
damaged in transport.

• Remove the fixing bolts from the holes at the 
back of the Optical Test Head, to the left and 
right of the connector area.

• There is one fixing bolt on each side of the Opti-
cal Test Head.
Depress the optical bench slightly to slide the 
bolt into position.

• There are two fixing bolts at the back of the Op-
tical Test Head, to the left and right of the con-
nector area.
Depress the optical bench slightly to slide the 
bolt into position.

If necessary, secure the fixing bolts to the Optical Test Head with 
adhesive tape to ensure they do not slip out during transport.

• You should return the Optical Test Head to the original packing if this is 
available.

• Make sure the Optical Test Head is transported horizontally. If 
necessary mark the packaging with the correct position for transport 
(up/down).

The Optical Test Head is heavy and requires two people to lift or 
carry.
Do not attempt to lift or carry it on your own.
Make sure you use the help of a colleague to pack, unpack or 
move the Optical Test Head.

CAUTIONWARNING
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Theory of Measurement and Operation

This chapter offers a brief explanation of the theory of measurement and 
operation as it applies to the Photonic All-Parameter Analyzer. For more 
details on the principles applied, please refer to one of the standard text 
books on fiber optic test. For more information on the theory of operation 
of the Tunable Laser Source, Polarization Controller or the other elements 
of the measurement system, please refer to the user documentation 
supplied with the individual instruments.

Theory of Operation for Basic Measurements  . . . . . . . . 292

Theory of Operation for Polarization Dependent Loss 
Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293

Theory of Operation for Group Delay Measurements. . . 294
Theory of Operation for Differential Group Delay 
Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296
Loss and Polarization Dependent Loss Measurements 
Using the Jones Matrix . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298
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Theory of Operation for Basic 
Measurements

To measure Loss and Reflectance, the optical test head uses three power 
meters.

The loss of the DUT is measured between power meters 2 and 3.
The reflectance of the device is measured by power meters 1 and 2.

Reference measurements are used to establish the relationshipbetween 
the readings of the respective power meters for a device of zero-loss.

Figure 30 Configuration used to measure basic lossparameters

TLS DUT

1 2 3

t

λ

Wavelength swept 
over time

The labeling of the power meters does not correspond to the slot numbers 
of the instrumentation.NOTE
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Theory of Operation for 
Polarization Dependent Loss 
Measurements

The Polarization Dependent Loss (PDL) is measured using the Mueller 
Method. For a detailed description of the Mueller method of measuring 
PDL, please see Agilent application note 5964-9937E.

Figure 31 Configuration used to measure polarization dependent loss

A Stokes vector, S=(S0, S1, S2, S3) completely describes the power and 
polarization state of an optical wave. 

An incident polarized wave, characterized by the Stokes vector Sin, 
interacts with the DUT, and the emerging lightwave is characterized by the 
Stokes vector Sout.
The 4 x 4 Mueller Matrix, MDUT, gives the relationship between these two 
vectors:

The four first-row coefficients of the Mueller Matrix describe the power 
transmission of the DUT.

From which the PDL can be calculated:
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Theory of Operation for Group 
Delay Measurements

The Group Delay of a DUT is measured using the basic principle of swept 
wavelength interferometry.

The Mueller Method determines PDL by measuring the DUT at four well-
known states of polarization, yielding a system of linear equations that can 
be solved to determine the four first-row coefficients of the Mueller Matrix:

Figure 32 Interferometric measurement of the GD of a DUT

As the source wavelength is swept by the TLS (tunable laser source), the 
strength of the signal detected, S, by the power meter is given by the 
formula

where I0 is the power of the laser, T(f) is the transmission ration of the DUT 
and  and  are, respectively, the phase delays in the DUT and 
reference paths.

The last term of this equation describes the beating of the output signal as 
the wavelength is swept. The period of the beats will depend on the 
difference in the phase delay between the DUT and reference paths(  
- ). Given the short length of the reference path, can be 
considered as a constant.
The application on the PC separates this phase component out:
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And differentiating this we get

Which is equivalent to the definition of relative group delay:

, where k is a constant.

Derivation of Chromatic Dispersion from the Group Delay

The chromatic dispersion is the derivative of the group delay.
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Theory of Operation for 
Differential Group Delay 
Measurements

Polarization Mode Dispersion (PMD) and Differential Group Delay (DGD) 
are due to any polarization dependence in the Group Delay. Measuring 
PMD and DGD relies on determining the maximum and minimum values 
for the group delay, over wavelength for the all possible polarization states.

To minimize the amount of data and the time required for the 
measurement, the Photonic All-Parameter Analyzer determines the values 
for the Jones matrix.
The Jones matrix is a 2 x 2 matrix for a device that describes the 
polarization-dependent, optical properties. Its Eigenstates give the states 
of polarization for minimum and maximum group delay. The resulting 
Eigenvalues give the values for maximum and minimum group delay.

Figure 33 Interferometric measurement of the GD and DGD of a DUT
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This setup extends the principle used for the basic swept wavelength 
interference setup described in “Theory of Operation for Group Delay 
Measurements” on page 294. A polarization controller has been added and 
vector detector (consisting of a polarization beam splitter (PBS) and two 
power meters). The PBS splits the light emerging from the interferometer 
into orthogonal components. By applying two, known states of input light 
(each swept over wavelength), we can solve the Jones matrix for the DUT.

Once the Jones matrix has been solved, we can use the difference of the 
Eigenvalues to derive the DGD, and the average of the Eigenvalues to 
derive the GD.
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Loss and Polarization Dependent 
Loss Measurements Using the 
Jones Matrix

While in the accurate measurement mode, Insertion Loss (IL) and 
Polarization Dependent Loss (PDL) are determined using the Mueller 
Method, it is also possible to use the Jones Matrix to determine those 
parameters. In the fast (realtime) measurement mode, the Photonic All-
Parameter Analyzer uses the Jones Matrix for all parameters including IL 
and PDL.

By exporting the Jones Matrix to a file after a measurement in accurate 
mode, it can be used for custom calculations. The Jones Matrix can deliver 
IL, PDL, GD, DGD traces as well as derived parameters such as CD, PMD, 
second order PMD, principal states of polarization (PSP), impulse response 
and others.

To characterize devices with a large polarization dependence or 
polarization extinction ratio, such as polarizers or polarizing beam splitters, 
the Jones Method delivers more reliable and accurate PDL measurement 
results than the Mueller Method. On the other hand, the Mueller Method 
is the most accurate way to determine small PDL values.

As uncertainty mechanisms are different for the Mueller Method and the 
Jones Method, there are a few things to consider:

• The maximum PDL that can be measured with the Jones Method 
depends on the sweep range: the narrower the sweep range is, the 
larger PDL values can be measured.

Under laboratory conditions, (e.g. for polarizers) PDL values as large as 
70 dB could be determined at sweep ranges of a few nanometers, 
however maximum polarization extinction / PDL values decrease to 29 
dB at the edges of a 50 nm sweep range.

• If small PDL values are to be determined with the Jones Matrix, 
uncertainties can become significant and limit the minimum detectable 
PDL.

• These effects do not compromise the accuracy of the principal states of 
polarization (PSP) derived from the Jones matrix.

Generally, for optimum loss and PDL measurement accuracy, we 
recommend to rely on Mueller data for a PDL of less than 10 dB, and on 
Jones data for larger PDL values.
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Definition of Terms

This appendix offers definitions of commonly used terms, and, where 
necessary, the measurement conditions associated with them.

References  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .308

Specification: describes a guaranteed product performance that is valid 
under the specified conditions. The confidence level used is 95%, as 
recommended by the ISO standard.

Generally, all specifications are valid at the stated operating conditions and 
measurement settings, at uninterrupted line voltage, for constant (as 
stated) ambient temperature after reference measurement, with all optical 
patchcords and fibers fixed and settled as stated.

Typical value: a characteristic describing the product performance that is 
usually met but not guaranteed. 
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Absolute wavelength uncertainty

Specifies the maximum difference between measured and actual 
wavelength.
Wavelength is defined as wavelength in vacuum.

Conditions: As specified.

Differential group delay (DGD)

The variation of “Group delay (GD)”  of a device, in transmission or 
reflection, resulting from applying all possible polarization states, 
expressed as the difference between the maximum and the minimum 
group delay value.

Differential group delay (DGD) loss range

“Loss”  range for which the system can measure “Differential group delay 
(DGD)” , lying between 0 dB and the specified value.

Differential group delay (DGD) measurement range

Measurable “Differential group delay (DGD)”  range, lying between 0 and 
the specified value.

Differential group delay (DGD) noise

The maximum variation of “Differential group delay (DGD)”  compared to 
low pass filtered (averaged) measurement curve over wavelength, for a 
device with wavelength-flat DGD.

Conditions: Device under test type and settings as specified. Other 
conditions as specified.

Differential group delay (DGD) resolution

The smallest possible “Differential group delay (DGD)”  increment in the 
DGD measurement results. 

Group delay (GD)

The optical signal delay time caused by a device, either in transmission or 
reflection. 

DGD is a peak-to-peak value. In optical fibers with their statistical nature 
of polarization-dependent group delay, the term “Polarization Mode 
Dispersion (PMD)”  is normally used expressing the average of the 
differential group delay <DGD>λ over a specified wavelength range. 

NOTE
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Group delay (GD) dynamic range

Specifies the maximum measurable “Group delay (GD)”  change over 
wavelength of a test device (DUT), given as the difference between 
maximum and minimum group delay.

Group delay (GD) loss range

“Loss”  range for which the system can measure “Group delay (GD)” , 
lying between 0 dB and the specified value.

Group delay (GD) noise

The variation of “Group delay (GD)”  compared to the second order 
polynomial fit of the measured curve over wavelength for measurements 
of an optical fiber.

Conditions: Device under test type and settings as specified. Other 
conditions as specified.

Group delay (GD) relative uncertainty

When calculating the difference between measured and actual “Group 
delay (GD)”  over a specified wavelength range and for a given polarization 
state, the Group delay (GD) relative uncertainty is ± half the span between 
maximum and minimum of all differences. This does not include an 
arbitrary offset of the complete GD spectrum to produce relative GD.

Conditions: Device under test type as specified. Other conditions as 
specified.

Measurement: The GD relative uncertainty is determined by measuring 
the maximum group delay change around one absorption peak of a 
H13C14N be molecular gas cell at the given wavelength. The actual group 
delay change value is derived from the measured spectral loss curve of the 
gas cell using the Kramers-Kronig relation as described in [1].

In general group delay depends on wavelength and polarization state. In 
some cases (for example to determine the chromatic dispersion) only the 
variation of the group delay over wavelength is of interest, not its absolute 
value. In these case the “relative group delay” can be used where an 
arbitrary delay value is added to the group delay values, typically to bring 
its minimum value to zero.

NOTE

The upper limit of the measurable group delay itself is given by the 
Maximum device optical path length of a fiber.NOTE
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Group delay (GD) resolution

The smallest possible “Group delay (GD)”  increment in the group delay 
measurement results. 

Loss

The loss of a device is the ratio between incident optical power at the input 
port and the optical power emerging either from the output port of the 
device (in transmission) or reflected back to the input port (in reflection). 
Loss is expressed in dB and can be calculated from:

where: Pa = input optical power, and Pb = output optical power.

Measurement: A sequence of 1.) reference measurement and 2.) device 
measurement.

In transmission: 

1

2
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In reflection: 

1

2

A constant coupling factor c has no effect on the result of loss in 
reflection. To calculate loss in reflection, the reference reflector’s 
reflectivity r must be known.

Loss range

Specifies in a “Loss”  measurement to the ratio between the receiver 
power level at a device loss of 0 dB and the receiver dark noise (RMS), 
expressed in dB.

Conditions: Power meter zeroing prior to measurement. Source power 
and power meter ranges as automatically set by the software. Other 
conditions as specified. 

Loss uncertainty

Specifies the maximum difference between measured and actual “Loss”  
(in dB).

In general, loss depends on wavelength and polarization state.
NOTE

“Loss in transmission” is often also called “insertion loss”. “Loss in 
reflection” is often also called “return loss”NOTE
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Conditions: Loss uncertainty does not include the loss of the 
connections (connectors or splices) between the adaptor patchcords and 
the reference fiber or device under test. In reflection, loss results are 
normalized to the used reference reflector, this means the reference 
reflector has per definition 0 dB loss in reflection. Other conditions 
specified.

Maximum device optical path length

Specifies the maximum geometric path length of a signal propagating 
through silica (i.e. typical single mode fiber with refractive index 1.47) for 
which group delay and differential group delay can be measured.

Measurement time

Time needed for a test device (DUT) measurement, for transfer of the 
measurement data to the computer, for calculation of the measurement 
results and displaying or storing the result. 

Condition: Reference measurements already taken. Other conditions 
and parameters as specified.

Operating conditions

The environmental conditions under which the specifications apply.

Polarization dependent loss (PDL)

The dependence of the “Loss”  of a device (in transmission or reflection) 
on the input polarization state, expressed as the difference between 
maximum and minimum loss (in dB).

Measurement: The polarization dependent loss measurement is based 
on four loss measurements in four defined polarization states of the light 
source. The polarization states are generated by a polarization controller 
and are mutually orthogonal on the Poincare sphere.

The polarization dependent loss values are calculated from the loss results 
using the Mueller-Stokes method [2].

In vacuum or air the maximum geometric path length can be higher than 
the specified value. Generally, for a medium with refractive index n the 
maximum length is 1.47/n times the specified value.

NOTE

For a mainframe mounted in a rack the environmental conditions within 
the rack apply. NOTE
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In transmission:

In reflection:

Polarization dependent loss (PDL) uncertainty

Specifies the uncertainty of the measurement results for “Polarization 
dependent loss (PDL)” , expressed as the maximum difference between 
the measured value and actual value (in dB).

Conditions: PDL uncertainty does not include the PDL of the 
connections (connectors or splices) between the adapter patchcords and 
the reference fiber or device under test. In reflection the uncertainty 
applies when using the bare fiber reflectance reference. Other conditions 
as specified.

Polarization Mode Dispersion (PMD)

The average of the “Differential group delay (DGD)” , <DGD>λ over a broad 
specified wavelength range.

Polarization mode dispersion (PMD) uncertainty

Specifies the uncertainty of the measurement results for “Polarization 
Mode Dispersion (PMD)” , expressed as the maximum possible difference 
between the measured value and actual value.

PDL is a peak-to-peak value. In general PDL depends on wavelength.
NOTE

In mode coupled devices, such as standard single mode fibers of kilometer 
length, the DGD has a strong wavelength dependence. The dependence of 
a device's DGD over wavelength performance may alter due to bending or 
temperature changes. It can be shown that the DGD characteristics of 
such devices can be described by a statistically averaged value like PMD.

NOTE
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Conditions: As specified.

Relative group delay

The difference in the “Group delay (GD)”  of a device at two different 
wavelengths.

Relative wavelength uncertainty

When calculating the difference between measured and actual 
wavelength over a specified wavelength range, the relative wavelength 
uncertainty is ± half the span between maximum and minimum of all 
differences. Wavelength is defined as wavelength in vacuum.

Conditions: As specified.

Wavelength range

The range of wavelength for which the specifications apply.
Wavelength is defined as wavelength in a vacuum.

Wavelength repeatability

Specifies the uncertainty in reproducing a wavelength in repeated 
measurements. The wavelength repeatability is ± half the span between 
maximum and minimum actual wavelength over repetitions at any nominal 
wavelength.

Conditions: Repetitions performed with the same measurement 
settings and same wavelength offset correction. Other conditions as 
specified.

Wavelength resolution

The narrowest wavelength spacing between the measurement result 
values. 
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Wavelength resolution bandwidth

Specifies the 2 Sigma width (in nm) of a Gaussian filter used for 
numerically convolving “Group delay (GD)”  or “Differential group delay 
(DGD)”  data over wavelength.

The convolution acts as a low pass (smoothing) filter for the measured 
signal over wavelength. Due to the symmetry of the Gaussian filter no 
wavelength shift is introduced to the data.

NOTE
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Index

#

8169 PNP drivers 45

816x PNP drivers 45

A

absolute wavelength uncertainty 300

ac line power
cable 17
supply 17

active measurement
setting 85, 114, 120

adapter patchcord
replacing 285

All Parameter mode 56
making a measurement 74
setting parameters 63, 140

analysis
automatic 87, 126
automatic, settings 96, 152
closing 114, 213
closing all open 77, 113
closing current 78
comparative 91, 117
comparing 205
opening existing 77, 112, 113, 122
opening measurement 173
printing 80, 122
printing preview 80, 122
saving 115, 212
saving all open 77, 122
saving current 77, 78, 112, 122

Analysis menu 87
Auto-Analysis Setup... 87, 126
Compare Loss Analysis with Active 
Measurement... 91
Reanalyze Loss... 89
Reanalyze Phase... 89

Analysis Settings 96, 97

analysis table 99, 103
exporting results 207
frequency 103
ordering results 206
selecting results 195
show all 114
wavelength 103

angled connector 41

appearance
arrange minimized windows 105
arrange windows 105, 131
cascade windows 104
default layout 101

pre-configured layouts 101
tiled windows 104

ASCII data
exporting 79

Auto-Analysis Setup...
Analysis menu 87, 126

average
chromatic dispersion over passband 190
group delay over passband 190
loss over passband 190
PDL over passband 190

B

bare fiber connector 41

Bring to Front 92, 93

C

calculation curve
showing 175

cascade windows 104

CD
analysis 89, 115, 178
auto-analysis 87, 126
comparing 91, 117
in reflection, showing graph 93
in transmission, showing graph 92
reanalyzing 178
Reflection Graph submenu 93
Transmission Graph submenu 92

Channel Bandwidth 198, 201

chromatic dispersion
. see "CD"
average over passband 190

clamping fibers 49

cleaning 270
equipment 272
supplies 272

Close Active Measurement
File menu 78

Close All
File menu 77
Measurement View 113

close all files 77, 113

close current files 78

close files 114

comment
DUT 84, 126

Compare Loss Analysis with Active Measurement...
Analysis menu 91
Measurement View 117

comparing
analysis 91, 117
results 205

components
cleaning 278

conditions
measurement 84, 126

connector
angled 41
bare fiber 41
cleaning 278
preserving 276
straight 41

Create Setup from Active Measurement
Measurement menu 85
Measurement View 114

Crosstalk Adjacent Ch. Long Wvl. (dB) 200

Crosstalk Adjacent Ch. Short Wvl. (dB) 200

Current Measurement Setup 96

cursor
appearance in analysis table 99
appearance in Graph window 107

curve
. see also "graph"
analyzing 180
selecting for display 174
viewing 174

Curve View 98
Activate 121
Measurement Curves 98
Set as Active Measurement 120
Show Min/Max Loss Curves 119
Show PDL Calculation Curves 119

D

data acquisition cable 42

data acquisition cards
installing 34

declaration of conformity 20

delivery
list 28

DGD 300
automatic analysis 152
in reflection, showing graph 93
in transmission, showing graph 92
loss range 300
measurement parameters 144
measurement range 300
measurement theory 296
Reflection Graph submenu 93
resolution 300
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Transmission Graph submenu 92

diagnostics 289

differential group delay
. see "DGD"

dispersion
specifications 218

documentation
using graphs 192

drivers
8169 PNP 45
816x PNP 45

Drop Range Bandwidth 201

DUT
clamping 52
comment 84, 126
ID 84, 126
information 84, 96, 97, 126, 150, 177
serial number 84, 126
temperature 84, 126

DUT holder
fixing 52
using 52

DUT Information 96, 97
Measurement Setup submenu 84, 126

E

Edit Parameters...
Measurement Setup submenu 83

Entering 151

Exit
File menu 80

Expert mode 57
making a measurement 72
setting parameters 59, 144

Export
File menu 79

exporting
ASCII 79
Jones matrix 80
Mueller matrix 80
results 79
spreadsheet 79

F

fiber clamp 49
fixing 49
using 49

fiber rail
fixing 48

file
close 114
close all open 77, 113
close current 78
open 77, 78, 112, 113, 122
save 78, 102, 115
save all open 77, 122
save current 77, 78, 112, 122

File menu 77
Close Active Measurement 78
Close All 77
Exit 80
Export 79
Open 77
Open Measurement Setup 78
Print 80
Print Preview 80
Print Setup 80
Save Active Measurement 77
Save Active Measurement As... 78
Save All 77
Save Measurement Setup 78
Save Measurement Setup As... 78

fixing bolts, optical test head
removing 36
storing 36

frequency and wavelength
selecting 180

Frq at Max (THz) 197

Frq at Min (THz) 197

G

GD 300
automatic analysis 152
in reflection, showing graph 93
in transmission, showing graph 92
loss range 301
measurement parameters 144
measurement theory 294
range 301
Reflection Graph submenu 93
relative uncertainty 301
resolution 302
Transmission Graph submenu 92

generating 60, 65

generic loss
analyzing 152
reanalyzing 196

GP-IB
scanning for instruments 137

graph
. see also "curve"
bringing reflection graphs to front 93, 130
bringing transmission graphs to front 92, 130
close all 105
closing 176
Copy to Clipboard 110
cut and paste 192
eliminating noise 94
frequency 103
Lock Marker AC 111
Lock Marker BD 111
Loss Orientation Curve 110
Marker submenu 109
opening 176
Print Graph 110
Print Preview 110
printing 193

scrolling 108
select and open 121
show all 114
show markers 94, 130
show min and max loss curves 119
show orientation curves 94, 130
show PDL calculation curves 119
showing CD in reflection 93
showing DGD in reflection 93
showing GD in reflection 93
showing loss in reflection 93
showing PDL in reflection 93
Synchronize X Axis 110
use in documentation 192
wavelength 103
x-axis 103
x-axis settings 103
zoom in 108
zoom out 108
zoom out all 94, 130
Zoom submenu 108

Graph menu 92
Reflection Graph submenu 93
Show Markers 94
Show Orientation Curves 94
Transmission Graph submenu 92
Zoom Out All 94

Graph Toolbar 130
show or hide 100

group delay
. see "GD"
average over passband 190

H

hardware
description 22
identifying 81, 137
installation 36
optical interconnections 38
selecting instruments 83, 125, 138
showing 81, 96, 123

Help menu 106
About Photonic Analysis Toolbox 106
Contents 106

hood
optical test head 37

I

ID
DUT 84, 126
operator 84, 112, 118

installation 15
hardware 36
lightwave measurement system 37
signal connections 42
site preparation 32
software 43
test 222
unpacking 28
310 Agilent 81910A Photonic All-Parameter Analyzer, Fourth Edition



Index
installing data acquisition cards 34

instrument
cleaning 277
description 22
identifying 81
installation 36
optical interconnections 38
selecting 83, 125, 138
showing 81, 96, 123, 177
zeroing 82, 124, 157

Instrument Setup 96, 97

Instrument Toolbar
show or hide 99

Instruments menu 81
Scan for Instruments 81
Show Instruments... 81
Zero All Power Sensors 82, 124

ITU Channel Spacing 197, 201

ITU Wavelength (nm) 199, 202

ITU-Ch 199, 202

J

Jones matrix 60, 65
export file 210
exporting 80, 210
generating 142, 145

L

laser signal
quality 149

layout
default 101

Layout submenu 101
Reset to Default 101

lightwave measurement system 26
installation 37
powering on 55
updating 33

Log submenu 102
Clear 102
Complete Logging 102
Log Errors and Warnings 102
Log Errors Only 102
Save... 102

Log window 99
auto-scroll 102
clear 102
log errors and warnings 102
log errors only 102
log everything 102
settings 102
show latest entries 102

Loss 302
measurement range 303
uncertainty 303

loss
automatic analysis 152
average over passband 190

calculation curve 175
in reflection, showing graph 93
in transmission, showing graph 92
measurement parameters 140, 146
measurement theory 292
Reflection Graph submenu 93
show min and max curves 119
show on all graphs 94, 130
specifications 217
Transmission Graph submenu 92

Loss at Center (nm) 200

Loss at ITU (dB) 199, 202

Loss at Notch (dB) 202

Loss at Peak (dB) 199

M

marker
free 109
frequency 103
locked to curve 109
locked to sample 109
locking vertical and horizontal 185
moving horizontal 184
moving vertical 183
off 109
positioning 111, 184
positioning freely 184
show on all graphs 94, 130
switching off 185
using 183
wavelength 103

Marker submenu 109
Averaging/PMD 109
Free 109
Locked to Curve 109
Locked to Sample 109
Off 109

Max Loss (dB) 197

Max Loss ITU-Ch (dB) 199, 202

Max Loss Long Wvl Passband (dB) 203

Max Loss Passband (dB) 199

Max Loss Short Wvl Passband (dB) 203

measurement
analysis 97
cancelling 168
closing 114, 170, 213
closing all open 77, 113
closing current 78
conditions 84, 126
DUT information 97
editing parameters 83, 125
exporting current 79
graphs 98
instruments 97
multi-port 167
open 97
opening existing 77, 112, 113, 122
opening for analysis 173
parameters 96, 97

pause realtime 86
performing 166, 167
performing realtime 158
printing 80, 122
printing preview 80, 122
realtime 86
repeating 155
saving 115, 169, 212
saving all open 77, 122
saving current 77, 78, 112, 122
show or hide results 98
start 85, 128
start realtime 86
stop realtime 86

measurement conditions
showing 177

Measurement Curves 98

Measurement History 97

Measurement menu
Create Setup from Active Measurement 85
Measurement Setup submenu 83
Set as Active Measurement 85
Start DUT Measurement 85
Start Reference 85

Measurement Parameters 96, 97

measurement path
show or hide results 98

measurement setup
analysis settings 97
create 85, 114
current 96
instrument setup 97
loading 155
opening existing 78
saving current 78, 154
using previous 156

Measurement Setup submenu 83
DUT Information 84, 126
Edit Parameters... 83
New 83
Properties... 84
Reconfigure Instrument Setup... 83, 125

measurement time 304

Measurement Toolbar 125
show or hide 99

Measurement View 97
Close 114
Close All 113
Compare Loss Analysis with Active 
Measurement... 117
Create Setup from Active Measurement 114
DUT Information 97
Measurement History 97
Measurement Parameters 97
Open... 113
Properties 118
Reanalyze Loss... 116
Reanalyze Phase... 115
Save 115
Save As... 115
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Set as Active Measurement 114
Show Analysis and Measurement Data 114

Min Loss (dB) 197

Min Loss ITU-Ch (dB) 199, 202

Min Loss Long Wvl Passband (dB) 203

Min Loss Short Wvl Passband (dB) 203

Mueller matrix
export file 211
exporting 80

multi-port DUT measurement 167

N

n dB Bandwidth (nm) 200

n dB Bandwidth (THz) 200

n dB Center (nm) 200

n dB Center (THz) 200

NdB Offset 198

New
Measurement Setup submenu 83
Setup View 112

new measurement 56
starting 83, 112, 125

New... 112

noise
eliminating from graphs 94, 176

Noise Suppression.. 94

notch analysis 89, 116
automatic 87, 126
comparing 91, 117

Notch Frequency (THz) 202

notch loss
analyzing 152
reanalyzing 196

Notch Wavelength (nm) 202

O

Open
File menu 77
Measurement View 113
Setup View 112

open file 77, 78, 112, 113, 122

Open Measurement Setup
File menu 78

operating conditions 16, 19, 304
acclimatization 37

operation
verifying 222

operator
ID 84, 112, 118, 151, 177

optical bench 48
fixing objects 54

optical test head 26
fixing bolts, removing 36
fixing bolts, storing 36
hood 37

installation 36
power on 55
transporting 290

Options menu 101
Layout submenu 101
Log submenu 102
X-Axes Dimension submenu 103

orientation curve
show on all graphs 94, 130
show on single graph 110
showing or hiding in all graphs 186
using 186
zooming 187

P

packing list 28

parameters
DGD measurement 144
GD measurement 144
loss measurement 140, 146
measurement, editing 83, 125
measurement, showing 177
measurement, viewing 96
PDL measurement 140, 146

patchcord
in optical head, replacing 285
in tubing 41
long, semi-rigid protected 39
short, semi-rigid protected 38

Pause Realtime Measurement 86

PDL 304
automatic analysis 152
average over passband 190
calculation curve 175
in reflection, showing graph 93
in transmission, showing graph 92
measurement parameters 140, 146
measurement theory 293
Reflection Graph submenu 93
show min and max curves 119
specifications 217
Transmission Graph submenu 92
uncertainty 305

peak analysis 89, 116
automatic 87, 126
comparing 91, 117

Peak Frequency (THz) 199

peak loss
analyzing 152
reanalyzing 196

Peak Wavelength (nm) 199

performance test 241

photonic analysis toolbox 26
exiting 80
installation 43

PMD 305
selecting 109

PMD over passband

analyzing 189

polarization controller 26

polarization dependent loss 304
. see "PDL"

polarization mode dispersion 305

port
measuring more than one 167

power cable
ac line 17

power on 55

power sensor
setting the start range 149
zeroing 82, 124, 157

power sensor module 26

power supply
ac line 17

Print
File menu 80

Print Preview
File menu 80

Print Setup
File menu 80

printing
analysis 80, 122
analysis preview 80, 122
graph 110, 193
measurement 80, 122
measurement preview 80, 122
preview graph 110
result 194
setup 80

Properties...
Measurement Setup submenu 84
Measurement View 118
Setup View 112

protected patchcord
long 39
short 38

R

realtime measurement 86
making 74
pausing 159
performing 158
stopping 159

Realtime Measurement Toolbar
show or hide 100

realtime measurements 56

Reanalyze Loss...
Analysis menu 89
Measurement View 116

Reanalyze Phase...
Analysis menu 89
Measurement View 115

Reconfigure Instrument Setup...
Measurement Setup submenu 83, 125

Reference data 96
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reference measurement
data 96
performing 160
start 85, 128

reflection graph
. see also "graph"
bringing to front 93, 130
showing CD 93
showing DGD 93
showing GD 93
showing loss 93
showing PDL 93

Reflection Graph submenu 93
Bring to Front 93
CD 93
DGD 93
GD 93
Loss 93
PDL 93

relative wavelength uncertainty 306

Reset to Default 101

result 97
analysis 97
automatic analysis 87, 126
closing 213
exporting 79, 207
graph 98
instruments 97
measurement parameters 97
printing 194
saving 212
show or hide results 98
using in documentation 191

S

safety class 16

safety precautions 16

safety symbols 18

Save
Setup View 112

Save Active Measurement
File menu 77

Save Active Measurement As...
File menu 78

Save All
File menu 77

save all files 77, 122

save current file 77, 78, 112, 122

save files 115

Save Measurement Setup
File menu 78

Save Measurement Setup As...
File menu 78

Scan for Instruments
Instruments menu 81

scrolling
zoomed curve 108

semi-rigid patchcord
long 39
short 38

serial number
DUT 84, 126

Set as Active Measurement
Curve View 120
Measurement menu 85
Measurement View 114

Setup View 96, 112
Analysis Settings 96
Current Measurement Setup 96
DUT Information 96
Instrument Setup 96
Measurement Parameters 96
Open... 112
Properties... 112
Reference data 96
Save 112

Show Instruments...
Instruments menu 81

Show Latest Entries 102

Show Markers
Graph menu 94

Show Orientation Curves 110
Graph menu 94

signal connections
installation 42

site preparation 32

software
. see "photonic analysis toolbox"

specifications
dispersion 218
loss 217
PDL 217
performance 216
test 241

spreadsheet
exporting 79

Standard Toolbar 122
show or hide 99

Start DUT Measurement
Measurement menu 85

Start Realtime Measurement 86

Start Reference
Measurement menu 85

Status Bar 100
show or hide 100

Stop Realtime Measurement 86

straight connector 41

system
major components 22
starting 55

system controller 26

T

table

. see "analysis table"

temperature
DUT 84, 126

termination
making 51

termination rod
fixing 51
using 51

test
installation 222

tile windows 104

transmission graph
. see also "graph"
bringing to front 92, 130
showing CD 92
showing DGD 92
showing GD 92
showing loss 92
showing PDL 92

Transmission Graph submenu 92
Bring to Front 92
CD 92
DGD 92
GD 92
Loss 92
PDL 92

transporting
optical test head

290

troubleshooting 289

tunable laser source module 26

U

unpacking 28

V

version information 106

View menu 95
Workspace 96

VISA files 45

W

wavelength and frequency
selecting 180

wavelength range 306

wavelength repeatability 306

wavelength resolution 306

wavelength resolution bandwidth 307

wavelength uncertainty
absolute 300
relative 306

Window menu 104
Arrange Icons 105
Arrange Window 105
Cascade 104
Close All 105
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Tile 104

windowmarker
averaging/PMD 109

Workspace 96
Curve View 98
Measurement View 97
Setup View 96
View menu 96

Wvl at Max (nm) 197

Wvl at Min (nm) 197

X

X-Axes Dimension submenu 103
Frequency 103
Wavelength 103

X-Axes Dimension Toolbar
show or hide 100

x-axis settings 103

Z

Zero All Power Sensors
Instruments menu 82, 124

zoom in 108, 181

zoom out 108, 181

Zoom Out All
Graph menu 94

Zoom submenu 108
Main Curves 108
Orientation Curve 108

zooming 108, 181
all graphs identically 181
Main Curves 108
Orientation Curve 108
scrolling 108
zoom out 108
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